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[bookmark: _Ref2145586633][bookmark: _Toc161997430]E-Commerce Overview
The Extended Enterprise or E-Commerce solution helps organizations increase top-line revenue from more productive channels, reduce the cost to sell to and service customers and channels, and increase brand awareness and loyalty.
· User Experience - Allows access to designated functions without obligating users to log into the application. This enables a business-to-consumer environment where people may search and browse for training, certifications and knowledge offerings prior to registering for or purchasing the related items. 
· Profit Center Support - Includes an eCommerce engine that allows Clients to charge for any of the assets available to its extended enterprise users. The robust configuration settings and business rules allow organizations to set prices by user group and/or individual asset, and provides full support for multiple currencies.
[bookmark: concept1]General Benefits of Extended Enterprise Solutions - By delivering targeted learning programs to the extended enterprise, companies have been able to accelerate product/service launches, lower overall support costs, increase customer retention and satisfaction and develop partners with deep product knowledge. Benefits include:
· Higher brand loyalty 
· Increase productivity 
· Faster time-to-market 
· Improved customer satisfaction and loyalty 
· Better supply chain communication 
Partners/Suppliers/Channels: Maximizing Returns - For partner and supplier education, the benefits of focusing on the extended enterprise are numerous and well-documented. When partners and suppliers are a critical part of supporting a product launch, ensuring deep product/service knowledge is as important as training your own internal salespeople. These tools allow companies to focus on channel education, certification and alignment of partner goals with broad business objectives. Benefits include: 
· Increased partner revenues 
· Improved certification rates 
· Increased utilization of products and services 
· Increased channel effectiveness
· Improved communication 
Customers: Building Further Value - Specifically with respect to customer education, Cornerstone Extended Enterprise clients use the platform to help customers get the most of products and services, thereby increasing overall value to both parties. Benefits include:
· Increased sales value 
· Higher post-sale customer loyalty 
· Higher brand recognition 
· Increased utilization of products and services 
· Lowered costs to serve the customer 
Trade and Industry Associations/Reaching Widespread Audiences - Cornerstone also delivers immediate value to trade associations and other similarly structured organizations with large, diffuse memberships. The platform allows for easy distribution of all types of training and professional development opportunities, as well rapid exchange of information, policies, procedures, and documentation.
Develop a Sustainable Revenue Stream - Cornerstone Extended Enterprise offering is used by clients to not only provide a valuable learning service, but also to develop revenue streams that can turn a cost center into a sustainable profit center. The Cornerstone platform includes a wide range of billing and credit card processing tools, along with unlimited control over how training content is distributed to end users.
[bookmark: _Toc161997431]Coupons Overview
Coupon Codes allow administrators to create single use or multiple use coupons, which provide a discounted price on learning objects to users. Coupon codes may have a start date and an expiration date.Once coupons are created, they can then be distributed by an organization through marketing emails outside of the system. Users then apply them to their order on the Review step of the checkout process.
Coupons are available for use with all LO types, but cannot be used with Knowledge Bank or Connect postings. With ILT events, coupon codes are available at both the event and session level. Currently, coupon codes cannot be used with training unit purchases. Coupon codes are unique, so if 100 single use coupons are created, 100 unique coupon codes are generated. Because each coupon code is unique, there is no availability set for a coupon.
Coupons are available within the Extended Enterprise module. To enable coupon functionality for your portal, contact Global Customer Support.
· For information about creating coupons, See Coupon - Create and Edit on page 8 for additional information.
· For information about coupon redemption history, See Coupon - View Usage on page 13 for additional information.
· For information about coupons with previous versions, See Coupon History on page 16 for additional information.
· For information about managing coupon codes, See Coupon Administration on page 6 for additional information.
To access coupon functionality, go to Admin > Tools > Learning > E-Commerce > Coupons. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Coupon Admin - Manage
	Provides manage access to Coupon Administration screen, enabling admins to view, add, delete and edit coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration



	Coupon Admin - View
	Provides view only access to Coupon Administration screen, enabling user to view details of existing coupons, but not add, edit or delete coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration


Workflow
When multiple coupons are used, coupons are applied in the order in which they are added to the order. Also, only one coupon can be applied to an item. The following example demonstrates how these rules work together.
In both scenarios, a user has three items in their shopping cart and they have two coupons:
· Item 1 is from Provider A
· Item 2 and 3 are from Provider B.
· Coupon X is for $5 off any one Provider A learning object.
· Coupon Y is for 15% off an entire order.
Scenario 1: The user applies Coupon X, which discounts Item 1 by $5 because it is from Provider A. The user then applies Coupon Y, which discounts Item 2 and 3 by 15%. Item 1 is not discounted by 15% because an item cannot have two coupons applied to it and Coupon X was applied first.
Scenario 2: The user applies Coupon Y, which discounts Item 1, 2, and 3 by 15% because the coupon applies to an entire order. The user then applies Coupon X, which does not discount any item. Item 1 is not discounted further because an item cannot have two coupons applied to it and Coupon Y was applied first.
Business Rules
· If an administrator creates 10,000 coupons and then reduces the number of coupons to 5,000, the removed coupons have a status of Void and cannot be used. If these coupons are distributed for use, the administrator should contact those users to inform them the coupon is no longer valid. It is strongly recommended that you do not reduce the number of coupons after the coupon codes are generated.
· If a coupon is applied that exceeds the total amount due, the total amount due is reduced to zero.
· All coupon prefixes and codes must be unique.
· If multiple currencies are in use on your portal, the coupon amount will be converted for users purchasing in other currencies based on the established currency conversion rate.
Coupon Statuses
The following statuses are available for coupons:
	Status
	Definition

	Not Started
	The coupon will be available at a future date.

	Started
	The coupon is active.

	Inactive
	The coupon is set as inactive.

	Expired
	The coupon expiration date is past.
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[bookmark: _Ref-1544310331]Coupon Administration
The Coupon Administration page allows administrators to create and manage coupon codes. Administrators can also view coupons that are available. Using the search features, administrators can search for inactive or expired coupons.
To access Coupon Administration, go to Admin > Tools > Learning > E-Commerce > Coupons.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Coupon Admin - Manage
	Provides manage access to Coupon Administration screen, enabling admins to view, add, delete and edit coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration



	Coupon Admin - View
	Provides view only access to Coupon Administration screen, enabling user to view details of existing coupons, but not add, edit or delete coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration


To enable coupon functionality for your portal, contact your account manager or Global Customer Support.
[image: ]
Create Coupon
To create a new coupon, click the Create New Coupon link. This opens the Create New Coupon page where you can enter the details of the coupon code. See Coupon - Create and Edit on page 8 for additional information.
Manage Coupons
You can search for an existing coupon by name using the Search functionality. Select the Include Inactive and Expired option to also include inactive and expired coupons in the search results. The Manage Coupons table displays the following information for each coupon:
· Title - The title of the coupon.
· Description - A brief description of the coupon.
· Coupon Type - The coupon type can be either Unlimited or Single Use. 
· Unlimited - The coupon can be used an unlimited number of times. 
· Single - The coupon can be used only once and is then no longer valid.
· Status - The available coupon statuses are:
· Not Started - The coupon will be available at a future date.
· Started - The coupon is active. To change the Active status for a coupon, click the Edit icon in the Options column and then select or deselect the Active option.
· Inactive - The coupon is set as inactive. To change the Active status for a coupon, click the Edit icon in the Options column and then select or deselect the Active option.
· Expired - The coupon expiration date is past.
· Last Modified - The date the coupon was created or last modified.
The following options are available in the Options column:
· Edit - This option takes you to the Edit Coupon page where you can edit the details of coupons that are Not Started. For coupons that are Started, Inactive, or Expired, the details cannot be modified, but the coupons can be made active or inactive. This page behaves similarly to the Create New Coupon page. See Coupon - Create and Edit on page 8 for additional information.
· Copy - This option takes you to the Copy Coupon page with all of the details copied from the original coupon except for the title and coupon code. This page behaves similarly to the Create New Coupon page. See Coupon - Create and Edit on page 8 for additional information.
· View Usage - This option takes you to the Coupon Manager Report page, where you can view a coupon's details and its usage. See Coupon - View Usage on page 13 for additional information.
· View Details - This option is only available for coupons that have more than one version. Clicking the View Details option navigates the user to the Coupon History page for the coupon. See Coupon History on page 16 for additional information.
[bookmark: _Ref1399177618][bookmark: _Ref-1784313839]Coupon - Create and Edit
When creating a coupon, administrators can customize all aspects of the coupon, including usage limitations, coupon value, minimum purchases, and more.
If multiple currencies are active on your portal, the currency conversion rate will be applied to the coupon for those purchasing in differing currencies.
To create a coupon, go to Admin > Tools > Learning > E-Commerce > Coupons. Then click the Create New Coupon link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Coupon Admin - Manage
	Provides manage access to Coupon Administration screen, enabling admins to view, add, delete and edit coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration


[image: ]
Define Coupon Details
Enter the following information for the coupon:
· Title - Enter a title for the coupon, up to 50 characters. This is a required field. This field can be modified after the coupon is saved.Note: The title of the coupon is not used by users. When users use the coupon, they enter the coupon code or prefix to receive the discount.
· Coupon Administration Page - The new title displays in the Title column in the Manage Coupons table.
· Coupon Usage Page - The new title displays in the Coupon Title field in the Coupon Details section.
· Custom Transaction Reports - The new title displays when running custom Transaction reports.
· Coupon History Page - The Title column displays the new title. 
· Description - Enter a description for the coupon, up to 500 characters. This is a required field. This field can be modified after the coupon is saved.
· Coupon Type - Select whether the coupon can be used an unlimited number of times or only a single time. After a coupon has been created, the coupon type can only be modified if the coupon has not been redeemed by any user. The following options are available:
· Unlimited - Users can use the code as many times as needed.
· Single Use - Users can use the code only once. 
· User-Constrained - Users can redeem the coupon an unlimited number of times between the coupon Start Date and Expiration Date.
· Number of Coupon Codes to be generated - For Single Use and User-Constrained coupons, you must specify the number of coupons to generate. When the code is created, the system generates the desired number of unique coupon codes. Each coupon code has the same coupon prefix, but each has a unique ending. The maximum number of coupon codes that can be generated at a time is 99,999.Note: When editing a coupon code, if the number of coupons that are created is reduced, those codes that are removed have a status of Void and cannot be used. If these codes have been sent out to users, the administrator must inform those users that the code is no longer valid. It is strongly suggested that you do not reduce the number of coupons after the coupon codes are created.
· Coupon Prefix - This field is required. The coupon code or prefix must be unique. If a coupon exists with the same coupon code or prefix, the coupon is not created. All coupon codes and prefixes must be alpha-numeric; no spaces or special characters are allowed. This field can be modified after the coupon is saved.If the coupon type is Single Use or User-Constrained, you must enter a coupon prefix (e.g., Fall11). Each coupon that is generated has the same prefix, but has a unique ending to make the entire code unique (e.g., Fall11-ABC, Fall11-XYZ). The character limit for prefixes is 7.
· Coupon Code - If the coupon type is Unlimited, you must enter a coupon code, which can be used multiple times by many different users. The character limit for codes is 15.
· Offer Type - Select whether the coupon is for a monetary amount or a percentage off of a purchase. This field can be modified after the coupon is saved.
· Amount - Enter the monetary amount that is taken off of the purchase total when the coupon is used. Also, select the currency type from the drop-down list. If multiple currencies are in use on your portal, the coupon will be converted to other currencies according to the currency conversion rate established. The maximum amount accepted for a coupon is 99,999,999.
· Percent - Enter the percentage amount that is taken off of the purchase total when the coupon is used. The field accepts up to two decimal places. The maximum percentage for a coupon is 100%. Note: The decimal is reflected when viewing the transaction in the Shopping Cart, Manage Transactions, and Order History.
· Use Case for Using Decimals:[footnoteRef:1] [1:  Acme Medical Supplies (AMS) sells training to customers on the operation and maintenance of its equipment. AMS works with a training manager at a distributor to sell the training. The training manager is responsible for managing the process of purchasing the training on behalf of users. The training manager purchases training using a coupon with a discount amount that represents the distributor’s profit. For example, the distributor’s profit for selling the training is 15% of the price of the training; the training manager purchases the training on behalf of the user using a coupon with a 15% discount. If the training is cancelled or if there is a customer support issue for the customer, then the customer gets a coupon for a 10% discount. This discounts represents a discount from AMS to the end user and is distinct from the discount used by distributors. When a student is refunded for a training purchase and then the student wishes to make a new purchase with the additional "customer service" discount, then the training manager needs the four decimal places for coupons. When the training manager makes a purchase for the new class, there are two discounts. One discount is from the distributor and one is from AMS. The coupon that would be needed is not worth 15% (distributor’s margin) + 10% (customer support discount). Instead, the coupon is worth 22.25% (.2225 as decimal). When purchasing the replacement training on behalf of a user, the training manager enters a coupon at the time of checkout that is worth a 22.25% discount.] 

· Portals with Digital River Integration - For portals integrated with Digital River, this drop-down contains all pre-defined discounts from Coupon Preferences. This enables administrators to map the coupons to pre-defined discounts, which are also mapped to discounts within Digital River.
· Minimum Purchase - Select whether a minimum purchase is required to qualify to use the coupon. 
· Not Required - Select this option to not require a minimum purchase. Users can apply the coupon to the purchase regardless of the total.
· [bookmark: concept4]Amount - Select this option and enter a monetary amount between 1 and 99,999,999 to require users to purchase a certain monetary amount of learning objects before they are eligible to use the coupon. Also, select the currency type from the drop-down list. The minimum purchase amount must be greater than or equal to the coupon discount amount. This field can be modified after the coupon is saved.
· Start Date - Select the date on which the coupon becomes available for use. This is required. This field can be modified after the coupon is saved. Note: Every time the administrator attempts to save a change to the coupon, the system checks to make sure the start date is a current or future date. If the date is not a current or future date, then the change to the coupon cannot be made until the start date meets the date criteria.
· Expiration - Select whether or not the coupon expires. This field can be modified after the coupon is saved.Note: Every time the administrator attempts to save a change to the coupon, the system checks to make sure the expiration date is a current or future date. If the date is not a current or future date, then the change to the coupon cannot be made until the expiration date meets the date criteria. Select one of the following options:
· Does Not Expire - Select this option to allow the coupon to never expire. If a coupon does not expire, administrators can still make the coupon inactive, which makes the coupon unavailable.
· Valid Through - Select this option and select an expiration date to determine the day on which the coupon is no longer available. When this date passes, the status for the coupon is Expired.
· Active - This option only displays when editing or copying a coupon or when viewing a saved coupon. Select this option to make the coupon active. When a coupon is inactive, the coupon cannot be used, regardless of the other criteria defined for the coupon.
Coupon Applicability
When defining the coupon applicability, the administrator selects one of the following options in the Apply To field:
· All Training - Select this option to allow the coupon to be used with any of the available learning objects. Note: When adding a session, if session options appear for the session, then your portal has enabled the ability to configure multiple providers for a session. 
· Training Units - Select this option to allow users to apply coupons when purchasing training units. Coupons configured for training unit purchases can only be used for training unit purchases and cannot be used to purchase training items, such as online courses or materials. Note: This functionality is only visible in portals with the training unit functionality enabled.
· Customize Training Types - Select this option to limit the LOs with which the coupon is available. Additional options are available when this option is selected. You can select certain training types, specific training titles, languages, providers, or subjects. Selecting a customized group of LOs to use with the coupon is a good way to tailor a coupon. For example, you can create a coupon for specific LOs or a specific provider in order to promote those items.
The training criteria uses OR logic, so any training items that match at least one of the criteria is included. 
Edit Coupon Applicability
All fields in the Coupon Applicability section can be modified after the coupon is created. The updated value is reflected on the Coupon History page.
If the Customize Training Types option is selected, then at least one training type must be defined in the Training Type field.
[image: ]
[bookmark: _Ref-50121016]Coupon - View Usage
The Coupon Usage page allows administrators to track the redemption of a coupon and view the associated transaction information.
To view the usage information for a coupon, go to Admin > Tools > Learning > E-Commerce > Coupons. Search for the appropriate coupon, and then in the Options column, click the View Usage icon.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Coupon Admin - Manage
	Provides manage access to Coupon Administration screen, enabling admins to view, add, delete and edit coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration



	Coupon Admin - View
	Provides view only access to Coupon Administration screen, enabling user to view details of existing coupons, but not add, edit or delete coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration


[image: ]
Coupon Details
In the Coupon Details section, the following coupon details are displayed:
· Version - This field displays the coupon version. A new coupon version is created each time the coupon is edited.
· Coupon Title - This field displays the title of the coupon.
· Description - This field displays the description of the coupon.
· Type - This field displays the coupon type, either Unlimited or Single Use.
· Start Date/Expiration Date - This field displays the start and expiration dates for the coupon.
· Percent/Amount - This field displays the discount the coupon offers. This is either a percentage off of a purchase or a monetary discount amount. 
· Minimum Purchase - This field displays the minimum monetary value that must be purchased in order to receive the coupon discount.
· Usage Pie Chart - To the right of the coupon details, for single use coupons, a pie chart is displayed, summarizing the coupon usage. The total number of coupons issued, used, and not used are displayed as well. Note: The pie chart is not displayed for unlimited use coupons because the coupon codes can be used multiple times.
Coupons
In the Coupons section, each coupon code is listed along with the following transaction information if available:
· Coupon Code - For single use coupons, each coupon code is unique, so if 10 coupon codes are created, each of those 10 unique codes is listed. For unlimited use coupons, the coupon code is displayed along with the number of instances. All redemptions are recorded for unlimited use coupons.
· Version - This column displays the version number of the coupon when it was used in a transaction. The column displays "1.0" as the first version of the coupon and increases in increments of one for all subsequent versions.
· Transaction ID - If the code is used, the transaction ID for the purchase is displayed. Click the transaction ID to view the purchase details. This is not available when a bill is requested. If a coupon is redeemed multiple times, a separate transaction ID is listed for each time the coupon is redeemed.
· Redeemed Date - The date the coupon is redeemed, if the coupon is redeemed.
· Redeemed By - The user who redeemed the coupon, if the coupon is redeemed.
· Status - The status of the coupon. 
To view a printable version of the coupon details or to export the information to excel, click the Printable Version link or the Export to Excel link in the upper-right corner of the Coupons section.
[bookmark: _Ref695945699]Coupon History
The Coupon History page displays the version history of coupons which have two or more versions. Coupon versions are created by editing a field on the Edit Coupon page and saving the change. See Coupon - Create and Edit on page 8 for additional information.
To access the Coupon History page, go to Admin > Tools > Learning > E-Commerce > Coupons and click the View Details icon in the Options column on the Coupon Administration page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Coupon Admin - Manage
	Provides manage access to Coupon Administration screen, enabling admins to view, add, delete and edit coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration



	Coupon Admin - View
	Provides view only access to Coupon Administration screen, enabling user to view details of existing coupons, but not add, edit or delete coupons. This permission can be constrained by Provider, ILT Provider, OU, User's OU, and User's LO Availability. This is an administrator permission.
	eCommerce - Administration


[image: ]
Coupon History Table
The following information displays in the Coupon History table:
· Version - This column displays the version number of the coupon. The earliest version displays at the top. Versions display as 1.0, 2.0, 3.0, etc.
· Title - This column displays the title of the coupon version. To view titles that are more than 25 characters, mouse over the title to view a tooltip with the full title.
· Description - This column displays the description of the coupon version. To view descriptions that are more than 25 characters, mouse over the description to view a tooltip with the full description.
· Coupon Type - This column displays the coupon type. The following are the possible values:
· Single - Use
· Unlimited
· User-Constrained
· Codes Generated - This column only applies to Single - Use and User-Constrained coupon types. This column displays the number of coupon codes that were generated for the coupon.
· Coupon Code/Prefix - For Unlimited coupon types, this column displays the coupon code. For Single - Use and User-Constrained coupon types, this column displays the coupon prefix.
· Offer Type - This column displays the type of coupon offer, either a percentage (e.g., 15%) or a monetary amount (e.g., $5).
· Min Purchase - This column displays the minimum amount that the user must purchase in order to use the coupon. If a minimum purchase amount was not defined for the coupon, then the column displays "N/A."
· Start Date - This column displays the date on which the coupon is first available for use. The date displays in MM/DD/YYYY format.
· Expiration Date - This column displays the date on which the coupon expires. The date displays in MM/DD/YYYY format.
· Apply Training To - This column displays the value selected in the Coupon Applicability section when configuring the coupon. The following are the possible values:
· All Training
· Custom Training Types - This option also displays the training types selected. If the list of training types is more than 50 characters, then hovering over the mouse to view the full list.
· Training Units
· Created By - This column displays the user ID of the user who created the new version of the coupon.
· Creation Date/Type - This column displays the date and time at which the new version of the coupon was created. The time displays in the user's time zone. For example, Jan is an administrator who makes a change to a coupon at 2:00pm EST. Anita, who is also an administrator but is not the coupon creator and is in the PST time zone, views the history for the coupon. Anita sees the time of the change as 11:00am PST.
To view a printable version of the coupon details or to export the information to excel, click the Printable Version link or the Export to Excel link in the upper-right corner of the Coupon History section.
Back Button
Select the Back button to return to the Coupon Administration page.
[bookmark: _Toc161997432]Training Inventory Overview
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[bookmark: _Ref1927346637]Training Inventory Administration
This page displays all pre-purchased training for the user, the training title, date it was pre-purchased, the total number of users for which the item is pre-purchased, the total number of used assignments, and the available balance. The user/manager can assign training to users with or without a due date, and track the enrollment and training details from this page.
To access the Training Inventory page, go to My Account > Order History. Then, click the View Inventory button.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Assign Training
	Grants ability to assign learning objects to the transcripts of those for whom the user is the assigned manager, approver or cost center approver. This is a manager/approver permission.
	Learning


[image: ]
Training Inventory
Using the Search functionality, you can search for inventory by title or type.
Include inventory purchased by others - Click this option if you want to include inventory purchased by other users in the search results that appear in the Inventory table. 
The Inventory table displays the following information:
· [bookmark: concept8]Title - This column displays the title of learning object.
· Purchased By - This column displays the name of the user who purchased the training.
· Date Purchased - This column displays the date and time of purchase.
· Quantity - This column displays the quantity purchased.
· Used - This column displays the quantity of pre-purchased training that has been assigned to users.
· Available - This column displays the quantity of training that can be assigned to users.
In the Options column, the following actions are available:
· Assign Users - Click this option to assign training to users. For ILT inventory, if registration is closed for the session or if the transaction is Pending Payment, the Assign Users option is not available. See Assign Training to Users from Inventory for additional information.
· View Enrollments - Click this option to view enrollments, assigned training. If the transaction is Pending Payment, the View Enrollments option is not available. See View Training Enrollments for additional information.
· Adjust Inventory - Click this option to adjust pre-purchased inventory values to reduce the number or training items or instructor-led training (ILT) session seats purchased. 
Extended Enterprise: 
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Purchase Training Inventory
Purchasing training inventory allows administrators to purchase a training item with the intent to assign that training to other users.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Purchase Inventory
To purchase inventory, follow these steps:
1. Search for the LO. See Search for Training for additional information.
2. The LO Details page displays an overview of the training item. At the bottom, click the Add to Cart button. If you are purchasing ILT inventory, next to the appropriate session, click the Add to Cart link in the Options column.
3. A pop-up appears where you can choose to purchase the training for yourself or for inventory. Select the Others: Pre-Purchase option and specify the number of users you are purchasing. Click Submit.
4. The item is added to the shopping cart with the specified number of users listed in the Quantity column. You can update this amount here if necessary. See Shopping Cart - Overview on page 173 for additional information.
5. Continue through the Checkout process. If you are purchasing ILT inventory, the system verifies that the number of seats being purchased is still available and that the user is able to purchase them. After purchasing the inventory, the inventory is visible on the Training Inventory page. See Training Inventory Administration on page 19 for additional information.
[bookmark: _Toc161997433][bookmark: _Ref201874825]Manage Client Accounts
From the Manage Client Accounts page, you can manage existing e-commerce client accounts and create new client accounts. Client accounts are created so that you can associate subscriptions to certain clients. This helps in tracking subscriptions via custom reporting.
To access the Manage Client Accounts page, go to Admin > Tools > Learning > E-Commerce. Then, click the Client Accounts link from the E-Commerce section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Client Account OU - Manage
	Allows administrations to view, create, and edit Client Account organizational units (OU) and manage the Manage Client Accounts page. This is an administrator permission.
	eCommerce - Administration



	Client Account OU - View
	Allows administrations to view Client Account organizational units. This permission can be constrained by OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Create Client Account
Click the Create Client Account button to create a new client account organizational unit (OU). See Create Client Accounts on page 24 for additional information.
Filters
The following filters are available:
· Client Account Name - Enter a full or partial name in the text box to filter the page by client account name.
· Include inactive - Check the box to display inactive client accounts on the page. This option is unchecked by default.
Click Search to update the page with the filtered results.
Client Accounts Table
This table displays active and inactive client accounts. The client accounts display in ascending alphabetical order.
The following information displays for each client account:
· Client Account Name - This column displays the account name for the client.
· Owner - This column displays the owner of the client account.
· Contact - This column displays the contact for the client account.
· Created - This column displays the date on which the client account was created.
· Status - This column displays the status of the client account, either Active or Inactive. Note: The active status of a client account is managed by clicking Edit from the Options drop-down and changing the status in the Active checkbox.
· Options - The following options are available in the Options drop-down:
· Edit - Click Edit to edit the client account settings.
[bookmark: _Ref2141517002][bookmark: _Ref918043044]Create Client Accounts
The Create Client Account page allows you to create new client account organizational units (OU). Client accounts are created so that you can associate subscriptions with certain clients. This helps in tracking subscriptions via custom reporting.
To create client accounts, go to Admin > Tools > Learning > E-Commerce and click the Create Client Account button on the Manage Client Accounts page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Client Account OU - Manage
	Allows administrations to view, create, and edit Client Account organizational units (OU) and manage the Manage Client Accounts page. This is an administrator permission.
	eCommerce - Administration


[image: ]
Create a Client Account
To create a client account, complete the following fields on the Create Client Account page:
· Client Account Name - Enter a name for the client account, up to 100 characters.
· Client Account Owner - Enter an owner for the client account, up to 300 characters.
· Contact Person - Define a contact person for the subscription. Click the Add User icon [image: ], which opens the Add user pop-up. Search for the user, and then click the plus icon [image: ] to the left of the user's name. This closes the pop-up and adds the user as the contact.
· Address Line 1 - Enter the address for the client account, up to 300 characters.
· Address Line 2 - Enter a second address line for the client account, up to 300 characters.
· City - Enter the city, up to 300 characters.
· State - Enter the state, up to 300 characters.
· Zip - Enter the ZIP Code, up to 300 characters.
· Country - Select the country from the drop-down.
· Active - The Active box is checked by default. Uncheck the box to inactivate the client account. If an account is inactivated but has an associated subscription, the subscription remains active unless inactivated or expired.
Cancel/Done
Click Cancel to cancel creating the account.
Click Done to create the account.
Edit Client Account
When editing a client account, all fields are editable. Note: Client accounts can be modified by clicking Edit from the Options drop-down on the Manage Client Accounts page.
[bookmark: _Toc161997434]Manage Subscriptions
From the Manage Subscriptions page, you can manage existing e-commerce subscriptions and create new subscriptions. Subscriptions are packages of training that are typically provided to an organization's external clients.
The availability of the Subscriptions functionality is controlled by backend settings, which are disabled by default. To enable this functionality, contact Global Customer Support.
To access the Manage Subscriptions page, go to Admin > Tools > Learning > E-Commerce. Then, click the Subscriptions link from the E-Commerce section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Subscription - Manage
	Allows administrations to view, create, and edit Subscriptions and manage the Manage Subscriptions page. This is an administrator permission.
	eCommerce - Administration



	Subscription OU - View
	Allows administrations to view Subscription organizational units. This permission can be constrained by OU. This is an administrator permission.
	eCommerce - Administration


Create Subscription
Click the Create subscription button to create a new client account organizational unit (OU). 
Filters
The following filters are available:
· Subscription Name - Enter a full or partial name in the text box to filter the page by subscription name.
· Include inactive and expired - Check the box to display inactive and expired subscriptions on the page. This option is unchecked by default.
Click Search to update the page with the filtered results.
Subscriptions Table
This table displays active, inactive, and expired subscriptions. The subscriptions display in ascending alphabetical order.
The following information displays for each subscription:
· Subscription Name - This column displays the subscription name.
· Account - This column displays the account.
· Contact - This column displays the contact for the subscription.
· Created - This column displays the date on which the subscription was created.
· Starting Date - This column displays the date on which the subscription starts.
· End Date - This column displays the date on which the subscription expires.
· Status - This column displays the status of the subscription, either Active or Inactive. Note: The active status of a subscription is managed by clicking Edit from the Options drop-down and changing the status in the Active checkbox.
· Options - The following options are available in the Options drop-down:
· Edit - Click Edit to edit the subscription settings. When changes to an existing subscription are saved, the changes only apply to users who register for training that is associated with the subscription after the changes are made. The changes do not affect users who currently have training in their transcript that is associated with the subscription.
Create Subscription - Overview
The subscription creation process allows administrators to create subscriptions for client accounts.
The subscription creation process is comprised of three steps:
· Step One (Details) - See Create Subscription - Details on page 30 for additional information.
· Step Two (Catalog) - See Create Subscription - Catalog on page 33 for additional information.
· Step Three (Availability) - See Create Subscription - Availability on page 39 for additional information.
Important: At least one client account must be created before you can create a subscription.
To create subscriptions, go to Admin > Tools > Learning > E-Commerce and click the Create subscription button on the Manage Subscriptions page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Subscription - Manage
	Allows administrations to view, create, and edit Subscriptions and manage the Manage Subscriptions page. This is an administrator permission.
	eCommerce - Administration



	Subscription OU - View
	Allows administrations to view Subscription organizational units. This permission can be constrained by OU. This is an administrator permission.
	eCommerce - Administration


[bookmark: _Ref-1396674081]Create Subscription - Details
From the Details page, define general information about the subscription, such as the name and start/end date. You will also select the client account to which the subscription is associated.
Pre-Step Note: At least one client account must be created before you can create a subscription.
To create subscriptions, go to Admin > Tools > Learning > E-Commerce and click the Create subscription button on the Manage Subscriptions page. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Subscription - Manage
	Allows administrations to view, create, and edit Subscriptions and manage the Manage Subscriptions page. This is an administrator permission.
	eCommerce - Administration


Details
Complete the following fields on the Details page:
· Subscription Name - Enter a name for the subscription, up to 100 characters.
· Starting Date - Define the date on which the subscription will start. You can enter a date in the text box or use the calendar to select a date.
· End Date - Define the date on which the subscription will expire. You can enter a date in the numeric text box or use the calendar to select a date.
· Price - Use the drop-down to select the currency. Then, enter the subscription price in the numeric text box. The price must be greater than 0. Subscription Price is intended only as a way to track the value of a subscription. This does not set a price for the user at this point. It is simply a way to track the value granted to users for reporting purposes.
· Account - Define the client account to which the subscription is associated by clicking the Select icon [image: ]. This opens the Select Client Account pop-up. Search for the desired Client Account organizational unit (OU), and then click the name of the OU. This adds the OU to the Account field.
· Contact - Define a contact person for the subscription. Click the Add User icon [image: ], which opens the Add user pop-up. Search for the user, and then click the plus icon [image: ] to the left of the user's name. This closes the pop-up and adds the user as the contact.
· Custom Fields - Custom fields display below the Contact field.
· Attachment - Drag and drop an attachment, or click Select a file to search for and select an attachment. Some examples of the kinds of files that an administrator might wish to upload are a copy of the purchase order that was used to create the subscription, or a document that has all of the parameters of the subscription from a clients order. The attachments section is a place for administrators to store such documents for quick reference should they need to access them in the future. This makes it so that they do not need to sign into any other system when managing a subscription should they need to reference the documents that are relevant.
Attachment Restrictions
The following attachment restrictions apply:
· Up to three attachments or one video can be added to a post.
· The maximum file size is configured by the system administrator. This limit is controlled by a backend setting, which can be increased up to 1 GB.
· The attachment file name cannot exceed 50 characters.
· Executable files cannot be uploaded.
· Files cannot have a hidden extension or no extension.
The following file types are allowed:
	File Type
	Extension

	Audio
	· mid
· m4a
· mp3
· wav

	Compressed
	· zip

	Data
	· xls/xlsx/xlsm

	Image
	· bmp
· gif
· jpeg/jpg
· png

	Presentation
	· pps/ppsx
· ppt/pptx

	Project
	· mpp

	Recording
	· arf

	Text
	· doc/docx/docm
· dot/dotx
· htm/html
· pdf
· txt

	Vector Graphic
	· vsd

	Video
	· avi
· flv
· m4v
· mov
· mpeg/mpg
· mp4
· rm - This file type is not supported when attaching a video.
· swf - This file type is not supported when attaching a video.
· wma/wmv


Cancel/Next
Click Cancel to cancel creating the subscription.
Click Next to go to the next step of the subscription creation process.
[bookmark: _Ref1333903788]Create Subscription - Catalog
From the Catalog page, define the training criteria for the subscription. The catalog is the package of training that will be available to users and will include certain learning object (LO) types that will be associated with the subscription.
Important Note: At least one client account must be created before you can create a subscription.
To create subscriptions, go to Admin > Tools > Learning > E-Commerce and click the Create subscription button on the Manage Subscriptions page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Course Catalog - Update
	Grants ability to manage and edit training items listed in the Course Catalog and also grants access to the Course Console, where training can also be managed and edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission also allows administrators to reversion online courses via the Course Console page. This permission also allows administrators to access an Edit Training option for training items included as objectives in Development plans. 
This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission.
Note: Adding an OU constraint and a provider constraint to this permission results in an "AND" statement.
	Learning - Administration



	Course Catalog - View
	Grants access to view the learning objects in the course catalog and enables administrators to view the Course Console and the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, and User's LO Availability. This is an administrator permission.
Adding an OU constraint and a provider constraint to this permission results in an "AND" statement.
	Learning - Administration



	Subscription - Manage
	Allows administrations to view, create, and edit Subscriptions and manage the Manage Subscriptions page. This is an administrator permission.
	eCommerce - Administration


[image: ]
Select Training Criteria
Use the Select Training drop-down to determine the training criteria for the subscription. You can add learning object (LO) types as training criteria, as well as training that is assigned to a specific Location organizational unit (OU). You can also add individual LOs.
The following options are available in the Select training criteria drop-down:
Type of Learning Object
To determine the types of LOs that will be available for the catalog:
1. Click Type of Learning Object from the Select training criteria drop-down.
2. Select the training types from the Training Types drop-down. The following options are available in the drop-down:
· All Training - This option adds both the Online Course and Event LO to the catalog.
· Online course - This option adds the Online Course LO to the catalog. All online courses in the portal will be available in the catalog.
· Event - This option adds the Event LO to the catalog. All online courses in the portal will be available in the catalog.
3. Click Add. This adds all LOs within the training type to the catalog.
[image: ]
Location
To add training within a specific Location OU:
1. Click Location from the Select training criteria drop-down.
2. Click the Select icon [image: ]. This opens the Select Location pop-up.
3. Search for a Location OU.
4. Click the title of the Location OU. This closes the pop-up and adds the Location OU to the training criteria for the catalog.
5. Check the Include sub-locations box to include child Location OUs. This option is checked by default.
All training that is within the Location OU will be available in the catalog.
Select Training Criteria - Specific Training
The Specific Training option allows you to add individual LOs to the subscription. This option is only available for users with permission to update or view the course catalog.
Use Case
1. Andrew works at ACME Software. ACME Software's product is an advanced application that is sold to businesses around the world.
2. Salespeople at ACME Software will sell licenses to their software, but as a part of these contracts, they will also include subscriptions to training on how to use ACME’s products.
3. Andrew wants to set up several tiers of subscriptions for different groups of partners and clients, with each tier offering different sets of training.
4. Andrew sets up one subscription offering just a few popular courses, and he sets up another subscription offering a substantially wider selection of courses.
[image: ]
To add specific training to the subscription:
1. Click the Specific Training option from the Select Training Criteria drop-down. This opens the Select Training slideout.
[image: ]
2. Enter search terms in the Search by Training Title search bar. The available training types are online courses, events, sessions, and curricula with curriculum pricing. Note: Curricula with incremental pricing cannot be added to subscriptions.
3. Click the Filter button to show a list of training that matches the search terms and is within your permission constraints for updating or viewing the course catalog. Note: You can also hit Return or Enter on your keyboard to display the search results.
[image: ]
4. Clicking the Filter button enables additional filter options to appear. You can narrow down your training search by using the following additional filter options:
· Training Types - Select one or more of the following training types from the drop-down:
· Curriculum
· Event
· Online Class
· Course Code - Enter a full or partial course code.
· Provider - Click the Select Provider button to open the list of providers. Select one or more providers by checking the box to the left of the provider.
· Languages - For portals with multiple languages enabled, select one or more languages from the drop-down.
· Locator Number - Enter a full or partial locator number.
· Location - Click the Select location button to open the list of Location OUs. Select one or more OUs by checking the box to the left of the OU.
· Description - Enter a full or partial training description.
5. Check the box to the left of the training title to select it for the subscription.
6. Click the Select button at the bottom of the flyout to add the training to the subscription.
[image: ]
Remove Criteria
To remove criteria, check the box to the left of the criteria. This enables a Remove button to display above the criteria table. Click Remove to remove the criteria.
[image: ]
Back/Cancel/Next
· Click Back to return to the previous step of the subscription creation process.
· Click Cancel to cancel creating the subscription.
Click Next to go to the next step of the subscription creation process.
[bookmark: _Ref2143378926]Create Subscription - Availability
The Availability page allows you to define availability criteria for the users who will be able to add the training that is part of the subscription to their transcript.
Pre-Step Note: At least one client account must be created before you can create a subscription.
To create subscriptions, go to Admin > Tools > Learning > E-Commerce and click the Create subscription button on the Manage Subscriptions page.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Subscription - Manage
	Allows administrations to view, create, and edit Subscriptions and manage the Manage Subscriptions page. This is an administrator permission.
	eCommerce - Administration
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Availability
You can select an organizational unit (OU) or users from the Select OU Criteria drop-down. Click Add to add the availability criteria.
[image: ]
Remove Criteria
To remove criteria, check the box to the left of the criteria. This enables a Remove button to display above the criteria table. Click Remove to remove the criteria.
[image: ]
Back/Cancel/Save
· Click Back to return to the previous step of the subscription creation process.
· Click Cancel to cancel creating the subscription.
· Click save to save the subscription.
[bookmark: _Toc161997435][bookmark: concept10]Manage Transactions Overview
The Manage Transactions page enables administrators to view transactions. Administrators can create Purchase by Proxy transactions, initiate refunds, track orders, and reconcile purchase orders.
To enable this functionality, contact Global Customer Support.
To access the Manage Transactions page, go to Admin > Tools > Learning > E-Commerce > Manage Transactions.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Proxy Checkout
	Grants ability to purchase learning objects on behalf of other users. This permission can be constrained by OU and User's OU. The permission constraints determine the users for which the administrator can purchase learning objects. This is an administrator permission.
	eCommerce - Administration



	Transaction Manager - Manage
	Grants ability to access the Manage Transaction page and also create and edit transactions. On the Order History Details page, the administrator can edit the order status, adjust prices, issue refunds, or enter comments. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration



	Transaction Manager - View
	Grants ability to view the Manage Transaction page where the administrator can review the transactions that meet their permission constraints. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Search
Using the Search criteria, administrators can search for transactions by Last Name, First Name, Payment Method, Order Status, Transaction Date, Transaction ID, Item Purchased, and ILT Locator Number. After entering the appropriate criteria, click the Search button. Note: Child items are not searchable unless added to a user's cart independently from the parent.
· Exclude zero-dollar transactions - This option is checked by default and hides all transactions that do not have a price associated with them. If unchecked, all transactions that do not have an associated price them display in the search results, with "0.00" in the Total column. Note: If your portal has a large number of training items that do not have an associated price, unchecking the option could generate a high number of results. You can use the additional filter options to narrow the results.
Transactions
To create a Purchase by Proxy transaction, click the Create New Transaction link in the Transactions section. See Purchase by Proxy Overview on page 44 for additional information.
The Transaction section displays the following information for each transaction:
· Date - The date on which the user submitted the order.
· Transaction ID - The transaction ID for the order.
· User - The user that made the purchase. For Purchase by Proxy functionality, this is the user for whom the purchase was made.
· Identifier - This displays identifying OU information about the user.
· Payment Method - The payment method used during checkout.
· Total - The total amount of the purchase. For training units, this displays the number of training units. For currency, this displays the amount of money along with the appropriate currency symbol. For training units and currency, both are displayed. For a purchase order, the currency value is displayed.
· Status - The status of the transaction. This can be Completed, Pending Payment, or Denied.
The following options are also available for each transaction:
· View Details - This displays the Order Details page for the transaction.
· Edit - This option allows you to view the Order Details page and edit the transaction. Note: This option is only available if you have permission to manage transactions.
From the Order Details page, administrators can initiate refunds and reconcile purchase orders.
Extended Enterprise: 
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[bookmark: _Ref-502618343]Purchase by Proxy Overview
The Purchase by Proxy functionality allows administrators to purchase learning objects on behalf of a user using all types of payment methods. The Shopping Cart must be enabled to utilize this functionality.
For reporting purposes, items purchased by proxy appear as though they were purchased by the user. The purchase is listed on the user's Order History page.
If an inventory purchase is used, it is the administrator's responsibility to ensure the user has the inventory permission. If the user does not have the inventory permission, they cannot assign the inventory training.
See Create Purchase by Proxy on page 46 for additional information.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Proxy Checkout
	Grants ability to purchase learning objects on behalf of other users. This permission can be constrained by OU and User's OU. The permission constraints determine the users for which the administrator can purchase learning objects. This is an administrator permission.
	eCommerce - Administration



	Transaction Manager - Manage
	Grants ability to access the Manage Transaction page and also create and edit transactions. On the Order History Details page, the administrator can edit the order status, adjust prices, issue refunds, or enter comments. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration



	Transaction Manager - View
	Grants ability to view the Manage Transaction page where the administrator can review the transactions that meet their permission constraints. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration


Workflow
1. To initiate a Purchase by Proxy, the user contacts the administrator to register for a learning object.
2. The user then informs the administrator which LO they would like. Note: The LO availability is based on the user's LO constraints.
3. The administrator clicks the Proceed to Checkout option and purchases the LO.
During checkout, the user's payment preferences and LO availability are enforced.
Emails
The following email trigger is available via Email Management in the Billing category:
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Shopping Cart Purchase
	This email is triggered when a shopping cart purchase is made. This email can be sent to the shopping cart owner or the purchase actor.
	Billing


Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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[bookmark: _Ref-161174950]Create Purchase by Proxy
[bookmark: concept12]The Purchase by Proxy functionality allows administrators to purchase learning objects on behalf of a user using all types of payment methods.
To create a Purchase by Proxy transaction, go to Admin > Configuration Tools > Learning > E-Commerce > Manage Transactions, and then click the Create New Transaction link in the Transactions section. The Purchase by Proxy page opens. The Create New Transaction link is only available for users with permission to purchase learning objects on behalf of other users.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce



	Proxy Checkout
	Grants ability to purchase learning objects on behalf of other users. This permission can be constrained by OU and User's OU. The permission constraints determine the users for which the administrator can purchase learning objects. This is an administrator permission.
	eCommerce - Administration


[image: ]
Purchase by Proxy
· Click the Select User pop-up to select the user for which you are creating a purchase by proxy. Note: The list of available users is determined by the administrator's permission constraints.
· Only one user can be selected for each purchase. Once a user is selected, they are displayed in the Select User section along with their phone number if available. Also, the pop-up option is no longer available because only one user can be selected. To change the user, click the Remove icon next to the user's name and select another user.
· After a user is selected, the Select Items section is available. By default, this section displays any items that are currently in the selected user's shopping cart. Click the plus icon to the right of the Select Items heading to add a learning object to be purchased. After selecting the appropriate LOs, click Done. These items appear in the Select Items section. Note: The list of available learning objects for purchase is determined by the user's LO availability constraints. If the user does not have access to the LO, the LO is not available for selection. Also, if the user requires LO approval prior to requesting or purchasing the LO, the Purchase by Proxy functionality does not work.
· Next to each item, the administrator can select whether the LO is being purchased for the user or for the user's inventory. The For User's Inventory option is only available if the user has permission to manage inventory. Also, if the user already has the LO on their transcript, the For User option is not available for that item since an item can only appear on a user's transcript once. To remove an item from the list, click the Remove icon in the Options column.
Click Next to proceed to the user's shopping cart. The shopping cart page follows the user's payment and shopping cart preferences. Note: This is the user's shopping cart, not the administrator's shopping cart. If the administrator clicks the Shopping Cart link in the upper-right corner of the page, they are directed to their own shopping cart.
[image: ]
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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Create Purchase by Proxy - Shopping Cart and Checkout
During a Purchase by Proxy, the user's shopping cart and payment preferences are observed.
The recipient of the training is noted in the Recipient column of the shopping cart.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Price Adjust - Manage
	Grants ability to define a custom price for a user in purchase by proxy. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration



	Proxy Checkout
	Grants ability to purchase learning objects on behalf of other users. This permission can be constrained by OU and User's OU. The permission constraints determine the users for which the administrator can purchase learning objects. This is an administrator permission.
	eCommerce - Administration


Shopping Cart
For inventory purchases, the administrator has the ability to edit the quantities for items. The availability of inventory functionality observes the user's permissions, rather than the administrator's.
The Continue Shopping option is not available during a Purchase by Proxy.
If Coupon Codes are enabled and the user's payment preferences allow coupons, the administrator is able to apply coupon codes during this step.
When creating a purchase by proxy, administrators with the appropriate permission can override the price for a training item on the Shopping Cart page. See Purchase by Proxy - Price Override on page 49 for additional information.
Checkout - Payment
All payment functionality remains the same as if the user is making the purchase. The administrator has access to the user's stored credit card information and can update the user's stored credit card information if a billing profile is enabled and established. When paying by credit card, the administrator must still enter the CVV number to complete the purchase.
Checkout - Review
The user's name and billing address display.
When the order is placed, any active emails are triggered based on the user's email preferences. The user is considered the purchaser for this transaction.
Checkout - Confirmation
The Print option is not available. The administrator can print the invoice on the Order Details page if necessary.
[bookmark: _Ref-1923981271][bookmark: _Ref2005249477]Purchase by Proxy - Price Override
When creating a purchase by proxy transaction, administrators with the appropriate permission can modify the cost of each training item directly from the Shopping Cart page. A Enter discount amount field displays below each training item, which allows the administrator to enter a discount for the training.
[bookmark: concept14]To create a purchase by proxy transaction, go to Admin > Configuration Tools > Manage Transactions. Then, click the Create New Transaction link in the Transactions section. The Purchase by Proxy page opens. The Create New Transaction link is only available for users with permission to purchase learning objects on behalf of other users.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce



	Price Adjust - Manage
	Grants ability to define a custom price for a user in purchase by proxy. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration



	Proxy Checkout
	Grants ability to purchase learning objects on behalf of other users. This permission can be constrained by OU and User's OU. The permission constraints determine the users for which the administrator can purchase learning objects. This is an administrator permission.
	eCommerce - Administration


Discount Unit Price
On the Shopping Cart, a Enter discount amount field is available for each item in the shopping cart, which enables administrators to discount the unit price of the training item for the user.
To discount a training item:
1. Enter the amount of the discount in the Enter discount amount field. The field accepts positive numeric characters up to the full unit price.
[image: ]
2. Click Apply. This subtracts the discount from the purchase price and displays the adjusted amount in the Subtotal column. The cost center payment amount is adjusted, if applicable. To remove the discount prior to proceeding to Checkout, click the Remove icon [image: ] to the right of the Enter discount amount field. This removes the discount and returns the price to the original amount.
[image: ]
Price Adjusted to Zero
If the administrator discounts the full unit price, then when the Proceed to Checkout button is selected, the Payment step is skipped. The administrator is taken to the Review step. If the administrator would like to change the discount, they can click Back on the Review page to readjust the price.
Invalid Discount Amount
If the amount entered in the Enter discount amount field is not a valid amount, then an error message displays below the field, indicating that the discount amount is invalid. Enter a valid amount in the field, and then click Apply.
Coupons
If a coupon is used for a purchase by proxy transaction that includes a unit price discount, the coupon is applied after the unit price discount. The coupon does impact the unit price discount for a training item.
Tax Calculation
If tax is collected on the transaction, the adjusted unit price is used for the tax calculation of the training item.
Purchase Price Discount Workflow
[image: ]
User's Shopping Cart
If the discounted training item is also in the user's shopping cart, the price adjustment does not display in the user's view of the shopping cart.
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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[bookmark: _Ref1745142759]Refunds Overview
[bookmark: concept15]The Refund functionality allows administrators to refund a user's purchase and manage a user's order history. Automated refunds are also available.
Refunds are only available for training units and credit card purchases. Also, refunds are not available if the item was purchased entirely by the user's cost center. If a user has multiple instances of a training item in their transcript, a refund cannot be issued from the transcript.
To enable refunds for your portal, contact Global Customer Support.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Refund Training
	Grants ability to issue a refund for a training item while removing it from the user's transcript. This is an administrator permission.
	eCommerce - Administration



	Remove Training
	Grants ability to remove training from other users' transcripts (training records) when viewing their transcript. This permission can be constrained by OU, User's OU, User's Corporation, User Self and Subordinates, User's Self, User's Direct Subordinates, and User. This is an administrator permission.
	Learning - Administration



	Transaction Manager - Manage
	Grants ability to access the Manage Transaction page and also create and edit transactions. On the Order History Details page, the administrator can edit the order status, adjust prices, issue refunds, or enter comments. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration



	Transaction Manager - View
	Grants ability to view the Manage Transaction page where the administrator can review the transactions that meet their permission constraints. This permission can be constrained by User's OU. This is an administrator permission.
	eCommerce - Administration


Workflow
The following is the refund or price adjustment workflow for each payment type:
· Credit Card
· ILT Sessions:
· If a user withdraws from a session, the user receives a refund directly to their credit card based on the refund terms and administrator approval.
· If a user is charged a no show fee, the fee is charged to the user's cost center.
· If a price adjustment is issued, the difference in price is issued to the user's credit card.
· If no refund terms are established and the administrator removes the ILT session from the transcript, no refund is issued. If the user withdraws, no refund is issued and any withdrawal fee is charged to the user's cost center. Transaction managers can manually issue refunds through the Order History Details page.
· If a session is cancelled by the administrator, all purchases of that session are refunded, even for withdrawn users.
· It is not possible to refund the purchase of Training Units.
Note: When canceling a session, the users who receive a refund are determined by the administrator who cancels the session. Only users that are available to that administrator will receive a refund. This group of users is determined by the constraints applied to the Sessions - Cancel permission for that administrator. To ensure all users receive a refund, the best practice is to cancel the session using an administrator account that does not have any constraints on that permission. Additionally, removing the constraints for the administrator canceling the session will result in all users receiving a refund.
· Other training types:
· Administrator can initiate a refund from the Order History Details page.
· If a refund is initiated, a refund is issued to the user's credit card, minus any processing fees.
· If an adjustment is issued, the difference in price is credited to the user's credit card.
· Access to Training After a Refund - If the refund is issued from the Order History Details page in Manage Transactions, then the user can still launch the training in their transcript, even after the refund. However, if the refund is issued via the user's Transcript page by clicking Remove in the options drop-down, and then selecting the box to refund the training item, then the user will no longer be able to launch the training. This applies to Material, Online Course, and Test learning object types.
· Training Units:
· ILT Sessions
· If a user withdraws from a session, the user receives a refund to their training unit account based on the refund terms and administrator approval.
· If a user is charged a no show fee, the fee is charged to the user's training unit account. If the account has a balance of zero, the user is not charged a no show fee.
· If a price adjustment is issued, the difference in training units is issued to the user's training unit account.
Note: When canceling a session, the users who receive a refund are determined by the administrator who cancels the session. Only users that are available to that administrator will receive a refund. This group of users is determined by the constraints applied to the Sessions - Cancel permission for that administrator. To ensure all users receive a refund, the best practice is to cancel the session using an administrator account that does not have any constraints on that permission. Additionally, removing the constraints for the administrator canceling the session will result in all users receiving a refund.
· Other LOs
· Administrator can initiate a refund from the Order History Details page.
· If a refund is initiated, a refund is issued to the user's training unit account, minus any processing fees.
· If an adjustment is issued, the difference in price is credited to the user's training unit account.
· Inventory purchases for ILT sessions and learning objects do not receive monetary refunds. For ILT purchases, the seat is refunded, and if the seat is expired, no refund is issued. For other learning objects, the learning object is refunded. With inventory purchases for ILT sessions, no show fees are not charged to anyone.
For organizations with their own payment gateway, refunds are issued from their own merchant accounts. For organizations utilizing the Cornerstone payment gateway, the refunded amount is deducted from the current month's earnings.
Refund Timing and Errors
For transactions made via Cybersource, there are special considerations for refunds made through their integration service, which Cornerstone uses. Cybersource sets a refund window (this varies but is usually around 60 days), in which a refund can be made directly to the purchaser. If a refund is processed outside of this window, the cost center will be refunded rather than the purchaser. In the event of an error processing the refund to the purchaser, the cost center will also be refunded instead.
To check if the cost center received the refund, you can run the Enterprise Standard Report, which will break down all refunds by user and cost center. See Enterprise Report.
Course Fees
For courses hosted by Cornerstone, the course fees are not refunded. If a course refund is required due to a defective course, this should be submitted as a Global Customer Support case.
For courses not hosted by Cornerstone, the delivery fees are not refunded.
Emails
The following email triggers are available via Email Management in the Billing category:
	Email
	Description

	Transaction Price Adjusted
	This email is triggered when a transaction price is adjusted by an administrator. This email can be sent to a specific user, the Purchaser, or Price Adjustor.

	Transaction Price Refunded
	This email is triggered when a transaction price is refunded and a course is removed from a transcript by an administrator. This email can be sent to a specific user, the Purchaser, or Refunding Administrator.


[bookmark: _Toc161997436]Self Registration Overview
Self-Registration functionality allows administrators to manage new users coming into the system via pre-defined groups. By sending them to a special URL (or converting that URL to a hypertext link) and assigning the users a code, users will get assigned to a particular group when they register through the Self-Registration page. Each group can then have parameters set which will determine how that user will be classified and handled within the system.
Extended Enterprise: 
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Self Registration Groups - Manage
Self-Registration functionality allows administrators to manage new users coming into the system via pre-defined groups. By sending them to a special URL (or converting that URL to a hypertext link) and assigning the users a code, users will get assigned to a particular group when they register through the Self-Registration page. Each group can then have parameters set which will determine how that user will be classified and handled within the system.
This functionality is available as an optional add-on feature upon request. Please contact Global Customer Support for additional information.
For portals with multiple languages enabled, when a user accesses a page as part of the self-registration process, the page displays in a user's browser language; if a user's browser language is not available in the portal, the user views the Self-Registration page in the portal's default language. However, pages that are configured as part of the anonymous user experience in the Guest User Settings tab are displayed in the portal's default language.
To manage self registration groups, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Available Languages - Modify
	Grants access to choose what languages to which learning objects may be associated when users search for training. This is an administrator permission.
	Core Administration



	Language Preferences - Manage
	Grants ability to set default language for portal/OU and set whether end users may adjust their own portal display language. This is an administrator permission.
	Core Administration



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration



	Self Registration Groups - View
	Grants ability to view Self Registration Groups when selecting Availability (for Training, Tasks, learning assignments, etc.) or User Criteria (for Learning Assignments). This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration



	Self-Registration and User Record Custom Fields - Manage
	Grants access to manage custom fields for user Self Registration and the user record in Custom Field Administration. This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration


[image: ]
Filters
You can search for existing self registration groups by filtering the page to show only groups that match your search terms. To apply a filter:
1. Enter your search terms in the Search box.
2. Use the drop-down to filter by Self Registration Name, Self Registration ID, User Last Name, or User ID.
3. Check the Include inactive box to include groups that have been made inactive.
4. Click Search.
The Corporate Self Registrations table updates to show only groups that match your search terms.
Create New Self Registration Group
Click Create New Self Registration Group to create a new self registration group. See Registration Group - Create - Step 1 - Details on page 60 for additional information.
Manage Custom Fields
Click Create New Self Registration Group to manage self registration custom fields for users who are added to the portal via a self registration group. This opens the User Record and Self Registration Custom Fields page. See User Record and Self Registration Custom Fields.
Corporate Self Registrations Table
The following information and options are available in the table:
· Title - This column displays the title of the group.
· ID - This column displays the unique ID of the group.
· Effective Date - This column displays the date users in the group can begin to self register on the portal.
· Expiration Date - After the expiration date, users can no longer self register themselves into the system.
· Active - Check the box to activate the group. When unchecked, the group is inactive and users cannot self register.
· Owner - This column displays the user who created the group.
· Users - Click the icon [image: ] in the column to view the user names and user IDs of the users in the group. If you have permission to edit user records, you can use the option in the Edit column to make changes to the user record. 
[image: ]
· Copy - Click the Copy [image: ] icon to copy an existing group. This will open a copy of the group with the Name and ID fields blank, the associated URLs cleared, and all other attributes open to editing.
· Edit - Click the Edit icon [image: ] to make changes to the group.
See also:
· Create Registration Group
· Approve Pending User Records
· Manage Users in Self Registration Group
· Manage Custom Fields
· Sample Self Registration Group Pages
· For information on emails for self registration groups, See Emails for Self Registration on page 80 for additional information.
Training Resources
Visit the Extended Enterprise Fundamentals - System Administrator Training page in the Success Center to access additional training resources.
You can also view a short Self Registration training video in the Success Center for more information about the Self Registration functionality.
Extended Enterprise: 
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Registration Group - Create
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, click the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


Create Self-Registration Group
The self-registration group creation process is comprised of five steps:
· Step One (Group Details) - See Registration Group - Create - Step 1 - Details on page 60 for additional information.
· Step Two (Approvals) - See Registration Group - Create - Step 2 - Approvals on page 62 for additional information.
· Step Three (Order) - See Registration Group - Create - Step 3 - Order on page 64 for additional information.
· Step Four (Layout) - See Registration Group - Create - Step 4 - Layout on page 70 for additional information.
· Step Five (Guest User Settings) - See Registration Group - Create - Step 5 - Guest User Settings on page 74 for additional information.
Extended Enterprise: 
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[bookmark: _Ref-846498823]Registration Group - Create - Step 1 - Details
On the Details step of the self-registration group creation process, provide basic information about the self-registration group, such as its name and effective date.
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, click the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


[image: ]
Details
Enter the following details on the Group Details page:
· Name - Enter a name for the self-registration group. If OU Localization is enabled for your portal, click the Translate icon to translate the field into other available languages. A translation for the OU's default language is required for this field.
· ID - Enter the ID the user must enter upon registration on the New User Registration page.
· Owner - Select the registration group owner. This defaults to the creator, but can be changed by clicking the pop-up icon.
· Effective Date - Select a date to make the ID/Code effective.
· Expiration Date - Select the date the group expires. After this date, users cannot enter the ID code to register themselves into the system.
· Leave this field blank if the group should not expire.
· User Inactivation Date - Select the date on which all of the self-registered users are automatically inactivated. This is useful if the self-registration group code is intended to only allow users to access the system for a certain period of time. This is independent of the Expiration Date. This must be a specific date; it cannot be set to a relative date.
· There is a process which runs daily to confirm that any self-registered users who are past the inactivation date are deactivated. Therefore, even if a user is activated via another source such as the User Record or a data load, the user will be automatically deactivated the following day via this process.
· Leave this field blank if the group should not become inactive.
· User Segment - Select whether the group is used for customers or internal employees. Note: This setting does not impact the functionality of the group and is planned for deprecation in an future release.
· Default Language - If OU Localization is enabled for your portal, this displays the default language for the OU. This enables administrators to know which translation will be displayed to a user if a translation is not defined for the user's preferred language. The Default Language value cannot be modified.
· For OUs that are created after OU Localization is enabled, the OU's default language is set to the preferred language of the administrator who creates the OU. This is set at the time the OU is created
· For OUs that are created before OU Localization is enabled, the OU's default language is set to the default language of the portal's top-level OU. This is typically the Corporate Language, and it is set when OU Localization is enabled.
Note: At this time, there is no email associated with inactivating users in a self registration group. A Marketing email can be manually created and sent out to users in a particular self registration group to notify them of the impending inactivation date.
Click Next to continue to the Approvals page or Submit to save changes. See Registration Group - Create - Step 2 - Approvals on page 62 for additional information.
Extended Enterprise: 
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[bookmark: _Ref603266939]Registration Group - Create - Step 2 - Approvals
On the Approvals step of the self-registration group creation process, specify who will approve self-registered users and grant them access to the system.
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, click the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


Approvals
Select who should approve a user before they can access the system. The available options are:
· Email Verification - Users will be required to verify their own email addresses after self registering
· No Approval - Users can automatically access the system
· Approver 
· Manager  
· Self-Registration Group owner 
· User - A specific user you select
· Group - Select a group of approvers for the self-registration groups. You must first create a group that contains the approvers. As a best practice, use only static groups of users. When a user self-registers for the portal, all approvers receive the approval request in their inbox and an email to approve the record. Any approver can approve the record, and the request is removed from all approvers' pending request queue once it is approved. 
· See the Considerations section for additional information.
· See Group - Create/Edit.
Click Next to continue to the Order page or Submit to save changes. See Registration Group - Create - Step 3 - Order on page 64 for additional information.
[image: ]
Considerations when a Group is selected
· Administrators can select static or dynamic groups, but Cornerstone recommends using static groups to ensure the correct users are included. 
· Customers must add and remove users from their group of approvers as needed.
· Administrators can select only one group per self-registration link.
Extended Enterprise: 
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[bookmark: _Ref-1047199384]Registration Group - Create - Step 3 - Order
The Order step of the self-registration group creation process determines the order in which fields appear within the self-registration process. Name, Email Address, and Group Code are required for all users and cannot be removed from this page.
Items that are in the Hidden column do not appear in the self-registration process, while items in the Visible column do.
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, click the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


[image: ]
Add Custom Fields
Click the Add Custom Fields link to add an existing custom field to the registration process. To create a new custom field, See Custom Field Administration.
· Once a custom field is added, it appears in the Visible column and can be moved to a different location by dragging and dropping. Click the Expand icon to configure the field. 
· Use default label (including translations) - When this field is selected, the name of the field displays as the name defined in Custom Field Administration in the default language for the custom field. If any translations have been defined for the field, then the translated value displays for users when completing the self-registration page, if a translated value is available for the user's browser language.
· Display Name - Set the name that is displayed to the users.
· Required - Select this option if the field must be completed.
· Users selects - Select this option to allow the user to complete the field.
· Automatically assign to - Select this option and enter a value to automatically set the value for the user to the specified value.
Add Page Break
Click the Add Page Break link to add a page break to the self-registration process. A page break is used to divide the fields into multiple pages. For example, if on PAGE 1 there is four fields and then a page break, when the user completes the four fields on PAGE 1, they are taken to the next page to complete the fields that appear after the page break. 
· When a page break is added, it appears at the bottom of the Visible fields list. It can be moved to a different location by dragging and dropping.
Expand All
Click the Expand All link to expand all fields that can be customized. Alternatively, you can click the Expand icon [image: ] to the right of a field name to customize the field. When all fields are expanded, you can click the Collapse All link to collapse all fields. 
Order Self-Registration Process
The Order Self-Registration Process table represents the process that users follow when self-registering. The table has two columns: Hidden and Visible. By default, all non-required fields appear in the Hidden column, while all required fields appear in the Visible column.
· PAGE 1 - By default, PAGE 1 is always listed first with the Name and Email Address field. To edit the instructions that appear on the first page, click the Edit icon.
· Name and Email Address - The Name and Email Address field is always in the Visible column because they are always required and cannot be edited. This is done because self-registering users should always be presented with the Name and Email Address fields at the beginning of the self-registration process.
· PAGE BREAK - For each page break, you can edit the instructions that appear on the new page by clicking the Edit icon. You can also delete the page break.
· Create Password - The Create Password field appears as the last item in the Visible column. This row is required and cannot be moved. If approval is not required and a default password is set in the Password Preferences, the Create Password field appears during self-registration and they are required to create a password.
All fields can be dragged and dropped into a different order or column except for the Name and Email Address field.
To edit a field, click the Expand icon [image: ] to the right of the field name. The following options are available for the default fields:
[bookmark: _Toc161997437]Address
This field allows users to enter their physical address. When included on the self-registration page, the following fields display for users to complete:
· Address Line 1
· Address Line 2
· City
· State
· Zip
In the configuration options for the field, you can make the field optional or required. You can also select to automatically set the address to the location in the Location field, which is the default selection for the configuration options.
Approver
· No Approver - click radio button if no Approver is to be assigned to all users in this group
· Allow User to Select Approver - click radio button to allow a user to select their Approver
· Require Manager to Select Manager - click radio button to require a user to select their Approver
· Automatically Assign to - click radio button to and then select Approver that will be assigned to all users in this group
Cost Center
· Automatically assign to - click radio button and select Cost Center that will be assigned to all users in this group 
· User Selects from the Following List - click radio button to allow the user to select from a list of Cost Centers that is created by clicking on the Add Cost Center link to create a list for selection. Include Subordinates - check to include subordinates if applicable. 
Country
This field allows users to select their country. The field displays as a drop-down from which users select their country.
In the configuration options for the field, you can make the field optional or required. You can also select to automatically set the country to the location in the Location field, which is the default selection for the configuration options.
Coupon Code
· The Coupon Code field display name can be customized and can be required. This field allows a self-registering user to enter an LMS coupon code during the registration process.
Division
· Automatically assign to - click radio button and select Division that will be assigned to all users in this group 
· User Selects from the Following List - click radio button to allow the user to select from a list of Divisions that is created by clicking on the Add Division link to create a list for selection. Include Subordinates - check to include subordinates if applicable. 
Grade
· None - click radio button if no grade is to be assigned to this group
· Automatically assign to - click radio button and select Grade that will be assigned to all users in this group
· User selects from the following list - click radio button to allow the user to select from a list of Grades that is created by clicking on the Add Grade link to create a list for selection
Language
· User selects - click radio button to allow the user to select the desired language if applicable
· Automatically assign to - click radio button and select the language from drop-down list to automatically assign to users in this group 
Location
· Automatically assign to - click radio button and select Location that will be assigned to all users in this group
· User Selects from the Following List - click radio button to allow the user to select from a list of Locations that is created by clicking on the Add Location link to create a list for selection. Include Subordinates - check to include subordinates if applicable 
Manager
· No Manager - click radio button if no Manager is to be assigned to all users in this group
· Allow user to select manager - click radio button to allow a user to select their Manager
· Require user to select manager - click radio button to require a user to select their Manager
· Automatically assign to - click radio button to and then select Manager that will be assigned to all users in this group
Phone/Fax
· Require valid phone number for registration - Select this option to require users to enter a valid phone number in order to register. This is an alphanumeric field, which allows users to enter a phone number, as well an extension, etc.
Position
· Automatically assign to - click radio button and select Position that will be assigned to all users in this group 
· User Selects from the Following List - click radio button to allow the user to select from a list of Positions that is created by clicking on the Add Position link to create a list for selection. Include Subordinates - check to include subordinates if applicable. 
Prefix
This field displays as a text box and allows users to enter a prefix, up to 20 characters. In the configuration options for the field, you can make the field required.
Required Approvers
· User selects - click radio button to allow the user to select the number of required approvals for learning object request approvals
· Automatically assign to - click radio button and enter number of required approvals to automatically assign this number of approvals to users in this group
User ID
· Allow User to enter ID - Select this option to allow users to enter a user ID.
· Require User to enter ID - Select this option to require users to enter a user ID.
· Hide this field from users (ID's are generated using system logic) - This option is only available for portals with Cornerstone HR enabled. When this option is selected, the system automatically generates a User ID for the user. If this option is selected, the User ID field must be in the Hidden column. User IDs are created based on the User ID Generation Rules. See User ID Generation Rules for additional information.
· Hide this field from Users (ID's are automatically generated) - Select this option to hide the User ID field and allow the system to automatically generate a user ID. The user ID is the value in the User ID on the user record. When this option is selected, the User ID field cannot be added to the Visible column, since the ID will be auto-generated. Note: If the Allow User to enter ID or Require User to enter ID option is selected, then the User ID field can be added to the Visible column.
· Field Name
· Format - Define the pre-text format and the numeric starting point for the automatically generated User ID. For example, enter C in the first box and 1000 in the second box to begin auto-generation of User ID's with the name C1000, C1001, C1002. The numeric starting point must begin with a non-zero number. This is because this is a numeric field and any zeros at the beginning of the starting point value are omitted. For example, if "01" is entered as the numeric starting point, the system will save the numeric starting point as "1." If it is necessary for the numbering system to begin with a zero, then this should be included as part of the pre-text.
Username
· Allow user to enter - click radio button to allow users to enter their own username 
· Automatically set to user's email address - click radio button to have the system automatically set the username to the user's email address. Note: Multiple users may register with the same email address as long as the option on the Create Self Registration Group page is not selected to automatically make the username equivalent to the user's email address. 
· Automatically set to User ID - click radio button to automatically set the username to the user ID
Next, Preview, or Submit
Click Next to continue to the Layout page. You can also click Preview to view the page or Submit to save changes. See Registration Group - Create - Step 4 - Layout on page 70 for additional information.
Note: When previewing the page, if CAPTCHA is enabled for a portal, a CAPTCHA widget appears on the Self-Registration page preview. The availability of this functionality is controlled by a security setting which can be managed in the Security Health Check tool. 
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[bookmark: _Ref267285035]Registration Group - Create - Step 4 - Layout
The Layout step of the self-registration group creation process allows you to configure the look of the self registration page. You can customize HTML above and below the self registration form fields. You can also add a background image and a transparent color block around the form fields, as well as define the font color of the form fields.
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, click the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


[image: ]
Background Image
This option enables administrators to upload an image that will fill the background of the self registration page. Administrators can select an existing image from the drop-down or click the Choose File button and upload a new image.
When uploading an image, the accepted file types are .gif and .png files up to 1MB.
Form Color Block
This option enables administrators to add a semi-transparent colored box centered around the self registration form fields. Administrators can enter the hex value for the color in the text box or click the Select Color button to select a predefined color.
If an image is not used for the page, then the colored form color block displays without transparency.
Note: If the color white (hex value = ffffff) is selected to display over a background image that includes color within the parameters of the form color block, then the transparency effect still displays over the colored areas.
Best Practice: As a best practice, it is recommended not to use color blocks with a strong red hue. Such hues can obscure the red error messages that display to users on the self registration page.
[image: ]
Form Text Color
This option enables administrators to define the font color for the self registration form fields. Administrators can enter the hex value for the color in the text box or click the Select Color button to select a predefined color.
Above Form
This option enables administrators to add valid HTML that will appear in a fixed rectangle above the self registration form fields. The size of the rectangle is 350px x 250px (or a 1:1.4 ratio).
When in Standard mode, the standard design features display. When in HTML mode, the standard design features do not display and the HTML code can be viewed and modified.
Below Form
This option enables administrators to add valid HTML that will appear in a fixed rectangle below the self registration form fields. The size of the rectangle is 90px x 728px (or a 1:8.08 ratio).
When in Standard mode, the standard design features display. When in HTML mode, the standard design features do not display and the HTML code can be viewed and modified.
Self-Registration Pages Created Prior to the May '15 Release
Prior to the May '15 release, HTML and design options were not automatically enabled. For self-registration pages created prior to the May '15 release, additional options are available that do not apply to newer pages:
· Configure with HTML - Select this option to enable the HTML options for the layout. Once selected the Color and Image sections are replaced with HTML options.
· Colors - Select the colors for the self-registration page.
· Corporate Colors - Select this option to use the settings from the Display Preferences on the top node of the Division organizational unit.
· Clear - Select this option to use a system generated uncolored style.
· Image - Select an image that will display either above the self registration form fields or to the left of the form fields. The following options are available in this section:
· Select Image - Select an image from the drop-down. Or, browse for a new image by clicking Browse, and then upload the image to the page. Note: The PNG file format is not supported. Note: Uploaded images cannot have spaces in the file name.
· Above Page - Select this option to display the image above the self registration form fields.
· Beside Page - Select this option to display the image to the left of the self registration form fields.
Multi-Step Self Registration Pages
For self registration pages that have multiple steps, the settings defined on the Layout tab display across all steps of the self registration process.
Back/Next/Cancel/Preview/Submit
· Click Back to return to the previous step.
· Click Next to continue to the Guest User Settings page. See Registration Group - Create - Step 5 - Guest User Settings on page 74 for additional information.
· Click Cancel to cancel creating or modifying the self registration group.
· Click Preview to preview the self registration page. All settings defined on the Layout tab display in the preview.
· Click Submit to save changes.
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[bookmark: _Ref1409000394]Registration Group - Create - Step 5 - Guest User Settings
On the Guest User Settings step of the self-registration group creation process, configure the experience that users have before they register in the system.
To create a self-registration group, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups. Then, select the Create New Self Registration Group link. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


[image: ]
Guest User Setting
Select whether guest users should be added to the default corporate self-registration group or allow guest users to browse annonymously.
· Corporate Self-Registration Group - Enable the default Corporate Self-Registration Group. This unique URL is created from the information that was entered when creating the self-registration group (e.g., https://portalname.csod.com/selfreg/register.aspx?c=self-reg).
· Extended Enterprise - Enable anonymous user login. This expands the page to include settings to configure URL's, select OU's for Preferences, Navigational Tabs and Links, Custom Pages and Welcome Page. User will be able to browse for training without being registered.
Track URLs for This Self-Registration Group
This section is only available when Extended Enterprise is selected as the Guest User Setting at the top of this page.
This section enables administrators to record and track the various locations where links to this self-registration group have been posted. For example, an organization may post a link to their self-registration group on various customer facing websites to direct them to the self-registration group. If there are multiple self-registration groups and multiple websites involved, it can be easy to lose track of all the places the link is posted. 
To add a URL for a location in which a link to this self-registration group has been posted, select the Add URL link. Then select the Save icon [image: ]. Multiple URLs can be added.
OUs for Preferences
This section is only available when Extended Enterprise is selected as the Guest User Setting at the top of this page.
In this section, select which organizational units will determine preferences for anonymous users before the user completes the self-registration process.
Navigation Tabs and Links
This section is only available when Extended Enterprise is selected as the Guest User Setting at the top of this page.
In this section, configure the navigation tabs and links that will be available to anonymous users before the user completes the self-registration process. See Navigational Tabs and Links.
Custom pages can be included in the navigation tabs. However, they must be created prior to configuring the self-registration group. See Manage Custom Pages.
Welcome Page Configuration
This section is only available when Extended Enterprise is selected as the Guest User Setting at the top of this page.
This section enables administrators to preview and configure the welcome page that is displayed to guest users.
To configure the guest user welcome page, select the Welcome Page Configuration link in the section header. The guest user welcome page can be configured in two different manners, which is determined by a backend setting:
· Custom Page Builder - The Custom Page Builder enables administrators to fully customize the welcome page, including a fully customizable layout and additional widgets. See Welcome Page Preferences - Custom Page Builder.
· Traditional - The traditional method enables administrators to manually edit each message box, image, and widget. See Welcome Page Preferences - Traditional.
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Sample Self Registration Group Pages
Self-Registration Page with Logo on Top:
[image: ]
Approval Notification page with Logo on Top:
[image: ]
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Self Registration - Approve Pending User Records
Approvers can access user registration requests via the Pending User Record page, accessible from the Report page. Note: When creating/editing the self registration group, the Self Registration Approval Settings must be set up to require some type of approval for this report to appear. An Approve User Records link will also appear under Your Inbox on the Welcome Page.
Note: The designated approver must have the Edit User permission to approve user records.
Approve or Deny Self Registration Request
1. Go to Reports > Standard Reports.
2. Click Pending User Records link under Track Employees reports.
3. Click View Details icon.
4. Click Approve Request or Deny Request.
· When an administrator approves a user, the system sets the user's temporary password or the user may be able to set their own password. The user's temporary password must be reset when they log in to the system.
[image: ]
Considerations
· If Cornerstone HR is enabled in the portal, all user record fields will be read-only. The approver can only approve or deny the request. If the approver wants to make change, they can do so after approving the user.
· If Cornerstone HR is disabled in the portal, user record fields can be edited before approval.
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Manage Users in Self Registration Group
Users with permission to manage self-registration groups can manage self-registered users via the Manage Self Registration Groups page.
To manage self-registration groups, go to Admin > Tools > Core Functions > Organizational Units > Manage Self Registration Groups.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration


Manage Self Registration Groups
The following options are available on the Manage Self Registration Groups page:
1. Active [image: ] - Select this option to make a self-registration group active or inactive.
2. Users [image: ] - Select this option to display all users who have registered through the Self Registration Group.
3. Copy [image: ] - Select this option to make a copy of group.
4. Edit [image: ] - Select this option to see details about the user, including the self registration custom fields that where available to the end user when they registered. The Self Registration Custom Fields will appear at the bottom of the user information page. Make any necessary changes and click Submit.
[image: ]
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[bookmark: _Ref980597180]Emails for Self Registration
Emails for the Self Registration functionality are available from the Email Administration page. To find the Self Registration emails quickly, you can use the Select Email Action Type option to filter the page by Self Registration type emails.
For more information about Email Administration: See Email Administration.
The following emails may be activated for Self Registrations:
Self Registration Emails
	EMAIL NAME
	EMAIL DESCRIPTION
	ACTION TYPE



	Activation Email
	This email is sent to users who submit a registration for a self-registration group that requires email verification.  To include a link that the user will click to verify their email address for the self-registration, the following tag must be included in the body of the email: EMAIL.VERIFICATION.LINK
This tag will update with the self-registration email verification link automatically when the user receives the email.
	Self Registration



	Deny User Record
	This email is triggered by the user record approver denying a record.
	Self Registration



	User Approve Record
	This email is triggered when a self-registered user record is approved. If self-registration user records do not require approval, then this email is triggered immediately. If approval is required, then this email is triggered when the user record is approved. This email can be sent to User, User's Approver, or User's Manager.
	Self Registration



	User Record Request
	This email is triggered by a self-registered user submitting their user record for approval.
	Self Registration


Self Registration - Email Verification
When a self-registration group has been configured to allow email verification, users who have self-registered will not have access to the system until their email addresses have been verified. 
If a user has submitted a self-registration but has not yet verified their email address, an administrator can view the user's Pending Approval status via the Users page. Once a user verifies their email address for the self-registration, their system status will change to Active.
Check Your Email Inbox
After the user submits the required information for self-registration, the system displays a message telling the user to check their email inbox and complete their registration. The message also instructs the user to check their spam folder if the email does not arrive. If necessary, the user can click the Resend Email link to have the verification email re-sent to their inbox.
[image: ]
Activation Email
When the activation email for the user's self-registration arrives, the user can click the verification link to verify their email address. The activation email displays to the user as configured by the system administrator. 
[image: ]
Confirmation
After the user has clicked the verification link from the activation email they received, they will see a confirmation message stating that their email has been confirmed. The user can then click the Log In button to log into the system using the credentials they established during the self-registration process.
[image: ]
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Manage Custom Fields
Guest Users and the Shopping Cart
A guest user may search LOs anonymously, and add items to the shopping cart anonymously. When the anonymous user selects Proceed to Checkout, the user navigates to a self registration page, where the user registers; the user then navigates to the Create Password page. After submitting the password the user navigates to the Home Page, where the user will see the Shopping Cart widget with the number of items that where added to it. Selecting the Cart widget will give them access to complete the check out process.
If shopping cart functionality is not active for the self registering user the user will request an LO item, navigate to the payment page, then after the receipt page, will navigate to the transcript page.
Anonymous Browsing
Items added to the shopping cart as an anonymous user remain in the shopping cart when the user logs in to the system.
Workflow
1. A user has two items in the shopping cart, LO1 and LO2.
2. The user logs out of the system and opens a different browser and anonymously browses.
3. The user adds another item to the shopping cart, LO3.
4. The user logs in to the system using their credentials.
5. When the user logs in to the system, LO1, LO2, and LO3 appear in the user's shopping cart.
Google Analytics
Organizations can use their own Google Analytics tracking code to track Web traffic. With Google Analytics, organizations can analyze web traffic and portal metrics which enables them to see trends in system usage or optimize marketing efforts. 
For organizations using the Extended Enterprise functionality, one of the most important areas of the application is the self-registration page. This is because it is an important step consumers must complete before entering the portal to purchase training. Having access to traffic analytics helps marketers fine-tune elements of the self-registration page (e.g., number of fields, call to action, number of pages, etc.) to optimize the number of registrations.
When Google Analytics is enabled in the portal and organizations use their Google Analytics tracking code, web traffic is tracked and reported back to Google Analytics for any page that includes a standard Cornerstone footer as well as any self-registration pages.
Note: Google Analytics can be used by any organization that has a Google Analytics tracking code.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Self Registration Groups - Manage
	Grants ability to create and update/edit self-registration groups, which are configured to make a self-registration page available to people who are not added to the portal via user feed. This permission can be constrained by OU, User's OU, and User's Corporation. This is an administrator permission.
	Core Administration



	Self Registration Groups - View
	Grants ability to view Self Registration Groups when selecting Availability (for Training, Tasks, learning assignments, etc.) or User Criteria (for Learning Assignments). This permission can be constrained by OU and User's OU. This is an administrator permission.
	Core Administration


Use Case
Marisa, a marketing manager at Acme Co, is testing two different layouts for a self-registration page to determine which layout is most effective at convincing consumers to register for the Acme Co website. Marisa has one set of customers go to one self-registration page (i.e., they are one self-registration group), and the other consumers go to a different self-registration page.
Marisa wants to know which page was more effective. She logs in to Google Analytics and looks at the web traffic on each page. For the first self-registration group, she sees that users went through the first step but did not complete the second step. For the second self-registration group, she sees that users went through both steps at a high frequency. Based on this data, Marisa chooses to roll out the second self-registration page to all of her consumers.
Implementation
Google Tag Manager can be enabled via the Edge Marketplace. See Google Tag Manager Integration.
Standard Footer
[image: ]
Workflow: Configuring & Using Google Analytics
1. An administrator opens a Google Analytics account and gets a unique Google Analytics tracking code for the account.
2. The administrator enables and configures the Google Tag Manager integration via the Edge Marketplace.
3. The administrator logs in to Google Analytics to view web traffic analysis of activity on the pages that use a standard Cornerstone footer as well as any self-registration pages.
[bookmark: _Toc161997438][bookmark: concept32]Training Units Overview
Training units allow organizations to create a virtual currency for use by their employees and customers in purchasing training. Internally, companies can use training units as a training budgeting tool. For extended enterprise customers, training units can be used as a virtual token.
If training is available to your users without a limit, training units should not be needed for your portal.
Training units are disabled by default. If your organization would like to use training units, please contact Global Customer Support to have it enabled for your portal.
Note: In order for users to use training unit key codes to purchase training, training unit key codes must also be enabled on the User Payment Preferences page.
Creating a Training Unit Assignment
The Training Unit Assignment creation process has four steps. 
For a general overview of the process, See Training Unit Assignment - Create on page 94 for additional information.
Click any of the links below for more information about the associated step in the process:
1. See Training Unit Assignment - Create - Step 1 - General on page 95 for additional information.
2. See Training Unit Assignment - Create - Step 2 - Availability on page 99 for additional information.
3. See Training Unit Assignment - Create - Step 3 - Emails on page 105 for additional information.
4. See Training Unit Assignment - Create - Step 4 - Confirm on page 107 for additional information.
For information about editing a training unit assignment, See Training Unit Assignment - Edit on page 109 for additional information.
For information about managing a training unit assignment, See Training Unit Administration on page 91 for additional information.
Considerations
Currently, ILT sessions paid for in training units are non-refundable. As a solution, the administrator can reissue training units to the user's account.
Prices charged in training units can be represented using up to two decimal places, and this always rounds up. For example, if the price of an LO is $1.50 and 1 training unit = $1, then the training unit price of the LO is 1.5 training units. If the price of an LO uses more than two decimal places (e.g., 1.234 training units), the training unit price is rounded up to the second decimal place (e.g., 1.234 is rounded to 1.24).
Also, the training unit cost is calculated on a per-item basis. For example, if a user purchases three LOs and the cost for each LO is 1.234 training units, then each LO price is rounded to the second decimal place before the costs are added together (e.g., 1.24 + 1.24 + 1.24).
Note: When purchasing training with training units, the entire purchase must be made with training units and cannot be split with another payment method. If the user has an insufficient number of training units to purchase the training, they will need to purchase more training units to complete the transaction.
Training Units (Distributed)
When implementing distributed training units, designate at least one person as a training unit creator. This person has the ability to administer all training units, including preferences and creating and assigning training units. The training unit creator then assigns training units to users or OUs and assigns a training unit distributor who redistributes the training units to individuals within an OU.
Distributed Training Units Use Cases
Company A needs to control internal training costs. They want to assign 30 training units every month to its Sales Division and allow the Sales Director to distribute these training units to individual employees within the Sales Division. Once the training units are exhausted, no more training can be taken until the next allotment of training units is assigned to the division.
Company B offers free training to its customers but wants to limit how much training each customer can take before they have to pay. 
Distributed Training Units Workflow
To begin the process, the training unit creator either assigns free training units or sells training units. The creator can assign training units to either individual users or an OU. When they are assigned, the creator also designates a training unit distributor.
Once the training units are created and assigned, the training unit distributor must assign those training units to individual accounts to make them available to those users. This is the case even if training units are originally assigned to an individual.
Once the training units are redistributed to individual accounts, those users can use those training units to purchase training.
Training Units (Key Code)
With key codes, a distributor is not required to redistribute training units.
Instead of training units being distributed by a distributor, the training unit creator can assign training units to a key code. Users can then use the key code at checkout. This method uses "first come, first served" logic, where multiple users access the same bucket of training units using the same key code.
Training Unit (Keycode) is considered a separate payment method, compared to Training Unit (Distributed). Users cannot purchase additional key code training units; they can only purchase distributed training units.
Key Code Training Units Workflow
If the user does not have sufficient key code training units when checking out, the user may pay the remaining balance with any purchased or distributed training units in their account. If the user does not have sufficient training units (key code or other), the administrator may allow users to pay the remaining balance by credit card or request bill.
If a user is redeeming a key code with multiple available groups of training units, the system uses training units in the following order:
1. Training units that are first to expire.
2. The largest available group of training units.
Training Unit Keycode FAQs
What is a training unit key code?
A training unit key code is a unique, 10-digit, auto-generated number that is used to store a user's training units. The key code number is confidential but can be viewed on the Manage Training Unit Key Code page.
The key code is entered during the checkout process when purchasing training. The system checks the key code balance to determine if there are enough training units to purchase the training item. If there are enough training units, then the user can check out using their key code. If there are not enough training units, then the user can request to be billed, if the administrator has configured the payment process to allow billing. If the payment process is not configured to allow users to be billed, then the user must either select a different payment method or they cannot check out.
How does the user receive the key code?
Once checkout is completed for the training unit key code purchase, the key code is sent to the user via the Monthly Training Unit Balance email, if the email is configured by the administrator.
Can a user refill their key code?
No. For key codes, training units can only be refilled by assigning training units to the key code. Only users with the appropriate permissions can assign training units.
Can the auto-generated monetary value for the key code be changed using the Customize Training Unit Keycode feature?
Yes. However, changing the auto-generated value will create inaccuracies in reporting, since the user has already paid for the training unit key code using their OU's monetary value.
Who is the training unit key code contact?
The user that purchases the training unit key code is automatically identified as the training unit key code contact. Note: Training unit key code contacts can be added from the Manage Training Unit Key Code page by clicking the Edit icon in the Options column.See Training Unit (Key Code) Management.
Is the key code amount adjustable?
Yes. The key code amount can be adjusted when editing the key code from the Manage Training Unit Key Code page. See Training Unit (Key Code) Management.
If a coupon is used to purchase a key code, what price displays for the key code in reporting?
Reporting displays the discounted price.
What emails are associated with the purchase of a key code?
· Shopping Cart Purchase - If configured by the administrator, this email is triggered when the key code purchase is completed. This email serves as the transaction receipt.
· Monthly Training Unit Balance - If configured by the administrator, this email is triggered on the date the key code is purchased and on the last day of each month. This email provides the user with the number of available training units on their key code. Best Practice: If Training Unit Preferences are configured not to allow users to view their training unit key code balance in My Account, then it is a best practice to configure the Monthly Training Unit Balance email. Otherwise, end users do not have a way to view their key code balance.
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[bookmark: _Ref938812408]Training Unit Administration
The Track Training Unit Assignment page allows training unit owners to manage training unit assignments in the following ways:
· Assign distributed or key code training units to specific users or an organizational unit
· Copy training unit assignments
Note: In order for users to use training units to purchase training, training units must also be enabled on the User Payment Preferences page.
To access Training Unit Administration, go to Admin > Tools > Learning > E-Commerce > Training Units.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration



	Training Unit Assignment - View
	Grants ability to view assignments of training units without being able to add or edit assignments. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Track Training Unit Assignment
On this page, any existing training unit assignments display. Search for a training unit assignment using the Search field and the date criteria. The search functionality searches titles of all existing training assignments within the date criteria.
Create a new assignment by clicking the Create New Assignment link, which takes you to the Training Unit Assignment page. The Training Unit Assignment page allows administrators to schedule standard and recurring training unit assignments to users and OUs.
In the table, the following information displays for each assignment:
· Title - Title of the assignment
· Type - Either Recurring or Standard
· Distribution Type - Either Distributed or Key Code
· Units Per Assignment
· Processed Cycles - This is the number of cycles that have been processed, based on the recurrence rules for that assignment.
· Status - The status displays whether the assignment is Active, Cancelled, or Processed.
· For Standard assignments, the status is Scheduled when it is created, and then becomes processed after the assignment is made.
· For Recurring assignments, the status is Scheduled when it is created, and then becomes Active once the first assignment is made.
· If a status is Active or Cancelled, you can click the status to switch it.
· Active assignments cannot be edited, but they can be cancelled by the administrator.
· Last Processed - The date the assignment rule was last processed.
· Create Date - The date the assignment was created.
· Created By - The person who created the assignment rule. This is not changed if the assignment is modified, but this is traceable through the modification history.
· Options
· Copy - Clicking this option takes you to the Copy Training Unit Assignment page, with the details of that assignment copied. You can continue modifying the details of the assignment. The title is removed, so you must enter a new title for your assignment.
· Edit - This option only displays for administrators with permission to assign training units. Clicking the Edit icon opens the Edit Training Unit Assignment page, from which administrators can edit the expiration date, distributor, and training contact.
· View Details - This option only displays for administrators who do not have permission to assign training units. Clicking this option takes you to the Distribute Training Units page. The specific batch assignment is displayed and the assignment can be modified.
Each training unit assignment is expandable by clicking the arrow to the left of the assignment table. When a row is expanded, the following information is displayed:
· Acquired Date - The date the instance is assigned.
· Training Units - The total number of training units originally assigned in the instance.
· Assigned - The number of training units being assigned in the instance to either a key code or a distributor.
· Available - The number of training units still available.
· Expires - The date the instance is set to expire.
· Options - Click the Edit icon to edit the assignment. All assignments can be edited, including expired assignments.
[image: ]
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[bookmark: _Ref831715102][bookmark: _Ref-95593776]Training Unit Assignment - Create
To create a training unit assignment, go to Admin > Tools > Learning > E-Commerce > Training Units. Then, click the Create New Assignment link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


There are four steps for creating a training unit assignment:
· See Training Unit Assignment - Create - Step 1 - General on page 95 for additional information.
· See Training Unit Assignment - Create - Step 2 - Availability on page 99 for additional information.
· See Training Unit Assignment - Create - Step 3 - Emails on page 105 for additional information.
· See Training Unit Assignment - Create - Step 4 - Confirm on page 107 for additional information.
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[bookmark: _Ref-60667377][bookmark: _Ref1122397603]Training Unit Assignment - Create - Step 1 - General
In the General section of the Create New Training Unit Assignment process, define the training unit assignment schedule.
Make a one-time assignment or a recurring assignment. Select whether the distribution method is Distributor or Key Code. Assignments can be scheduled immediately or for a specific date, and you can configure training units to expire. If an assignment is recurring, set the recurrence for a fixed date each year or a date relative to the previous assignment.
When creating a new training unit assignment, it is important to consider that training units are considered property of the training unit creator and the company. Be aware of the financial implications when assigning training units, as they are considered a virtual currency. In eCommerce situations, training units are used to redeem training.
Note: In order for users to use training units to purchase training, training units must also be enabled on the User Payment Preferences page.
To create a training unit assignment, go to Admin > Tools > Learning > E-Commerce > Training Units. Then, click the Create New Assignment link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Define Training Units Assignment Schedule
On the General step, configure the following options:
Assignment Title
Enter a title for the assignment, up to 100 characters.
Assignment Type
Choose from the following assignment types:
· Standard - Select Standard to schedule all of the training units to be assigned at once.
· Recurring - Select Recurring to schedule the training units on a recurring basis annually or relative to the previous assignment.
[bookmark: _Toc161997439]Distribution Method
Choose from the following distribution methods:
· Distributor - Select this option to have a designated training units distributor who is required to redistribute the allocated training units to users. This option allow the organization to more closely control how the training units are distributed.
· Key Code - Select this option to allow users to access the available training units via a key code. This option uses a first come, first served system and gives the organization less control over how the training units are distributed. When this option is selected, the Users will be restricted from viewing the balance option displays.
· Users will be restricted from viewing the balance - The Users will be restricted from viewing the balance option only displays when the Key Code option is selected. This option is unselected by default. When unselected, users can view their key code balance on the My Account page and during the checkout process in the Shopping Cart. When this option is selected, users cannot view their key code balance on the My Account page or during the checkout process.
Scheduling
Define when the training units are assigned. The following options are available:
· Immediately - Choose this option to assign training units immediately upon the submission of the assignment.
· Start Date - Choose this option to select a specific date on which the training units will be assigned.
Expiration Date
Define when the training units will expire. When training units expire, they can no longer be redeemed for training. Only the training unit creator can assign an expiration date. The following expiration date options are available:
The expiration date can be changed to any of the expiration date options.
· None - If this option is selected, then all training unit instances for the assignment are updated with the change. This includes expired, not expired, assigned, and not assigned training units.
· Fixed Date - If this option is selected, then the new date must be a date in the future. The date may be a date prior to the original expiration date but must be a future date from today's date. All training unit instances for the assignment are updated with the change, which includes expired, not expired, assigned, and not assigned training units.
· Relative Date - If this option is selected, then all training unit instances for the assignment are updated with the change. This includes expired, not expired, assigned, and not assigned training units.
Recurrence
This option only appears if the Assignment Type field is set to Recurring. Here, define the recurrence schedule. This can be a fixed annual date or it can be relative to the previous assignment.
Next/Cancel
When complete, click Next to continue to the Availability section. See Training Unit Assignment - Create - Step 2 - Availability on page 99 for additional information.
Or, click Cancel to cancel creating the training unit assignment and return to the Track Training Unit Assignment page.
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[bookmark: _Ref2021650307]Training Unit Assignment - Create - Step 2 - Availability
In the Availability section of the Create New Training Unit Assignment process, determine to whom the assigned training units are available. Also, depending on the distribution method selected in the General section, you must either specify who is responsible for allocating those training units within the assigned groups or specify the key code details.
Note: In order for users to use training units to purchase training, training units must also be enabled on the User Payment Preferences page.
To create a training unit assignment, go to Admin > Tools > Learning > E-Commerce > Training Units. Then, click the Create New Assignment link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Availability
In the Availability section, choose who will receive the training units. Select specific users, OUs, or create a new group. When you select an OU or users, they appear in the table below. Choose whether or not to include their subordinates in the assignment and specify the number of training units they are assigned.
· The Training Unit Creator has the ability to assign unlimited training units.
· If training units are assigned to a parent OU and the Include Subordinates option is selected, the distributor can distribute those training units to members of the child OU as well.
· The Amount of training units assigned must be a positive value and may contain up to two decimal places.
· The maximum number of training units that can be assigned is 999,999.
Distributors
The Distributor section displays if Distributor is selected as the distribution method on the General step. In the Distributors section, specify who can allocate training units to specific users within the users and OUs specified in the Availability section. People assigned as distributors automatically are given access to the Distribute Training Units page.
When editing a training unit assignment, the distributor can be modified. Modifying the distributor affects the Training Unit Distribution Assigned and Training Unit Distribution Expires emails. When the change to the distributor is saved, the distributor is automatically updated in the above emails.
Add Training Unit Distributor
To add a distributor, select an option from the Select OU Criteria drop-down. If selecting All Users, then click the Add button to add the option to the Distributors section. If selecting an organizational unit (OU) or specific user, then select the OU or user from the pop-up.
Check or uncheck the Include Subordinates option to include subordinate OUs or users.
Click Save on the Confirm page to save the changes. Note: If the administrator navigates away from the Availability tab without saving the changes on the Confirm tab, then the changes are lost upon returning to the Availability tab.
The following occurs in the system when a distributor is added:
· If the user is not a distributor on any training unit assignments, then the user is dynamically assigned the permission to distribute training units.
· The user can view the training unit assignment and therefore distribute the training units.
· Any training units that had previously been distributed to end users remain distributed to those end users, and the new distributor can see what had been distributed.
· Any training units that had not previously been distributed to end users remain available for distribution, and the new distributor can see and distribute those training units.
· Any training units that had expired in the training unit assignment remain expired.
Note: If training units are assigned to an individual user, a distributor is still required to assign the training units to that user's individual account.
Remove Training Unit Distributor
To remove a distributor, click the Delete icon [image: ] in the Remove column. Click Save on the Confirm page to save the changes. Note: Training unit assignments must have at least one distributor.
The following occurs in the system when a distributor is removed:
· The user who is removed can no longer view the training unit assignment on the Distribute Training Units page, and thus can no longer assign the training units. 
· If the distributor is removed as a distributor from all training unit assignments, then the permission to distribute training units is dynamically removed from the user’s security permissions.
· Any training units that had previously been distributed to end users remain distributed to those end users.
· Any training units that had not previously been distributed to end users remain available for distribution.
· Any training units that had expired in the training unit assignment remain expired.
Note: If the administrator navigates away from the Availability tab without saving the changes on the Confirm tab, then the changes are lost upon returning to the Availability tab.
Training Unit Contact
This section displays for distributed training unit assignments. The Training Unit Contact section allows administrators to add a contact person for the training unit assignment.
Add Training Unit Contact
To add a training unit contact, click the Select icon in the Contact field. Then, select a user from the pop-up. This adds the user as the training contact. Up to 10 contacts can be added. This is a required field.
Once a contact is added, the contact can be removed by clicking the Delete icon [image: ] in the Remove column.
Note: If the administrator navigates away from the Availability tab without saving the changes on the Confirm tab, then the changes are lost upon returning to the Availability tab.
Note: If the contact is modified on the Training Unit Distribution Details page, then the Training Unit Contact section is updated on the Training Unit Assignment page.
Edit Training Unit Contact
The training unit contact can be modified after the training unit assignment is created. The contact can be removed by clicking the Delete icon [image: ], and additional contacts can be added.
Training unit assignments must have at least one training unit contact.
Note: If the contact is modified on the Training Unit Distribution Details page, then the Training Unit Contact section is updated on the Training Unit Assignment page.
Purchased Training Units
For training units that are purchased from the Distribute Training Units page, the user who purchases the training units is automatically added as the training contact. The contact can be removed on the Availability tab of the Edit Training Unit Assignment page, or additional contacts can be added.
Key Code
The Key Code section displays if Key Code is selected as the distribution method on the General step.
[image: ]
The following options are available in the Key Code section:
· Key Code - The Key Code option enables you to create a new key code or use an existing key code by selecting the corresponding option. Key codes must be unique to ensure that training units are being managed accurately.
· Create New Code - If you choose to create a new key code, a text box appears next to the option. Enter the new key code and click Validate to ensure that the key code name is not already in use. 
· The character limit for the field is 15. 
· The code must contain only letters and numbers. Spaces and special characters are not allowed.
· The code is not case sensitive (e.g., Sales2011 = sales2011 = SALES2011).
· Use Existing Code - If you choose to use an existing key code, you are adding training units to that code. A text box appears next to the option. Enter the existing key code and click Validate to ensure that the key code entered matches an existing key code.
· If the training unit assignment creator does not have access to the existing key code, they cannot use that existing key code. They can either select a different code or create a new code.
· Contact - Click the Search icon to select a contact for the training unit assignment. The selected contact is the contact for assignment, including all triggered emails that are sent to the TU Contact role. Only one contact can be selected for a key code.
· Training Unit Details - This field enables you to enter details about the training unit assignment. The maximum character limit is 100. The field accepts both text and numerical values but does not accept HTML. This is not a required field. Additional Training Unit Details fields cannot be added.
· Additional Comments - This field enables you to enter comments about the training unit assignment. The maximum character limit is 500. The field accepts both text and numerical values but does not accept HTML. This is not a required field. Additional Additional Comments fields cannot be added.
Note: If the Use Existing Code option is selected in the Key Code field, the Training Unit Details and Additional Comments fields are not visible until the key code is validated.
Next
When all fields are completed, click Next to continue to the Emails section. See Training Unit Assignment - Create - Step 3 - Emails on page 105 for additional information.
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[bookmark: _Ref-681983892]Training Unit Assignment - Create - Step 3 - Emails
In the Emails section of the Create New Training Unit Assignment process, define which emails should be triggered regarding training unit assignments.
Customize email triggers for the training unit assignments, use the standard email triggers from the Email Administration page, or disable emails for the assignment.
Note: In order for users to use training units to purchase training, training units must also be enabled on the User Payment Preferences page.
To create a training unit assignment, go to Admin > Tools > Learning > E-Commerce > Training Units. Then, click the Create New Assignment link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
When complete, click Next to continue to the Confirm section. See Training Unit Assignment - Create on page 94 for additional information.
You have the following options for training unit assignment emails:
· System Defaults - This selection uses the default emails based on settings and availability from the Email Administration page.
· Custom Emails - This selection allows you to customize the emails for this assignment. The list of customizable emails is listed below in the Email Administration section.
· No Emails - No emails are sent regarding this assignment. This includes when training units are assigned and when they expire.
There is no option to disable the Emails step. Also, there is no separate permission for managing emails within the assignment.
The available email triggers are:
· Training Unit Distribution Created - This email is triggered when a training unit distribution batch is assigned to a distributor. The email is sent to the distributor responsible for distributing the training units.
· Training Unit Distribution Assigned - This email is triggered when a distributor assigns training units to a user. The email is sent to the user receiving the training units.
· Training Unit Distribution Expires - This reminder email is triggered when training units are scheduled to expire. The email is sent to the distributor of the training units so they take action if necessary. The distributor may choose to redistribute those training units.
· Training Unit Expires - This reminder email is triggered when training units are scheduled to expire. This email is sent to the user whose training units are expiring.
The Training Unit Revoked email is not available on this screen, but can be managed from the Email Administration page.
All emails for the distributor are suppressed once all training units are distributed. All emails for the user are suppressed once all training units are used.
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[bookmark: _Ref1010283013]Training Unit Assignment - Create - Step 4 - Confirm
On the Confirm page, an overview of the assignment is displayed. A Modification History section displays below the Confirm section.
To create a training unit assignment, go to Admin > Tools > Learning > E-Commerce > Training Units. Then, click the Create New Assignment link.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Modification History
The Modification History section displays the assignment creation details, as well as changes to the assignment. The section displays for both distributed and key code training unit assignments
The following information displays in the Modification History section:
· Training Unit Assignment Creation - When a training unit assignment is created, the Modification History section is updated. The first and last name of the administrator who made the change displays. The date and time are also included and display in the time zone of the administrator who is viewing the change.
· Distributor Removed - When a training unit distributor is removed, the Modification History section is updated. The first and last name of the administrator who made the change displays. If the Include Subordinates option is modified, the Modification History section also records the change. The date and time are also included and display in the time zone of the administrator who is viewing the change.
· Distributor Added - When a training unit distributor is added, the Modification History section is updated. The first and last name of the administrator who made the change displays. If the Include Subordinates option is modified, the Modification History section also records the change. The date and time are also included and display in the time zone of the administrator who is viewing the change.
· Expiration Date Change - When the training unit assignment expiration date is changed, the Modification History section is updated. The first and last name of the administrator who made the change displays. The date and time are also included and display in the time zone of the administrator who is viewing the change.
· Training Unit Contact Removed - When a training unit contact is removed, the Modification History section is updated. The first and last name of the administrator who made the change displays. The date and time are also included and display in the time zone of the administrator who is viewing the change.
· Training Unit Contact Added - When a training unit contact is added, the Modification History section is updated. The first and last name of the administrator who made the change displays. The date and time are also included and display in the time zone of the administrator who is viewing the change.
Save
Click Save to finalize the training unit assignment. The distributor can then redistribute the training based on the rules set in the assignment. The appropriate emails are triggered, if enabled on the Emails page or in Email Administration.
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[bookmark: _Ref-870727538]Training Unit Assignment - Edit
From the Training Unit Distribution page, training unit creators can edit a training unit distribution. When a creator clicks the Edit icon, they are redirected to the Edit Training Unit Distribution page, where they can adjust the expiration date, training unit balance, and leave comments regarding the adjustment.
To access Training Unit Administration, go to Admin > Tools > Learning > E-Commerce > Training Units.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Assignment
	Grants ability to assign a block of training units to an org unit or group and to edit training units once they have been created. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


Edit Training Unit Distribution
To edit a training unit distribution:
1. From the Training Unit Distribution page, click the down arrow to the left of the training unit distribution title you are editing. This expands the distribution, displaying details for each assignment. 
[image: ]
2. Next to the appropriate assignment, in the Options column, click the Edit icon.
[image: ]
3. The following information and fields display on the Edit Training Unit Distribution page:
· Assignment Title - This field displays the assignment title.
· Assignment Type - This field displays the assignment type, either Standard or Recurring.
· Scheduling - This field displays the assignment scheduling, either Immediately or a specific start date.
· Expiration Date - This field displays the expiration date. The date is editable for both distributed and key code training unit assignments. To edit the distribution expiration date, next to the Expiration Date, click the Edit icon. If None is selected, then all training unit instances for the assignment are updated with the change. This includes expired, not expired, assigned, and not assigned training units. If Fixed Date is selected, then the new date must be a date in the future. The date may be a date prior to the original expiration date but must be a future date from today's date. All training unit instances for the assignment are updated with the change, which includes expired, not expired, assigned, and not assigned training units. To remove a contact, click the Delete icon [image: ] to the left of the contact's name. The expiration date is editable even after expiration.
Note: Changing the expiration date affects the Training Unit Adjustment Email (Key Code), Training Unit Distribution Assigned, Training Unit Distribution Expires, and Training Unit Expires (Key Code) emails. When the change to the expiration date is saved, the email displays the updated expiration date the next time the email is triggered.
· Contact Person - This field displays the contact person defined for the assignment. This field is editable for both distributed and key code training unit assignments.
· Distributed - To edit the distributed training unit contact, click the Select icon [image: ] and select a name from the Select Users pop-up. To remove a contact, click the Delete icon [image: ] to the left of the user's name. At least one contact must be configured for the assignment. Changes made to the contact on the Training Unit Distribution Details page display in the Modification History section on this page and in the training unit assignment.
· Key Code - To edit the training unit key code distribution contact, next to the contact name, click the Edit icon. The key code contact has access to the Key Code Management page. The date can be changed to a date in the future, even if the training unit expiration date has passed.
· Amount - To edit the distribution amounts, in the Availability section, in the Amount column next to the appropriate assignment enter the new amount and click Save. Training unit amounts can be represented using up to two decimal places.
· Comments - To add a comment regarding the distribution or any adjustments made, enter the comment in the Comments field and click Save. The character limit for comments is 500.
· Modification History - This section displays the history of modifications to the assignment.
Save
Click the Save button to save your edits.
[bookmark: _Toc161997440]Miscellaneous E-Commerce
Anonymous Deep Linking
Organizations can deep link to a training item's Learning Details page for anonymous users. Deep linking is only available for Global Search LO details pages.
This is only available to organizations using self-registration functionality.
To create an anonymous deep link, follow these steps:
1. Obtain the anonymous user link from the Guest User Settings page when creating or editing the self-registration group. In this example, the anonymous user link is: https://Demopm.csod.com/default.aspx?c=self-reg.
[image: ]
2. Obtain the LO ID of the LO for which you are creating an anonymous deep link from the General page when creating or editing the training item via the Course Catalog. In this example, the learning object ID is: 415057cf-20de-4b76-9d6a-85eaad6ffbbe.
[image: ]
3. Merge the anonymous user link with the LO ID in the following manner: SelfRegGroupURL + "&loid=" + LOID. In this example, the following URL is an anonymous deep link to the LO details page: 
[image: ]
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Cybersource Payment Processor
The payment processor for the system is Cybersource. This enables the system to include sales tax functionality, recurring billing, subscription, improve payment processing security, and process credit card charges in multiple currencies. To implement sales tax functionality, contact Global Customer Support.
Customers can have their own payment processing account and merchants account through Cybersource. To be eligible, you must be using the system's Ecommerce functionality and you cannot use the system PayGo content. In this case, the system no longer handles the payment processing and reimbursement. To implement your own merchant account, contact Global Customer Support.
There are setup costs for establishing your own merchant account:
· A one-time system setup/implementation fee
· Cybersource Gateway ID registration
· Monthly minimum purchase activity
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Create Cybersource Transaction Key
Cornerstone's Cybersource integration requires a SOAP API transaction key in order to authenticate and pass transaction details to Cybersource for processing. The transaction key is different for each environment and is mapped as follows:
· Cornerstone Stage, Pilot = Cybersource Test
· Cornerstone Production = Cybersource Live
The transaction key expires three years after it is generated, so it is important to check and ensure that you are using a valid one for each payment account.
To generate a new transaction key, you'll need access to Cybersource's Business Center and Cornerstone's Modify Payment Accounts page. Please note which Cybersource environment you need to log into based on the impacted environment.
1. Click on the View All Keys link in the Expiring Keys section of the Dashboard page.
[image: ]
2. On the Key Management page, click the Generate Key button.
[image: ]
3. Click the Transaction Processing option for the key type.
4. Choose the SOAP option for the key subtype.
5. Copy the key for use with the Cornerstone system. You can also download the key if needed.
[image: ]
6. To set up your Cybersource gateway on the Cornerstone home page, within the system, go to Admin > Preferences. Then select Modify Payment Account.
7. Edit the appropriate account, enter this key in the Transaction Key field. Save your changes.
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[bookmark: _Ref1827951663]Sales Tax Overview
Sales tax functionality is available for any LO type. The sales tax functionality is set by the administrator in the following areas of the system:
· Course Catalog - Online Course, Quick Course/Library, Test, Material
· ILT Create Event - Event
· Curricula Administration - Curriculum
· Test Engine
Sales tax may be applied when a user checks out using the Credit Card payment method to pay for training. Note: Sales tax is not applied to the purchase of training units, even if the purchase is made with a credit card and the portal is configured to apply sales tax. Purchases of training made with training units will also not have sales tax applied.
To utilize sales tax functionality in the system, you must own a CyberSource gateway ID and set up a tax nexus with CyberSource. 
· Sales tax functionality is unavailable if you are using a CSOD merchant account. 
· Sales tax functionality is not applicable if you are using CSOD PayGo content.
· Organizations that have a CyberSource account or gateway are no longer charged processing fees to LOs, but delivery fees are still applicable.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Course Catalog - Update
	Grants ability to manage and edit training items listed in the Course Catalog and also grants access to the Course Console, where training can also be managed and edited. This permission also grants access to the Popular Requests and Highest Rated widgets on the Learning Admin Console (in conjunction with the Learning Admin Console - View permission). This permission also allows administrators to reversion online courses via the Course Console page. This permission also allows administrators to access an Edit Training option for training items included as objectives in Development plans. 
This permission can be constrained by OU, User's OU, Training Type, Training Item, Provider, ILT Provider, User's ILT Provider, User, User Self and Subordinates, and User's LO Availability. This is an administrator permission.
Note: Adding an OU constraint and a provider constraint to this permission results in an "AND" statement.
	Learning - Administration



	Curricula Admin - Manage
	Grants ability to create new and edit/update existing curricula. This permission can be constrained by OU, User's OU, Provider, and User's LO Availability. This is an administrator permission.
Adding an OU constraint and a provider constraint to this permission results in an "AND" statement.
Tip: Do not constrain this permission to your entire corporation; it can cause long page load times and timeout errors. Applying this constraint is functionally the same as leaving the permission unconstrained, but omitting this constraint does not cause the system to do the unnecessary constraint checks as in the former scenario.
	Learning - Administration



	Sessions - Create
	Grants ability to create new instructor led training sessions. This permission works in conjunction with Events - View and Sessions - View permissions. Administrators can only create sessions for events for which they have the availability to view. When adding users to a session in which the session roster is full, this permission grants the ability to increase the session's available seats. This permission can be constrained by OU, User's OU, Instructor, User as Instructor, Facility, Facilities Owned by User, ILT Provider, User's ILT Provider, User, and User Self and Subordinates. This is an administrator permission.
Note: The "Restrict to User as Instructor" constraint is available, but it does not actually constrain the permission.
	Learning - Administration



	Sessions - Edit
	Grants ability to edit/update existing instructor led training sessions. This permission works in conjunction with Events - View and Sessions - View permissions. Administrators can only edit sessions for which they have the availability to view and edit. When adding users to a session in which the session roster is full, this permission grants the ability to increase the session's available seats. This permission can be constrained by OU, User's OU, Instructor, User as Instructor, Facility, Facilities Owned by User, ILT Provider, User's ILT Provider, User, and User Self and Subordinates. This is an administrator permission.
	Learning - Administration



	Test Engine - Manage
	Grants ability to create and edit/manage tests via the Test Engine. This permission can be constrained by OU, User’s OU, User, User’s Self, and User’s Subordinates. This is an administrator permission.
	Learning - Administration


Implementation
To implement sales tax, contact Global Customer Support.
For US customers, the following are required to implement sales tax functionality:
· CyberSource Gateway ID
· CyberSource Password
· Merchant Account Information
· Tax Nexus Information. You must provide Cornerstone with tax nexus information prior to implementation.
For International customers, the following are required to implement sales tax functionality:
· CyberSource Gateway ID
· CyberSource Password
· Merchant Account Information
· VAT/GST Registration Information (if applicable) 
Clients have the opportunity to test the sales tax functionality in their Pilot portal using a CyberSource test credit card.
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Shopping Cart and Inventory Overview
Shopping Cart functionality and Inventory allow:
· Users to purchase more than one learning object in a single transaction.
· Pre-purchase learning objects to be assigned to other users via Inventory.
· Print a shopping cart summary or purchase summary that will print in the seller's loaded document template.
· Customize the shopping cart with HTML boxes by division.
· Guest users to shop anonymously, and when checking out will register and return to the cart to continue the check out process.
· Administrator to control Shopping Cart preferences by division.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce



	Inventory Purchase Report 
	Grants access to Inventory Purchase report, which displays transaction details on learning objects purchased for future assignment via the Inventory purchase feature. 
	Reports - Billing



	Shopping Cart Preferences - Manage
	Grants ability to configure shopping cart preferences, which allows the administrator configure aspects of the shopping cart page to be viewed by users making shopping cart purchases. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


Who should use Shopping Cart Functionality?
Shopping Cart functionality is best used for extended enterprise. Extended enterprise sells training to users and guest users. That training is configured to be paid for by the user, and the training requires no approval. See E-Commerce Overview on page 2 for additional information.
Who should use Inventory Functionality?
Inventory functionality works with shopping cart functionality. It gives the user the ability to pre-purchase training to be assigned to a specific user at a later date. 
Criteria for using Shopping Carts and Inventory:
· Catalog Pricing - The training must have a cost greater than $0.00.
· Training Approvals - The training item does not require approval.
· User Payment Preferences - The user pays more than $0.00 by credit card.
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[bookmark: _Toc161997441]E-Commerce Preferences
Modify Payment Account
The Modify Payment Account page enables administrators to create payment profiles to determine the routing of users' payments. Payment routing methods can be created by associating various attributes to an account. Based on the configuration, funds are directed to the designated merchant account or acquired from the pre-determined cost center. If the criterion exists for more than one payment profile, the profile that appears higher in the list is used. 
Modify Payment Account preferences are controlled by a backend setting that is turned off by default. To enable the Modify Payment Account page, contact Global Customer Support.
To access Modify Payment Account preferences, go to Admin > Tools > Learning > E-Commerce > Modify Payment Account.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Payment Account - Modify
	Grants ability to create payment profiles to determine the routing of users' payments. This permission cannot be constrained. This is an administrator permission.
	eCommerce - Administration


[image: ]
	Feature
	Description

	1
	Modify Payment Account Tokenization Custom Fields - To associate users' system information with their Cybersource credit card payment profile, click the Modify Payment Tokenization Custom Fields link. This opens the Modify Payment Tokenization Custom Fields pop-up. See Modify Payment Tokenization Custom Fields on page 126 for additional information.

	2
	Enable CVV Validation - This option determines whether or not users are required to enter their credit card's CVV code when purchasing training in their Shopping Cart. The option is checked by default. When checked, users are required to enter a CVV code. When unchecked, users are not required to enter a CVV code.
It is important to note that if the administrator unchecks the Enable CVV validation option, the administrator should ensure that they also configure the CyberSource Business Center settings to match the portal settings.
Note: This option is only applicable to organizations that do not use tokenization to store users' billing profiles, since CVV code validation is required if payment tokenization is used to store billing profiles. If at least one OU (parent or child) in the portal has the Allow users to store credit card information on My Account Billing Profile page option checked in User Payment preferences, then the Enable CVV validation option in Modify Payment Account preferences is checked by default and is not selectable. If payment tokenization is later disabled in such portals, then the Enable CVV validation option remains checked but is selectable.

	3
	Payment Account - Click the plus icon [image: ]
 to create a payment account. To add a payment account, click the Add Payment Account icon to the right of the Payment Account heading. See Create Payment Account on page 127 for additional information.

	4
	Modify Payment Account Table - The following information appears for each payment account:
· Name - This column displays the name of the payment account.
· Default Payment Account - The default payment account is denoted with the "(Default Account)" text. If a newly created account fails, the payment is processed using the default account. If the default account fails, the entire transaction fails.
· Active - Check or uncheck the Active option to activate or deactivate the account.

	5
	Options - The following options are available:
· Edit - Click the Edit icon to edit the payment account. This opens the Define Payment Account page.
· Delete - Click the Trash Can icon to delete the payment account.


Cybersource - Modify Payment Account
Three additional fields are added to the Modify Payment Accounts page when a Cybersource payment account is configured. These fields are only required if a client needs to enable 3D Secure 2.1 support:
· API Identifier
· Org Unit ID
· API Key
1. Obtain the values for API Identifier, Org Unit ID, and API Key. Values for the three new fields can be found in the CyberSource Business Center. For information about finding these values: 
2. After obtaining the API Identifier, Org Unit ID, and the API Key, input these values into the corresponding fields on the Modify Payment Account page.
3. Click the Save button at the bottom of the page to save and apply your changes.
Adyen Payment Gateway
The Adyen Payment Gateway payment processor is available for credit card payments. For more information about the Adyen Payment Gateway, See Adyen Payment Gateway (Early Adopter).
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[bookmark: _Ref-1989071934][bookmark: concept47]Modify Payment Tokenization Custom Fields
To associate users' system information with their Cybersource credit card payment profile, click the Modify Payment Tokenization Custom Fields link. This opens the Modify Payment Tokenization Custom Fields pop-up. 
[image: ]
The following options are available in the pop-up:
· Cybersource tokenization custom field 1 - This field is associated with the User Reference ID by default. Select this option to send the users' reference ID to Cybersource as custom field #1. 
· Cybersource tokenization custom field 2 - Select this option to send a user record custom field to Cybersource as custom field #2. You must also select the appropriate user record custom field from the drop-down list. All user record custom fields that are available to the administrator are displayed in the drop-down list.
· Cybersource tokenization custom field 3 - Select this option to send specific static text to Cybersource as custom field #3. You must also enter the text in the field to the right of the option.
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[bookmark: _Ref-1125787256]Create Payment Account
On the Define Payment Account page, administrators can configure the payment account. For portals with an integration with CCH, a tax calculator can be designated per payment account. See the CCH Integration section below.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Payment Account - Modify
	Grants ability to create payment profiles to determine the routing of users' payments. This permission cannot be constrained. This is an administrator permission.
	eCommerce - Administration


[image: ]
Enter the following information for the payment account:
· Name - Character limit is 50.
· Description - This is for administrator use only. It is not displayed anywhere. Character limit is 250.
· Define Criteria - At least one criteria is required and constraints do not apply to the available selections. The available attribute types are:
· Currency
· Provider
· OU
· LO
The remaining fields that the administrator must populate depend on the payment processor selected for the portal.
Cybersource
If using Cybersource for payment processing, populate the following fields:
· Transaction Key - This field is generated from the CyberSource portal. Clients should have their own CyberSource account. Character limit is 50.
· Tax Nexus - This is the state abbreviation for US sales tax use. Character limit is 200.
· 3D Secure - Select this option to enable Payer Authentication for credit card transactions made during the Shopping Cart checkout process. The box is unchecked by default. Note: This availability of this option is controlled by a backend setting. To enable this option, contact Global Customer Support.
· When this functionality is enabled, users are required to verify that they are the cardholder when purchasing training items. Some card issuers only require users to validate their credit card information once, as long as no information changes on the card. However, other card issuers require credit card validation for each purchase. In these cases, users are required to verify their credit card information every time they check out with a credit card.
· If a user has more than one training item in their shopping cart and the transaction has different payment accounts, one of which requires authentication, then Payer Authentication is required in order for the user to complete check out.
· If a user has more than one training item in their shopping cart and the transaction has different payment accounts, both of which require authentication, then Payer Authentication is required and may also require separate authentication for both transactions in order for the user to complete check out.
· Merchant Descriptor - This is the company name that is displayed on purchasers' credit card receipt. The character limit for this field is 22. 
· This field is associated with the invoiceHeader_merchantDescriptor in CyberSource.
· Merchant Descriptor Contact - This is the company telephone number that is displayed on purchasers' credit card receipt. The character limit for this field is 13. 
· This field is associated with the invoiceHeader_merchantDescriptorContact in CyberSource.
· This field must be in one of the following formats:
· PCCCCCCCCCCCC
· NNN-NNN-NNNN
· NNN-NNN-NAAA
· NNN-NNN-AAAA
· NNN-AAAAAAA
· A: Alphanumeric (Alpha or Numeric)
· C: Character (Alpha or blank)
· N: Numeric
· P: Alpha
· Merchant Descriptor (Others) - This can be the company address, website, or other information. The character limit for this field is 32.
· This field is associated with the invoiceHeader_merchantDescriptorAlternate in CyberSource.
· VAT Number - This is for UK/Australia sales tax use. Character limit is 150. Mulitple VAT numbers can be entered in a comma delimited string. To enter multiple VAT numbers into the field, add a comma between each VAT number. The character limit of 150 allows for one space to be added between the comma and the VAT number.
Use Case for Multiple VAT Numbers
An organization sells training to customers in the Netherlands, Brazil, Canada, and the United Kingdom. The organization charges its users in their local currency and charges local tax accordingly. When a customer from the Netherlands places training in her cart and enters her billing information in Dutch, the shopping cart displays the appropriate tax that she needs to be charged. When she completes her purchase and checks out, she is charged the appropriate amount of tax.
Workflow for Multiple VAT Numbers
1. An administrator sets up a merchant account with CyberSource.
2. The administrator registers to be a merchant in the United Kingdom (UK) and receives a Value Added Tax (VAT) number. The organization also has existing VAT numbers for two other countries.
3. The administrator logs in to Cornerstone and navigates to Modify Payment Account.
4. The administrator creates a new payment account and adds criteria for the payment account that specifies that when a user's location is in the United Kingdom, the payment account at hand should be used.
5. A user with Location OU (organizational unit) = UK makes a purchase and checks out.
6. The UK payment account is used by the system to calculate the tax.
· Bank Name - Character limit is 50.
· Merchant ID - Account information provided by the merchant bank. 
CCH Integration
In this section, portals with a CCH integration enabled can designate a tax calculator per payment account. Administrators have the option to select either Cybersource or CCH as the tax calculator for a payment profile. Each merchant account can have more than one tax calculator. For example, a portal has one Cybersource gateway and merchant account. Using the same merchant account, the administrator can configure two payment accounts, each with a different tax calculator.
CCH
Select the CCH option to use CCH as the tax calculator for the payment account. When this option is selected, the Tax Nexus and VAT Number fields are hidden.
Selecting this option enables a tax calculator drop-down to appear below the option. The drop-down displays a list of the tax calculators that are configured in Tax Preferences. Select a tax calculator from the list. The tax calculator selected is used as the tax calculator for the payment account.
Tax Calculation
The Tax Calculation section enables administrators to configure the tax calculator for each payment account.
Note: The Tax Calculation feature is only applicable for portals with the sales tax functionality enabled. In addition, the CCH option is only enabled once a CCH account is added as a tax calculator on the Tax Preferences page.
Cybersource Tax Calculator Integration
In the Cybersource Tax Calculator Integration section, administrators enable the setting which allows the PayPal Payment Gateway integration to use an existing Cybersource account to dynamically calculate taxes for PayPal transactions.
To enable this setting, toggle the Cybersource Tax Calculator Integration toggle to the On position. If you do not wish to enable the Cybersource Tax Calculator, leave this switch toggled to the Off position. Note: You must create a Cybersource account prior to enabling this option in order to allow the PayPal Payment Gateway integration to dynamically calculate taxes.
If the Cybersource Tax Calculator Integration has been enabled, the administrator can configure the following fields which appear on the page:
· Transaction Key - The Transaction Key is generated from the Cybersource portal and is a required field.
· Merchant Descriptor 
· Merchant Descriptor Contact 
· Merchant Descriptor (Others) 
· Tax Nexus 
· VAT Number 
· Merchant ID 
[image: ]
Adyen Payment Gateway Integration
In the Payment Gateway Information section, if the Adyen Payment Gateway has been enabled, populate the following fields with the API credentials obtained from Adyen:
· Merchant Account ID - This is obtained from your Adyen account and displays on the API Credentials page in Adyen.
· X-API-KEY - This is the API key generated through Adyen. This must be copied at the time it is generated, as it will be obfuscated in the Adyen account after creation.
· Username - This is the username generated from within your Adyen account. Note: This is NOT the username used to log into your Adyen account; it is a username associated with the API key when it is generated. This data will display on the details page for the merchant account.
· Password - This is the password generated from within your Adyen account. Note: This is not the password used to log into your Adyen account; it is a password associated with the API key it is generated. This password must be copied at the time it is generated, as it will be obfuscated in the Adyen account after creation.
· 3D Secure - This setting, if enabled, must also be configured in your Adyen account in order to function. Without first configuring this option in Adyen, errors will occur when attempting to perform transactions in the Cornerstone portal. This option should only be selected AFTER it has first been configured via Adyen. 
Click the Save button to finish configuring the Adyen payment account. This account will then be available for users who meet the specified user criteria defined for the account. Note: More than one account can be defined for the portal. 
For more information about generating API credentials, please see Adyen's documentation: Adyen Help Documentation. 
For more information about the Adyen Payment Gateway, See Adyen Payment Gateway (Early Adopter).
PayPal Payment Gateway Integration
In the PayPal Information section, if the PayPal Payment Gateway integration has been enabled via Edge, the administrator can populate the following fields:
· Merchant Account ID - Provide the email address or merchant account ID associated with your organization's PayPal business account. This field is required.
· Client ID - Provide the Client ID associated with your organization's PayPal business account. This field is required.
· Client Secret - Provide the Client Secret associated with your organization's PayPal business account. This field is required.
Click the Save button to finish configuring the PayPal payment account.
Access your PayPal information from the My Apps & Credentials tab of your PayPal Developer account. See Obtain Client ID and Client Secret from PayPal.
For more information about the PayPal Payment Gateway integration, See PayPal Payment Gateway (Early Adopter) Enhancements.
Save/Cancel
Click Save to save the payment account. Or, click Cancel to cancel creating the payment account.
Secure Enablement with Cybersource
1. Contact your CyberSource account manager, sales manager, or technical account manager to learn more about 3D Secure 2.x and PSD2.
2. Configure your test merchant ID with CyberSource.
1. Contact customer support to make the necessary configuration changes to enable 3D Secure 2.x for the desired card type and currencies.
2.  Log into the CyberSource Business Center to obtain the API keys for implementation. Access the keys by going to: Navigation > Payment Configuration > Payer Authentication Configuration in the Business Center. 
[image: ]
3. Implement 3D Secure 2.x by migrating to the Hybrid integration. For more information about completing this step: 
4. Test your 3D Secure 2.x services. This testing ensures that you understand the possible use cases as part of implementation. For more information about these test cases, see: Test Cases.
5. Configure your account for Production. Repeat Steps 2-4 for the production environment.
If 3D Secure 2.1 is enabled, when transactional details are sent from the checkout to Cybersource, an additional check will be made to validate if further payment authentication is necessary. If it is necessary, the customer will be redirected to authenticate with the payer. If authentication is successful, the customer will be returned to checkout. If authentication fails, the customer will not be able to complete the transaction with this payment method.
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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[bookmark: _Ref-1353222206]Training Unit Preferences by Division
The Training Unit Preferences page allows the training unit administrator to determine which training can be purchased using training units. They can also associate a training unit with a specific monetary value and set discounts for training units when purchased in bulk. Training unit preferences can be set by organizational unit (OU).
Note: In order for users to use training units to purchase training, training units must also be enabled on the User Payment Preferences page.
[bookmark: concept50]To manage Training Unit Preferences, go to Admin > Tools > Learning > E-Commerce > Training Unit Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Training Unit Preferences
	Grants ability to configure certain aspects or behaviors of training units at the organizational or division level. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration
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Training Unit Redemption Preferences
The following option is available in the Training Unit Redemption Preferences panel:
· Do not allow users to redeem training units for ILT session if session start date occurs after training unit expiration date - This option is unchecked by default. When checked, users cannot use training units to purchase a session if the training units expire before the session start date.
Note: This functionality is only available at the top level OU and applies to both "Training Unit (Key Code)" and "Training Unit (Distributed)" shopping cart payment methods.
Training Criteria
In the Training Criteria section, select the training that can be purchased with training units.
Apply training units to all training or to a customized selection. If the Customized option is selected, only the specified training accepts training units. Specify the training using the following options:
· Training Type - Specify which training types can be purchased with training units (e.g., online course, event, material).
· Provider - Specify providers that can be purchased with training units. If no providers are specified, all providers are eligible.
· Subject - Specify subjects that can be purchased with training units. If no subjects are specified, all subjects are eligible.
Training unit eligibility is determined using OR logic between the criteria types (i.e., training type, provider, subject). For example, the training criteria may be set to "online course, event" OR "My Provider" OR "Product Management."
Basic Pricing Options
The following options are available in the Basic Pricing Options section, depending on the portal's configuration:
	Field
	Description

	Do your Training Units have a monetary value?
	Specify whether or not your training units have a monetary value. If Yes is selected, specify the following:
	Field
	Description

	What is the equivalent monetary value of each Training Unit?
	In the monetary value field, specify how much money each training unit is worth. There can be no more than six digits to the left of the decimal point and no more than four digits to the right of the decimal point (i.e., 999999.9999).
If a monetary value is set, the administrator can allow users to purchase additional training units. The administrator can define bundling discounts. Also, the administrator can set up automatic conversions if pricing by currency is available.
If no monetary value is set, training units are used only as tokens with no actual value. Users can not purchase training units from the My Accounts page. Also, the administrator must define the price by training unit in the course catalog for each item individually.




	Use users' OU training unit monetary value
	Select this option to use the training unit monetary value for the OU of the user that is purchasing training in order to determine the training price in training units.


Basic Pricing Options - Training Unit My Account Preferences
	Field
	Description

	Allow users to track training unit history through My Account
	Select the Allow users to track training unit history through My Account option to allow users to track training unit history through My Account. This field also controls the visibility of the Orders filter on the Orders page in My Account.

	Allow users to purchase training units for their personal account
	Select this option to allow users to purchase training units. This option only appears if you have set a monetary value for training units.

	Allow users to purchase training units keycode
	This option is unchecked by default. When checked, the Buy Training Unit Keycode link appears on the My Account page, enabling users to purchase training unit key codes. The following additional options appear when the field is selected:
Training units keycode expires after
This option is unchecked by default. When unchecked, the key code never expires.
When checked, administrators can configure an expiration date for the key code. To configure an expiration date, check the Training units keycode expires after option. Select either Days, Month, or Year from the range drop-down to determine when the key code expires. Enter a number up to three digits in the numeric text box.
Allow purchased training units to be distributed to users from the following criteria
This option enables administrators to constrain the training units assigned to a key code by the OUs that are defined for the portal. The option displays all OUs that are defined for the portal, as well as an All Users option. The All Users option is selected by default. When the All Users option is selected, all users can use the training units purchased by the purchaser. To constrain the availability of the training units purchased by the purchaser, select an OU from the list. Only one option can be selected.
Note: If the administrator purchasing the training units does not apply to the constraint, then the constraint is not applied to the training units purchased for the key code. Instead, the All Users constraint applies by default. For example, if training unit distribution is constrained to Cost Center on the Training Unit Preferences page, and the administrator who is purchasing the training units does not have a cost center specified for them, then the system allows the training units purchased by this administrator to be used by all users.

	Allow users to track personal training units balance (Distributed/Self Purchase type)
	This option is checked by default and enables users to view their training unit balance on the My Account page. When unchecked, the training unit balance is not visible to users.
Best Practice: Unchecking this option is useful for organizations in which users only have a training unit key code and therefore do not have a personal training unit balance.

	Allow users to check training units keycode balance
	This option is unchecked by default. When checked, users can view their key code balance on the My Account page.

	Allow users to purchase distributable training units
	Select this option to allow users to purchase distributable training units. 
When this option is selected, you must then select the OUs, groups, or users that are able to purchase distributable training units. From the drop-down list, select the OUs that are able to purchase distributable training units. A selection is not required; however, if no selection is made, then no users are able to purchase distributable training units. The selected users are automatically assigned the Training Unit Distributor role and they have access to the Manage Training Unit Distribution page.
After selecting the users that are able to purchase distributable training units, you must select the users to which the distributor is able to distribute the training units. Only one option can be selected. The following options are available: Users' Position (This is selected by default), Users' Division, Users' Cost Center, Users' Cost Center, Users' Location, Users' Self Registration Group, and Users' Custom OU (All custom OUs that are available in the portal are available for selection).


Basic Pricing Options - Training Unit Keycode Emails
	Field
	Description

	Send low balance reminder email
	Select this option to send the Training Unit Low Balance Reminder (Key Code) email when a key code balance falls below a certain level, if the email is enabled. When this option is selected, specify the key code training unit balance that triggers the email. For example, if "100" is entered, then the email is triggered when the key code training unit balance falls below 100.

	Send monthly balance to training unit contact
	Select this option to enable the Monthly Training Unit Balance email to be sent to confirm the current training unit balance. When this option is selected, the Monthly Training Unit Balance email is sent to the training unit contacts that are within the OU for which the preference is set in Training Unit Preferences. The email is sent on the last day of the month, if the email is configured in Email Management.
Note: If there are no transactions in a given month for the training unit key code and the balance is 0, then the Monthly Training Unit Balance email does not trigger. If the balance is 0 but there is at least one transaction in the given month, then the email is triggered.


Bundled Pricing Options
In the Bundled Pricing Options section, set discounts on training units when a certain number of training units are purchased. For example, if over 10 units are purchased, they may receive a 10% discount, and if over 20 units are purchased, they may receive a 20% discount. Discounts must be an integer value and cannot exceed 99%. You can have up to 100 bundled pricing options, and the maximum number of training units for which you can specify a bundled pricing option is 999999. This option is only available if you have set a monetary value for training units.
A modification history is maintained for all modifications. Bundling history is saved for all modifications, but if the bundling options for a parent OU are modified, the bundling history for the child OU is overwritten.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Save/Cancel
Click Save to save the settings. Click Cancel to cancel the changes to the settings.
[bookmark: _Toc161997442]Shopping Cart and Billing Preferences Overview
[bookmark: concept52]Billing Information Preferences
The Billing Information Preferences page enables administrators to configure the settings for the secondary address that is available for all payment types.
To access Billing Information Preferences, go to Admin > Tools > Learning > E-Commerce. Then, click the Billing Information link in the Shopping Cart and Billing Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Billing Information Preferences
	Grants ability to manage which payment options are available to users. Administrators can determine which payment options are available and how the options appear during the configuration process and purchasing process. This permission cannot be constrained. This is an administrator permission.
	eCommerce - Administration
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Secondary Address Name
In this field, enter the display name for the Secondary Address, up to 100 characters. If nothing is entered in this field, "Secondary Address" is displayed.  If multiple languages are enabled for your portal, select the Translate icon to translate the field into other available languages.  When a user's defined language has a localized value for the secondary address field, the field is displayed in the user's defined language. If a translation is not available for that user, then the field is displayed in the language of the administrator who first modified the field.
This affects the following areas:
· Checkout - Payment
· My Account - Billing Profile
· User Payment Preferences
Secondary Address Fields
By default, the secondary address contains the following fields:
· First Name
· Last Name
· Email
· Address 1
· Address 2
· City
· State
· Country
· Zip Code
In addition to the default fields, the secondary address can also include a Company Name and Phone Number field.
Active
Select the Active checkbox for the appropriate field to make the field active and appear in the secondary address.
Required
Select the Required checkbox for the appropriate field to make the field required. Note: If the secondary address is set as optional for a payment type in User Payment Preferences, then all secondary address fields are optional when the corresponding payment type is used, regardless of whether the Required option is selected.
Save or Cancel
Clicking Save commits the changes. Clicking Cancel returns the user to the Preferences page and does not save changes made to the page.
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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Transaction Currency Conversion Rates
The Conversion Rates Table allows the administrator to set currency conversion rates for all currencies they support. The combination of each column places settings that will be applied to the system where pricing and transactions are involved. A Cornerstone default rate (CORNERSTONE RATE column), which is hard coded in Dollar (USD) $ amounts will be applied throughout the system unless changed by the administrator at this screen.
To access Conversion Rates Preferences, go to Admin > Tools > Learning > E-Commerce. Then, click the Conversion Rates link in the Shopping Cart and Billing Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Currency Conversion Rate Preferences
	Grant Access to Conversion Rate Preferences, which enables setting currency conversion rates for all currencies supported in the portal. The combination of each column places settings that will be applied to the system where pricing and transactions are involved. This is an administrator permission.
	Learning - Administration
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Conversion Rates
The following columns are available in the Conversion Rates table:
· Currency - This column lists the name of the currency and the three-letter abbreviation for world currencies.
· Symbol- This column displays the currency symbol.
· Fix - This column allows the administrator to enter a rate that will applied throughout the system for this selected currency. If not selected, the rate defaults to the rate under Cornerstone Rate column. To edit a currency rate:
1. Click Edit icon to apply a different currency rate.
2. Enter the rate amount.
3. Click the Save icon.
· Client Rate 1 USD = - This column displays the currency rate in relation to 1 USD. Note: Any currency rate changes that were saved will be displayed by clicking on the corresponding History icon. 
· Cornerstone Rate - This column displays a hard-coded default currency rate that will apply throughout the system.
· Last Updated - This rate displays the date and time a currency rate was last updated.
· History - The administrator can click the History icon to view the history of changes.
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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Currency by Division
Currency Preferences can be set on this page for all Transactions within the system by Division and will display for users upon searching for training. Once search results are displayed, the user can click on the training link to view detailed pricing and currency information. The currency set for all Transactions as well as the Additional currency will also be displayed.
To access Currency Preferences, go to Admin > Tools > Learning > E-Commerce. Then, click the Currency Preferences link in the Shopping Cart and Billing Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Currency Preferences - Manage
	Grants access to Currency Preferences screen and Currency Conversion Rates screen for purposes of billing for learning objects. This permission works in conjunction with the User Payment Preferences permission. This is an administrator permission.
	Learning - Administration
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Transactions
The following options are available in the Transactions section:
· Transaction Currency Conversion Rates Table - The Transaction Currency Conversion Rates table enables you to reference currency conversion rates while configuring currency preference setting.
· Transactions - Select a currency from drop-down list to display when a user searches for training.
· Additional - Select a currency to display when a user searches for training in addition to the transaction currency.
· [bookmark: concept54]Currency Override - Select this option to enable the user's OU currency to be overridden when purchasing a learning object (LO) in their shopping cart. When selected, this option enables the Override user's OU currency option to appear on the Pricing step when editing an LO in Course Catalog. The Currency Override option is unchecked by default.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Invoice Preferences
Administrators can configure a global invoice for their entire organization, including the business phone number and invoice logo.
To access Invoice Preferences, go to Admin > Tools > Learning > E-Commerce. Then, click the Invoice Preferences link in the Shopping Cart and Billing Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Invoice Preferences - Admin
	Grants access to Invoice Preferences. This page enables administrators to customize the invoices that users receive. Administrators can create invoices for users in order to meet certain requirements, such as the requirements of a different country. This permission cannot be constrained. This is an administrator permission.
	eCommerce - Administration
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Invoice Preferences
The following options are available:
· [bookmark: concept55]Active - Check this option to make the invoice active. When a custom invoice is active for a division, then the custom invoice can be used for certain learning objects (LO). A custom invoice must be manually applied when setting the pricing or sales tax for a LO. When a custom invoice is not used, the default invoice is used.
· Australian Business Number - In this field, enter the Australian business number. This business number appears on the Order History page and the printed invoice. This field is disabled if the Active option is not checked. The character limit for this field is 100.
· Upload Logo - A logo can be added to the custom invoice. To upload a logo for the custom invoice, click the Choose File button. Then, select the file from your computer and click the Upload button. The selected image appears in the Logo field. This field is disabled if the Active option is not checked. The system supports .jpg, .jpeg, .gif, .png, and .bmp file types.
· Logo - If a logo is uploaded for the custom invoice, then it is displayed here. If no image is displayed, then this is because no image has been uploaded via the Upload Logo field. Once a logo has been uploaded, it can be removed by clicking the Remove button in the lower-left corner of the logo.
Submit or Cancel
Click Submit to submit any changes to the invoice preferences. Otherwise, click Cancel to discard any unsaved changes.
Extended Enterprise: 
Extended Enterprise: Extended Enterprise Overview
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User Payment Preferences by Division
User Payment by Division determines the method and percentage that users are to pay for content. Through this feature, charges are applied to a credit card, receive a bill or can be deducted from a user's paycheck. Note: paycheck deductions are done internally within your organization from a report you can run in the Cornerstone system. An administrator can select options including a percentage a user must pay by non-credit card, percentage to be paid by credit card or charge user's credit card excluding delivery fees. The act of requesting a bill means that the transaction charge is sent to the User's Cost Center; appearing in a column for User Pays. The Cost Center is treated as a billing department by the client. An Admin can run a report to see who has purchased training, and determine whether a paper bill should be created and sent to the end user.
Note: If your organization is considering using this feature please contact your Client Success Manager as additional considerations and processes will apply.
To manage User Payment preferences, go to Admin > Tools Learning > E-Commerce > Payment Methods.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Assignment Tool - Bypass User Payment
	Grants ability to bypass user payment when creating a Learning Assignment. When user payment is bypassed, users are automatically registered into the training regardless of whether or not payment is required. This permission is dependent on the Assignment Tool - Standard, Assignment Tool - Standard and Dynamic, and Assignment Tool - Standard and Dynamic - Recurrence permissions. This permission cannot be constrained. This is an administrator permission.
	Learning - Administration



	User Payment Preferences - Manage
	Grants ability to manage user payment preferences, which includes determining the payment methods allowed and percentage of overall price that users must pay when purchasing learning content. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


Cost Allocation
Users' Cost Center - Enter a number from 0-100. The number indicates the percent the company or cost center will be paying for the user. The number entered here represents the amount that the user will not pay because the company is covering this percent of the cost. The combination of percent entered for User's Cost Center and User Pays must equal 100%. 
User Pays - Enter a number from 0-100. This number represents the portion the user is responsible for paying. The combination of percent entered for User's Cost Center and User Pays must equal 100.
[image: ]
Payment Preferences
Proxy Enrollment
Select this preference to check the "Bypass User Preference" by default - This option enables the administrator to define the default value of the Bypass User Payment option, which is used when enrolling users into training via the Learning Assignment Tool. If this preference is selected for an OU and an administrator from that OU creates a learning assignment, then that administrator will have the Bypass User Payment option selected by default. If this preference is not selected, then the Bypass User Payment option is deselected by default. Note: The administrator must also have permission to bypass user payment within a proxy enrollment to see this option.
[image: ]
Payment Options
Coupon
If this option is selected, during checkout, users are able to use coupons towards their purchase. If this option is selected, coupons can be applied to an order, but only one coupon can be applied to each item in a shopping cart. During checkout, a Coupon input box appears on the Checkout page for users to enter a coupon code.
· To limit the number of coupons that can be used in a transaction, select the second option and enter the maximum number of coupons.
[image: ]
Credit Card
If this option is selected, during checkout, credit card functionality appears in the Payment Method drop-down list. If this option is not selected, users cannot pay their remaining balance by credit card if they do not have sufficient training units.
· Select Valid Credit Card Types - Select which of the following credit card types can be used within the system: VISA, MasterCard, Discover, and American Express. Note: A user cannot use an unsupported credit card to complete a transaction. However, if a user has an unsupported credit card type saved in their billing profile, that transaction can be completed as if the card is supported.
· Exclude Credit Card Fees - check to exclude credit card fees.
· Allow users to store credit card information - Select this option to allow users to store credit card information on My Account. This option is required for recurring billing. If this option is selected:
· A Billing Profile section appears in My Account, where users can store credit card information to be used with recurring billing, subscription renewals, and to make the purchase process more efficient. Once a billing profile is established, when using the shopping cart to check out, the user has the option to use the stored credit card information for the purchase. Note: If a user intends to utilize the curriculum subscription functionality with auto-renewal, the user must establish a billing profile.
· During checkout, users have the option to store their credit card information to their billing profile.
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· [bookmark: concept56]Use Secondary Address in Tax Calculation - This field is enabled when the Collect secondary address field is selected and defined as required. This field only displays if at least one learning object (LO) is selected on the Tax Preferences page to indicate tax collection by LO.
The Use Secondary Address in Tax Calculation option is unchecked by default. This field displays for the following payment types that support collecting secondary address at time of transaction:
· Credit Card
· E-check
· Request Bill
· Wire Transfer
When the Use Secondary Address in Tax Calculation option is selected, the secondary address is used in tax calculation. When unselected, the secondary address is not used in tax calculation.
Workflow - Use Secondary Address
[image: ]
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
[image: ]
Request Bill
If this option is selected, during checkout, the Request Bill functionally appears in the Payment Method drop-down list. Selecting this option and placing the order allows the user to receive the training on their transcript as though the user has already purchased it. The charge is sent to the cost center called User Pays. You can run a report (View by Cost Center, viewing the cost center User Pays section) to determine for whom a bill should be created and to whom the bill should be sent. 
Only having the Request Bill option active disables the Shopping Cart. The purpose of the Shopping Cart is to allow the user to purchase more than one item in one credit card transaction and is not relevant to a Request Bill only workflow. A Request Bill workflow always shows a line item in the cost center User Pays report view, therefore there is no value in showing the shopping cart page when a user can only request a bill. 
When you run a report (Billing: Enterprise or Enterprise Custom reports) to determine who should be sent a bill, you can view charges by user, and send a bill showing a list summarizing the charges for which the user is responsible for sending payment. If the user can only be sent a bill, then the user will not see the Add to Cart button, only the Request button on the LO details page, and the user will never be prompted in the system to pay for the training.
· Request Bill - Select the name of the Request Bill option that you want to display to the end user from the drop-down list. Available options are Send Bill, Invoice, and Purchase Order. If Send Bill is the display, then the user will see two options, Credit Card and Send Bill.
· Minimum Purchase - If this option is selected, a minimum purchase is required before the Request Bill option appears.
· Show Reference number input box - If selected, the Please enter purchase order reference number: field displays on the Payment step when a user selects to pay by Purchase Order during the checkout process. This allows a user to enter a purchase order number at checkout. The field is unchecked by default. Note: To display Purchase Order as a payment option during checkout, you must select Request Bill, and then choose Purchase Order in the Request Bill: Select Request Bill display name when Request Bill is an active payment option field.
· Users are required to enter a reference number in the box - If selected, the user is required to enter a purchase order number in the Please enter purchase order reference number: field on the Payment step during the checkout process, provided the user selected Purchase Order in the Payment Method field. The field is grayed out by default and only selectable if the Show Reference number input box field is checked.
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Payment Pending - Select this option to enable the Payment Pending status. See Pending Payment Status Overview on page 160 for additional information. If a user is subject to the Payment Pending option and elects to purchase a learning object with the Request Bill option, the transaction is placed in Payment Pending status. If a learning object is in Payment Pending status, the user cannot access this item until the payment is reconciled. If this option is selected, you must then select which users are placed in the Payment Pending status.
· All - Select this option to place all of the users in the selected OU in Payment Pending status until their order is reconciled. This applies to all users in the OU for which you are setting the User Payment Preferences.
· Selected - Select this option to then select specific users that are placed in Payment Pending status until their order is reconciled. If this option is selected, the Add Users option appears. Click this link to select the users that are in Payment Pending status.
· Note: If a user is already assigned to a session, then that roster seat remains reserved for the user.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
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E-Check
If this option is selected, during checkout, the E-Check option is available in the Payment Method drop-down list, enabling users to pay with an E-Check. The following options are also available for the E-Check payment type:
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Payment Pending - Select this option to enable the Payment Pending status. See Pending Payment Status Overview on page 160 for additional information. If a user is subject to the Payment Pending option and elects to purchase a learning object with the Request Bill option, the transaction is placed in Payment Pending status. If a learning object is in Payment Pending status, the user cannot access this item until the payment is reconciled. If this option is selected, you must then select which users are placed in the Payment Pending status.
· All - Select this option to place all of the users in the selected OU in Payment Pending status until their order is reconciled. This applies to all users in the OU for which you are setting the User Payment Preferences.
· Selected - Select this option to then select specific users that are placed in Payment Pending status until their order is reconciled. If this option is selected, the Add Users option appears. Click this link to select the users that are in Payment Pending status.
· Note: If a user is already assigned to a session, then that roster seat remains reserved for the user.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
Wire Transfer
If this option is selected, during checkout, the Wire Transfer option is available in the Payment Method drop-down list, enabling users to pay with a wire transfer. The following options are also available for the Wire Transfer payment type:
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Payment Pending - Select this option to enable the Payment Pending status. See Pending Payment Status Overview on page 160 for additional information. If a user is subject to the Payment Pending option and elects to purchase a learning object with the Request Bill option, the transaction is placed in Payment Pending status. If a learning object is in Payment Pending status, the user cannot access this item until the payment is reconciled. If this option is selected, you must then select which users are placed in the Payment Pending status.
· All - Select this option to place all of the users in the selected OU in Payment Pending status until their order is reconciled. This applies to all users in the OU for which you are setting the User Payment Preferences.
· Selected - Select this option to then select specific users that are placed in Payment Pending status until their order is reconciled. If this option is selected, the Add Users option appears. Click this link to select the users that are in Payment Pending status.
· Note: If a user is already assigned to a session, then that roster seat remains reserved for the user.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
Training Units (Key Code)
If this option is selected, users are able to pay with a training unit key code during checkout.
· Allow users to pay the remainder of their balance with a credit card if they do not have sufficient key code training units at checkout - If this option is not selected or if the Credit Card payment option is not selected, users cannot use a credit card to complete the transaction if they do not have enough key code training units.
· Allow users to pay the remainder of their balance with using Request Bill if they do not have sufficient key code training units at checkout - If this option is not selected or if the Request Bill payment option is not selected, users cannot proceed with a transaction if they do not have enough key code training units.
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
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Training Units (Distributed)
If this option is selected, users are able to pay with distributed training units during checkout.
· Allow users to pay the remainder of their balance with a credit card if they do not have sufficient distributed training units at checkout - If this option is not selected or if the Credit Card payment option is not selected, users cannot use a credit card to complete the transaction if they do not have enough distributed training units.
· Allow users to pay the remainder of their balance with using Request Bill if they do not have sufficient distributed training units at checkout - If this option is not selected or if the Request Bill payment option is not selected, users cannot proceed with a transaction if they do not have enough distributed training units.
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
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Custom Payment Types
When a custom payment type is created via work order, it appears in the Payment Preference section and can be enabled or disabled by OU. The Pending Payment payment status can be enabled for each custom payment type via a backend setting. When the Pending Payment payment status is enabled for a custom payment type, then the Payment Pending option appears when the custom payment type is enabled.
· Collect secondary address at time of transaction - Select this option to allow users to enter a secondary address for the payment during the checkout process. When this option is selected, a Required/Optional toggle [image: ] is enabled, which allows the administrator to determine whether the secondary address fields are required or optional. If the secondary address is optional, then all fields within the secondary address are optional, regardless of the Billing Information Preferences. Note: The Secondary Address label can be customized in Billing Information Preferences.
· Payment Pending - Select this option to enable the Payment Pending status. See Pending Payment Status Overview on page 160 for additional information. If a user is subject to the Payment Pending option and elects to purchase a learning object with the Request Bill option, the transaction is placed in Payment Pending status. If a learning object is in Payment Pending status, the user cannot access this item until the payment is reconciled. If this option is selected, you must then select which users are placed in the Payment Pending status.
· All - Select this option to place all of the users in the selected OU in Payment Pending status until their order is reconciled. This applies to all users in the OU for which you are setting the User Payment Preferences.
· Selected - Select this option to then select specific users that are placed in Payment Pending status until their order is reconciled. If this option is selected, the Add Users option appears. Click this link to select the users that are in Payment Pending status.
· Note: If a user is already assigned to a session, then that roster seat remains reserved for the user.
· Show comments input box - Select this option to allow users to enter a comment for the payment during the checkout process. 
Receipt Message
Enter a text only message that displays on the receipt page for either a Credit Card transaction or a Request Bill transaction. If Request Bill is the only active option the user does not see the receipt message because the user will not see the checkout page or receipt.
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Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Submit or Cancel
Click Submit to finalize your changes. Otherwise, click Cancel to discard any unsaved changes.
Workflow Cases
In the following scenarios, training units are assigned and activated.
Scenario 1:
· Credit Card, Send Bill, Training Units are enabled.
· Course has a training unit price and a monetary price.
The user can checkout using Credit Card, Send Bill, or Training Unit.
Scenario 2:
· Training Units is enabled.
· Course only has a training unit price.
The user can checkout using Training Unit.
Scenario 3:
· Credit Card, Send Bill are enabled.
· Course only has a monetary price.
The user can checkout using Credit Card or Send Bill.
Scenario 4:
· Credit Card, Send Bill are enabled.
· Course has no price set.
The user must request the course.
Scenario 5:
· Credit Card, Send Bill are enabled.
· Course has a training unit price and a monetary price.
The user can checkout using Credit Card and Send Bill.
Scenario 6:
· Send Bill is enabled.
· Course has a training unit price and a monetary price.
The user can checkout using Send Bill.
Scenario 7:
· Training Units is enabled.
· Course only has a monetary value.
The user cannot checkout.
Scenario 8:
· Credit Card, Send Bill are enabled.
· Course only has a training unit value.
The user cannot checkout.
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[bookmark: _Ref-311785782]Pending Payment Status Overview
The Pending Payment functionality enables a payment status of Pending Payment for a transaction if the Send Bill (Purchase Order) option is selected during checkout. If a learning object is in Payment Pending status, the user cannot access this item until the payment is reconciled. 
The administrator can set an entire division in the Pending Payment status or they can specify users.
This option is only available with the Send Bill functionality. If this functionality is not being used, the Pending Payment status is not available.
Workflow
If a user is subject to the Pending Payment status and they checkout using the Send Bill functionality:
· They are placed in Pending Payment status and they cannot access the course material until the payment is received. The user cannot purchase training units and cannot use the Send Bill option for any purchase.
· When the payment is received, the administrator must adjust the payment status from Pending Payment to Complete. Once this occurs the user can access the material.
· If an ILT session is purchased, a seat is reserved until the administrator chooses to cancel the order.
· If No Show Fees are enabled, the user is subject to these fees if a payment is not received and reconciled prior to the session or if the user does not attend the session. Note: No show fees are implemented once the roster is submitted.
Statuses
The following table lists all payment statuses related to the Pending Payment status:
	Situation
	Training Status
	Options

	During Pending Payment
	Pending Payment
	None

	Admin Marks Payment Complete (for all LOs except ILT)
	Registered
	Manage/Launch

	Admin Marks Payment Complete (ILT Session)
	Registered - If after the session start date, the user remains in Registered status until the administrator uploads the roster. If a No Show Fee is applied to the user, the user is marked as a No Show.
	If session has not yet started: View
If session has started: None

	Admin Marks Payment Denied
	Payment Denied - If payment is denied, a withdraw penalty may be applied.
	Re-Purchase 


Emails
The following email triggers are available via Email Management in the Billing category:
	Email
	Description

	Pending Payment Notification
	This email is triggered when a user checks out using the Send Bill functionality and is subject to the Pending Payment status. This alerts them that they are in Pending Payment status. This email can be sent to a specific user, position, or the Purchaser.

	Order Status Adjusted
	This email is triggered when a user's order status is changed. This email can be sent to a specific user, position, Purchaser, or Order Status Adjuster.


Extended Enterprise: 
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Shopping Cart Preferences
The Shopping Cart preference page allows the administrator to provide instructions and activate HTML friendly boxes. Administrators can also select custom Transaction fields to appear on the Payment step for the checkout process. The preferences defined on this page affect the Shopping Cart, Payment, and Receipt pages. 
To set the shopping cart preferences, go to Admin > Tools > Learning > E-Commerce > Shopping Cart.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Shopping Cart Preferences - Manage
	Grants ability to configure shopping cart preferences, which allows the administrator configure aspects of the shopping cart page to be viewed by users making shopping cart purchases. This permission can be constrained by OU and User's OU. This is an administrator permission.
	eCommerce - Administration


[image: ]
Localization
From the language drop-down in the upper-right corner, select the appropriate language, if applicable.
Activate Shopping Cart
Activate Shopping Cart Functionality - Select this option to activate the shopping cart functionality for the division. By default it is unchecked. When checked it gives users in the division the ability to purchase more than one LO at a time using the shopping cart.
Define Instructions
Enter instructions that will display to users on the Shopping Cart and Checkout screens. The maximum number of characters for each field is 3000.
Preferences
The maximum number of characters for these fields is 3000. Click the Edit icon to format the message.
· Formatted Message Box Above - Select this option to include an HTML message that displays above the shopping cart.
· Formatted Message Box Below- Select this option to include an HTML message that displays below the shopping cart.
· Payment Page Message Box - Select this option to include an HTML message that displays on the Payment Page.
· Billing Text Box - Select this option to include HTML information or instructions related to billing that display in the billing area. Note: This text box is not used when the new Shopping Cart interface is enabled.
· Payment Text Box - Select this option to include HTML information or instructions that display above the Payment Method drop-down list.
· Review Page Message Box - Select this option to include an HTML message that displays on the Order Review Page.
· Thank You Page Message Box - Select this option to include an HTML message that displays on the Thank You Page. When the new Shopping Cart interface is enabled, this message box also appears on the Checkout - Confirmation page. Click the List of Available Tags link to view the tags that can be used when customizing the Thank You Page Message Box.
· Use Case: [footnoteRef:2] [2: An administrator configures the Thank You Page Message Box option by adding tags to display the items purchased, purchaser, total transaction cost, and the last four digits of the credit card used so that customers can print the Confirmation/Thank You page as a receipt.] 

· Use Case: [footnoteRef:3] [3: An administrator adds the TAG.USER.TRANSCRIPT tag to the Thank You Page Message Box option in Shopping Cart Preferences. This provides customers with a link directly to the transcript so that customers can access their transcript from the Confirmation/Thank You page, where they can find and launch their training items.] 

· Hide Shopping Cart Widget When Cart is Empty - Select this option to hide the Shopping Cart link when the cart in empty.
· Show the User's Cost % - Select this option to display the user's cost percentage on the Receipt page if the user's cost percentage is less than 100% (i.e., if the organization is paying a portion of the cost) 
· Display system generated recommendation - The box is unchecked by default. Checking the box enables a system-generated list of recommended training to display at checkout in the shopping cart or on the LO Details pop-up. The list is generated by using the portal's purchase history. In the Show items to be recommended field, use the drop-down to select the number of recommended trainings that will appear on the list, from 1-5.
· Display admin defined recommended training - The box is unchecked by default. Checking the box enables a Recommendations tab to display when editing an LO in Course Catalog, under which administrators can create a customized list of recommended training. In the Show items to be recommended field, use the drop-down to select the number of recommended trainings that will appear on the list, from 1-5.
Custom Fields
The Custom Fields section allows administrators to add up to four custom Transaction fields that will appear on the Payment page of the shopping cart checkout process. In addition, the email tags for custom Transaction fields can be added to the Thank You Page Message Box.
Add Custom Field
This option allows administrators to select from existing custom Transaction fields to add to the Shopping Cart Preferences page. The fields that are added can then be configured to display on the Payment page of the shopping cart checkout process.
To add a field:
1. Click the Add Custom Field link. This opens the Select Custom Fields pop-up. The pop-up displays all active custom Transaction fields that have been created, regardless of the availability settings defined for the fields. The field title and type also display.
2. Check the box in the Select column next to each field you would like to add. Up to four fields can be added.
3. Reorder the fields in the pop-up to define the order in which the fields display on the Payment page of the shopping cart. The fields will also display in this order in the custom fields table on the Shopping Cart Preferences page.
4. Click Save. This adds the fields to the custom fields table.
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Manage Custom Fields
Click Manage Custom Fields to open the Transaction tab of the Custom Field Administration page. From there, administrators can add or edit custom Transaction fields.
Custom Fields Table
The custom fields table displays all custom Transaction fields that have been added from the Select Custom Fields pop-up. The following columns display in the table:
· Field - This column displays the name of the field.
· Display on Shopping Cart - Check the box in the column to display the field on the Payment page.
· Response Required - Check the box in the column to require users to complete the field.
· Delete - Click the Delete icon [image: ] to delete the field from the Shopping Cart Preferences page. When deleted, the field no longer displays on the 
Email Tags for Thank You Page Message Box
Email tags for custom Transaction fields can be added to the Thank You Page Message Box. Click the List of Available Tags link in the Thank You Page Message Box field to view the tags. To add the tags to the message box, click the Edit icon to open the text box and add the tags. There is no limit to the number of custom Transaction field email tags that can be added to the message box.
HTML Safe List
The system only accepts certain customizable HTML elements in the WYSIWYG Editor. Elements that are not acceptable display as text. See Safe Listed Customizable Elements.
Overwrite Settings
Select this option to overwrite custom settings for child division OUs. If you overwrite custom settings for child division OUs, the selected settings are applied to both new and existing child OUs. Any previously customized child OUs are updated with the selected settings.
· If there are no customizations to the child OU, then the parent OU customizations are applied to all child OUs.
· Overwrite custom settings checkbox setting
· If this option is selected, all child OU customizations are deleted from the database, which means the parent OU customizations will be applied to new and existing child OUs.
· If this option is unselected, all existing child OU customizations will remain unchanged, and any new child OUs will inherit the parent OU customizations by default.
· If a child OU has been customized to display any widgets, then regardless of the parent OU customizations, the child OU customizations are applied.
· If a child OU has been customized to hide all widgets, then parent OU customizations will take precedence and will be applied.
Cancel/Submit
Click Cancel to cancel changes to the preference settings.
Click Submit to submit changes to the preference settings.
[bookmark: _Ref1326223812]Tax Preferences
The Tax Preferences page enables administrators to configure tax calculation service vendors and other tax calculation-related preferences. From this page, administrators can define the preferences for sales tax collection per learning object (LO) type. Administrators can also add tax calculators and edit the details of tax calculators.
The Tax Preferences page is controlled by a backend setting that is disabled by default. To enable this functionality, contact Global Customer Support.
To access the Tax Preferences page, go to Admin > Tools > Learning > E-Commerce. Then, click the Taxes link in the Shopping Cart and Billing Preferences section.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Tax Preferences
	Grants ability to manage Tax Preferences. This permission cannot be constrained. This is an administrator permission.
	eCommerce - Administration
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Sales Tax Preferences per Learning Object
In the Sales Tax Preferences per Learning Object section, administrators define which LOs will be taxable. Check or uncheck the following LO types to set the type as taxable:
· Curriculum
· Event
· Library
· Material
· Online Class
· Quick Course
· Test
Once the options are selected, click Save to save the changes. Or, click Cancel to cancel the changes made to the settings.
Note: The Video option LO type does not currently support sales tax. This LO type is included as an option to support the possibility of future updates to this feature. The Video option can be selected but has no functionality.
Tax Calculator
In this section, administrators can view and add tax calculators to the Tax Preferences page. Tax calculators are used to look up and calculate the tax.
Tax calculators are only used for CCH, not for Cybersource.
Add Tax Calculator
To add a tax calculator, click the plus icon [image: ] to the right of the Tax Calculator heading. This opens the Add Tax Calculator pop-up.
[image: ]
Complete the following fields in the pop-up:
· Name - Enter the name used to identify the tax calculator, up to 30 characters. This is a required field.
· Description - Enter a description for the tax calculator, up to 250 characters. The description is for the administrator's use only and does not display in any other area of the system.
· Tax Calculator Account ID - Enter your administrator-level account ID, up to 50 characters. This is a required field. Note: When updating both the account ID and password, update the account ID first and then the password.
· Tax Calculator Account Password - Enter your administrator-level account password, up to 50 characters. This is a required field. While entering the password, the characters are hidden. Once the password is entered and the Submit button is clicked, the Tax Calculator Account Password field changes to an Update Password link. Note: When updating both the account ID and password, update the account ID first and then the password.
· Update Password - This link displays when a submitted tax calculator is being edited. Click the Update Password link to change the password. This opens the Update Password pop-up. Enter the new password, up to 50 characters. Then, click Update. This closes the pop-up. Click Submit at the bottom of the Edit Tax Calculator pop-up to submit the changes.
· Country - From the drop-down, select the country for which the sales tax will be calculated. This is a required field.
· Address Line 1 - Enter the street address for the organization for which the sales tax will be calculated, up to 60 characters. This is a required field.
· Address Line 2 - Enter additional address information for the organization for which the sales tax will be calculated, up to 60 characters.
· City - Enter the city for the organization for which the sales tax will be calculated, up to 50 characters. This is a required field.
· State - From the drop-down, select the state/province/territory for which the sales tax will be calculated. This is a required field.
· Zip - Enter the Zip code for the organization for which the sales tax will be calculated, up to 10 characters. This is a required field.
· Status of Finalized Invoice Sent to Tax Calculator - The following options are available:
· Posted - When this option is selected, the finalized invoices that are sent to the tax calculator when a transaction is completed will be in a Posted status. Note: This is a status used by the vendor.
· Pending - When this option is selected, the finalized invoices that are sent to the tax calculator when a transaction is completed will be in a Pending status. Note: This is a status used by the vendor.
Click the Submit button to submit and save the tax calculator. To discard the tax calculator without saving it, click Cancel instead.
Tax Calculator Table
The Tax Calculator table displays the tax calculators that have been added to Tax Preferences. From here, administrators can access the details of a tax calculator and edit the tax calculator's settings.
The following information displays in the table:
· Name - This column displays the name of the tax calculator.
· Options - This column displays an Edit option. Click the Edit icon [image: ] to edit the details of the tax calculator. This opens the Edit Tax Calculator pop-up. See the Add Tax Calculator section above for information about the settings available in the pop-up.
Note: The settings in the Tax Calculator section are saved automatically. The Save and Cancel buttons in the Sales Tax Preferences per Learning Object section do not impact the settings in the Tax Calculator section.
[bookmark: _Toc161997443]Shopping Cart Checkout Overview
Similar to a grocery store shopping cart, the system shopping cart enables users to select learning objects (LOs) that they intend to purchase. Users can then proceed to the checkout process in order to purchase all of the items in a single transaction.
In a single transaction, users can only purchase items that use the same invoice. If a user adds items to their shopping cart that require two or more different invoices, then the user is prompted to adjust their shopping cart. An asterisk appears next to the LOs that use a custom invoice. Users must then modify their shopping cart so that all items use the same invoice prior to proceeding to the checkout process.
[bookmark: _Toc161997444]Shopping Cart - Add to Cart
If the shopping cart is enabled, users may be able to add learning objects (LOs) to their shopping cart. From the shopping cart, users are able to purchase the LOs.
Users can only add an LO to their shopping cart if the following is true:
· The Shopping Cart functionality is enabled by the administrator in Shopping Cart Preferences.
· The LO has a cost associated with it.
· The user is responsible for paying for the LO (i.e., the user's cost center does not pay 100% of the LO cost).
Add Training to Cart
1. Search and find training. See Search for Training for additional information.
2. Click Add to Cart button.
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3. If you are purchasing the training for yourself, select Myself and click Submit if training is for yourself. Otherwise, if you are purchasing the training as inventory to assign to other users, select the Others: Pre-Purchase option and enter the quantity you are purchasing. The quantity can be adjusted on the Shopping Cart page. You can continue shopping and can add more learning objects to the shopping cart. The shopping cart is saved and does not expire. Note: If you have already added the LO to your shopping cart for yourself, then the Myself option is disabled.
[image: ]
Pre-Purchase LOs
The following LO types cannot be pre-purchased:
· Posting 
· Event/Session - These LOs cannot be stored in inventory without user assignment.
· Library
Recurrence
If training has recurrence, after selecting Add to Cart, for a training item the user previously completed, you will be able to select Myself again.
Example: 
· Course A = Course B. You have completed Course A, and would like course B to appear on your transcript. Course B cost 10 dollars. Course B will be completed based on equivalency and as a result you will bypass the shopping cart when requesting course B. The Button will display Request in that case. Course B will appear on your transcript as completed equivalent and is NOT launch-able. If you want to take Course B, you will need to search for Course B a second time and in that case the Add to cart Button will appear and you will be able to purchase it.
[bookmark: _Ref872519342][bookmark: _Ref2007258707][bookmark: _Toc161997445]Shopping Cart - Overview
Similar to a grocery store shopping cart, the system shopping cart enables users to select learning objects (LOs) that they intend to purchase. Users can then proceed to the checkout process in order to purchase all of the items in a single transaction.
In a single transaction, users can only purchase items that use the same invoice. If a user adds items to their shopping cart that require two or more different invoices, then the user is prompted to adjust their shopping cart. An asterisk appears next to the LOs that use a custom invoice. Users must then modify their shopping cart so that all items use the same invoice prior to proceeding to the checkout process.
To access the Shopping Cart page, add a training item to your shopping cart.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce
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Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Shopping Cart Table
The Shopping Cart Table displays details of the training items the user has added to their shopping cart. 
The following information is displayed for each item in the Shopping Cart Table:
· Title - This column displays the LO title. If the LO title exceeds two lines, an ellipsis appears at the end of the second line. The icon to the left of the LO title represents the type of LO (e.g., Online Class, Curriculum, Session). Users can click the LO title to view the LO Details Page for the LO. When creating a purchase by proxy, administrators with the appropriate permission can override the price for a training item on the Shopping Cart page. See Purchase by Proxy - Price Override on page 49 for additional information.
· Provider - This column displays the LO provider. If the LO provider exceeds two lines, an ellipsis appears at the end of the second line.
· Recipient - This column displays the recipient of the LO. If the user has purchased inventory, then this column displays "Inventory." If the LO provider exceeds two lines, an ellipsis appears at the end of the second line.
· Quantity & Price - This column displays the quantity of the LO that is added to the shopping cart and the price for a single instance of the LO. For example, if five instances of the LO are added to the shopping cart and the LO price is $500.00, then "5 x $500.00" appears in this column.
· Quantity - The quantity value represents the quantity that was entered by the user when the LO was added to the shopping cart. This value can be edited by entering a new value in the text box. See the Change LO Quantity section below for additional information.
· Price - The price value represents the single unit price for the LO.
· Subtotal - This column displays the subtotal for the quantity and price of the LO. For example, if the quantity is five and the price is $500.00, then the subtotal for the LO is $2,500.00. If a coupon code is applied to the LO, the coupon savings amount appears below the discounted price. The coupon is displayed in currency or training units, depending on the coupon configuration.
Cost Center Percentage
If the cost center is configured to pay for a portion of certain learning objects, then the amount and percentage that the cost center pays is displayed above the Subtotal row. When the cost center percentage is greater than zero and coupons are applied to at least one item in the shopping cart, then the coupon code amount may be adjusted according to the cost center percentage that is applied to the purchase.
Change LO Quantity
When purchasing inventory, the quantity value for each LO appears in a text box in the Shopping Cart Table. This value can be edited by the user by entering a new value in the text box. The maximum value that can be entered in the text box is 999. If the user enters "0" in the text box, the price for the item is reduced to zero, but the item is not removed from the shopping cart.
When an LO quantity is changed, the subtotal at the bottom of the Shopping Cart Table is updated.
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Remove LO from Shopping Cart
To remove an LO from the shopping cart, click the Remove icon [image: ] to the right of the LO in the Shopping Cart Table.
When an item is removed from the shopping cart, the subtotal at the bottom of the Shopping Cart Table is updated.
[image: ]
If the user removes all of the items in the Shopping Cart, the Proceed to Checkout button is disabled.
Currency/Training Units Toggle
If Training Units are enabled as a payment type for the user and the LOs in the shopping cart, then shopping cart items can be viewed in either currency amounts or training units. The default display is Currency. When Currency is the only option, the toggle is not available.
The Currency/Training Units toggle appears in the upper-right corner of the Shopping Cart Table. Users can click the appropriate option to toggle between currency amounts and training units. The training unit amount for an LO is configured by the administrator in Course Catalog.
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If only one price type has been configured (Currency or Training Units) and you are viewing the type where no price is configured, then “Not Eligible” is displayed because there is no price for that type.
Example:
· LO1 - Currency Price is set to $0 // Training Units are disassociated and set to 100
· LO2 - Currency Price is set to $200 // Training Units are based upon the configured conversion rate - which in this case is 1 to 1 (i.e. $200 = 200 training units)
· LO3 - Currency Price is set to $200 // Training Units are not allowed
When a user adds the three LOs above to the shopping cart, what they see depends upon whether they are viewing the Currency or Training Units toggle:
Currency toggle view:
· LO1 - Not Eligible
· LO2 - $200
· LO2 - $200
Training Units toggle view:
· LO1 - 100
· LO2 - 200
· LO2 - Not Eligible
Coupon Codes
Users can apply, remove, and modify coupon codes on the Shopping Cart page. This functionality is only available if coupons are enabled by the administrator in User Payment Preferences. In addition, if training units are the only payments that are enabled, then this functionality is not available. Coupon codes must be configured by the administrator.
Enter a Coupon Code
To apply a coupon to items in the shopping cart, enter the coupon code in the Enter coupon code field. Then, click Apply.
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When a coupon is applied, the system validates the coupon. If the coupon is validated, then the coupon is applied to the shopping cart subtotal, and the applied coupon code appears below the Enter coupon code field.
[image: ]
Multiple coupon codes can be applied to the shopping cart. However, administrators can set a maximum number of allowed coupons. If the maximum number of allowed coupons is applied, then the user must remove an applied coupon in order to apply another coupon.
Remove a Coupon
Removing a coupon removes the discount that was previously applied by the coupon.
To remove a coupon that has been applied, click the Remove icon [image: ] to the right of the applied coupon at the bottom of the shopping cart. The coupon discount is removed and the shopping cart subtotal is updated.
Unavailable Training Items
When a training item in a user's shopping cart is no longer available, the item is removed from the cart. When the item is removed, a message displays for users indicating that the item is no longer available and was removed from the cart.
Others Also Purchased Panel
The Others Also Purchased panel displays up to five other LOs that users have purchased based on the contents of the shopping cart. For example, if users often purchase LO1 and LO2 together, and a user has LO1 in their shopping cart, then this panel displays LO2 as an LO that others have also purchased.
If ratings are enabled, then the ratings display below the LO title.
This panel may be disabled by the administrator via Shopping Cart Preferences. In addition, the administrator can configure how many LOs are displayed, up to five.
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Recommended Training Panel
The Recommended Training panel displays up to five LOs that are configured as recommended training by administrators via the Course Catalog. 
This panel may be disabled by the administrator via Shopping Cart Preferences. In addition, the administrator can configure how many LOs are displayed, up to five.
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Continue Shopping or Proceed to Checkout
After reviewing the contents of the shopping cart, users can continue shopping for training items by clicking the Continue Shopping button. Otherwise, if users are finished shopping, they can begin the checkout process by clicking the Proceed to Checkout button. See Checkout - Step 1 - Payment on page 178 for additional information. 
When users click the Continue Shopping button, they are directed back to their search results on the search page from which they selected the training item for purchase, either the Events Calendar, Global Search, or Browse for Training page. This allows users to continue shopping within their search results, as well as search for additional items. Any filters the user applied to the search results remain when the user returns to the search page.
The Continue Shopping button does not display during the checkout process in the following instances:
· When the search page does not include search results
· When users access the shopping cart from a page other than a search page, provided that the user has not been to a search page while logged in to the portal
· When administrators purchase training items by proxy
[bookmark: _Ref971084828][bookmark: _Ref-44107591][bookmark: _Toc161997446]Checkout - Step 1 - Payment
The Payment step is the first step of the checkout process and it enables the user to view an overview of the pending purchase, select the method of payment, and enter any necessary information. Users arrive at the Payment step when they click the Proceed to Checkout button on the Shopping Cart page. If the Shopping Cart functionality is disabled, then users arrive at the Payment step when they click the Add to Cart button for a learning object (LO).
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce
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Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the checkout process, and it displays a summary of the shopping cart items, including a subtotal. For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
The process for completing the Payment step varies, depending on the payment type that is selected. 
To begin the checkout process, select the appropriate payment method from the Payment Method drop-down list. The following payment methods may be available:
· Credit Card
· E-Check
· Paypal
· Send Bill/Purchase Order
· Training Units (Distributed)
· Training Units (Key Code)
· Wire Transfer
· Custom Payment Methods
Available payment options are determined by the system administrator via User Payment Preferences for the user's organizational unit (OU). Some payment methods may not be available. Note: PayPal is not available as a payment method for purchasing Training Units.
Additional Information
An Additional Information section may appear on the Payment step. This section displays any custom Transaction fields that were added by the administrator to the Custom Fields section on the Shopping Cart Preferences page.
Users can enter a value in fields that are configured as editable by the administrator. Fields that users are required to complete display with a red asterisk. A value must be entered in the field before proceeding to the next step in the purchasing process.
Next
After completing the Payment step, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
Checkout - Payment - Credit Card
The Credit Card payment option allows users to pay with a credit card. This option is only available if enabled by the administrator in User Payment Preferences.
If Credit Card is selected as the method of payment, the total is displayed in the Purchase Summary section and you must enter the appropriate information in the Credit Card Information section. If you have established a credit card billing profile, you have the option to use the stored credit card information to complete the purchase or you may enter a new credit card. Only one credit card can be stored to a billing profile.
Which credit card types are accepted is determined by the system administrator in User Payment Preferences. The following credit card types may be accepted:
· VISA
· MasterCard
· American Express
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the checkout process, and it displays a summary of the shopping cart items, including a subtotal. For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
To pay for training using a credit card on the Checkout - Payment page, select Credit Card from the Payment Method drop-down list. The following fields appear below the Payment Method drop-down list:
Credit card information
· Use this card or Enter new card - If you have established a credit card billing profile, you have the option to use the stored credit card information to complete the purchase or you may enter a new credit card. Only one credit card can be stored to a billing profile.
· Card Number - Enter the credit card number (no spaces or dashes).
· Expiry Date - Enter the expiration month and year. The two-digit expiration month (MM) should be entered in the first field, and the four-digit expiration year (YYYY) should be entered in the second field.
· CVV Code - Enter the card verification value or card security code. This is a three or four digit value printed on the card or signature strip. Note: The visibility of the CVV field is determined by the administrator. If the CVV field does not display, then a CVV code does not need to be entered.
· Save my credit card information to my profile - If billing profiles are not enabled, this option does not appear. Select this option to store the provided credit card information as your billing profile.
· If you store the credit card information as your billing profile, in future purchases, when you reach the Payment step of the checkout process you have the option to use the stored information for payment, rather than reenter the information each time.
· To view or edit the billing profile, in the upper-right corner of any screen, select My Account, and then select the Billing Profile link on the left.
Comments
The Comments fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Comments field is enabled for a payment type, then users are able to enter comments for the transaction, up to 500 characters.
Billing information
· Email - Enter the email address associated with the credit card.
· First Name - Enter the first name on the credit card. The character limit is 100.
· Last Name - Enter the last name on the credit card. The character limit is 100.
· Address Line 1 - Enter the street address associated with the card. The character limit is 100.
· Address Line 2 - Enter additional address information. The character limit is 100.
· City - Enter the city for the street address associated with the card. The character limit is 100.
· Country - Use the drop-down to select the country associated with the credit card.
· State/Province - Use the drop-down to select the state or province for the street address associated with the card.
· Zip Code - Enter the postal or zip code for the street address associated with the card. The character limit is 10.
· Use the billing address as my shipping address? - Select Yes to copy the billing information into the Secondary Address fields. Select No to enter a secondary address that differs from the billing address.
Note: For portals with a CCH integration, if User Payment preferences are not configured to use the secondary payment address for tax calculation, then CCH uses the user's primary address to determine the tax rate and amount for the purchase.
Secondary Address
The Secondary Address fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Secondary Address fields are enabled for a payment type, then users are able to enter a secondary address for the transaction. The Secondary Address may also include a Company Name and Phone Number field, depending on the Billing Information Preferences that are set for the user's OU. These fields may be required, depending on the Billing Information Preferences and User Payment Preferences that are set for the user's OU. Note: The Secondary Address label can be customized in Billing Information Preferences.
The following character limits are applied to the Secondary Address fields:
· Company Name - 100
· Phone - 30
· First Name - 30
· Address - line 1 - 60
· Last Name - 30
· Address - line 2 - 60
· Email - 50
· City - 50
· Zip Code - 10
Note: For portals with a CCH integration, if User Payment preferences are configured to use the secondary payment address for tax calculation, then CCH uses the user's secondary address to determine the tax rate and amount for the purchase.
Next
After entering the necessary information, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
Checkout - Payment - Custom Payment Method
Organizations can add up to six custom payment methods in addition to the standard options. These options are only available if enabled by the administrator in User Payment Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the checkout process, and it displays a summary of the shopping cart items, including a subtotal. For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
To pay for training using a custom payment method on the Checkout - Payment page, select the custom payment method from the Payment Method drop-down list.
Users may be prompted or required to provide personal information and a code to use the payment method.
Depending upon the custom payment type configuration, when a code is provided and applied, the user's available balance may be displayed. The Apply button only appears if the custom payment type is configured to allow users to check their balance.
Up to two additional fields can be configured to display on the Payment page. These fields may be optional or they may require a response.
Comments
The Comments fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Comments field is enabled for a payment type, then users are able to enter comments for the transaction, up to 500 characters.
Secondary Address
The Secondary Address fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Secondary Address fields are enabled for a payment type, then users are able to enter a secondary address for the transaction. The Secondary Address may also include a Company Name and Phone Number field, depending on the Billing Information Preferences that are set for the user's OU. These fields may be required, depending on the Billing Information Preferences and User Payment Preferences that are set for the user's OU. Note: The Secondary Address label can be customized in Billing Information Preferences.
The following character limits are applied to the Secondary Address fields:
· Company Name - 100
· Phone - 30
· First Name - 30
· Address - line 1 - 60
· Last Name - 30
· Address - line 2 - 60
· Email - 50
· City - 50
· Zip Code - 10
Next
After entering the necessary information, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
[image: ]
[bookmark: _Ref972566820][bookmark: _Ref996687785]Checkout - Payment - Purchase Summary
The Purchase Summary panel appears on the Payment step of the checkout process, and it displays a summary of the shopping cart items, including a subtotal. For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons.
The following information is displayed for each item in the shopping cart:
· Title - This displays the learning object (LO) title. If the LO title exceeds two lines, an ellipsis appears at the end of the second line. The icon to the left of the title represents the type of training (e.g., online class, curriculum, session). Users can click the title to view the Learning Details page for the LO. 
· Price - This displays the subtotal price for each LO. When a coupon code is applied, the coupon discount appears below the price.
· Cost Center Pays - If the cost center is configured to pay a percentage of the price, the cost center percentage is displayed as well as the total amount that the cost center is paying.
· Subtotal - This displays the subtotal that is being charged to the user. This accounts for any amount the cost center is paying and any coupon discounts.
Coupon Code Entry
For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons.
To enter a coupon code, enter the coupon code in the Enter coupon code field and click Apply. The system validates the coupon. If the coupon is validated, then the coupon is applied to the subtotal.
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Checkout - Payment - Send Bill/Purchase Order
This payment option enables users to pay via send bill/purchase order. This option is only available if enabled by the administrator in User Payment Preferences. Sales tax can only be applied to certain payments under certain circumstances. See Sales Tax Overview on page 118 for additional information.
A user must have an address that includes a Country setting in their user record to checkout using the Send Bill payment method. If an address is not available in the user record, the address defaults to the user's Location OU address. If no Country is available for the user, they cannot checkout using the Send Bill payment method.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the checkout process, and it displays a summary of the shopping cart items, including a subtotal. For organizations with Coupon Code functionality enabled, the Purchase Summary panel enables users to enter coupons. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
To pay for training using the Send Bill method of payment on the Checkout - Payment page, select Send Bill from the Select Payment Method drop-down list. If the administrator has set a minimum required purchase amount, this option does not appear unless the user has purchased the minimum amount.
Reference Number
The Reference Number field is only available if enabled by the administrator in User Payment Preferences.
Enter a reference number to have the invoice sent. 
Comments
The Comments fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Comments field is enabled for a payment type, then users are able to enter comments for the transaction, up to 500 characters.
Secondary Address
The Secondary Address fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Secondary Address fields are enabled for a payment type, then users are able to enter a secondary address for the transaction. The Secondary Address may also include a Company Name and Phone Number field, depending on the Billing Information Preferences that are set for the user's OU. These fields may be required, depending on the Billing Information Preferences and User Payment Preferences that are set for the user's OU. Note: The Secondary Address label can be customized in Billing Information Preferences.
The following character limits are applied to the Secondary Address fields:
· Company Name - 100
· Phone - 30
· First Name - 30
· Address - line 1 - 60
· Last Name - 30
· Address - line 2 - 60
· Email - 50
· City - 50
· Zip Code - 10
Note: For portals with a CCH integration, if User Payment preferences are configured to use the secondary payment address for tax calculation, then CCH uses the user's secondary address to determine the tax rate and amount for the purchase.
Next
After entering the necessary information, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
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Checkout - Payment - Training Units - Distributed
This payment option enables users to pay via distributed training units. This option is only available if enabled by the administrator in User Payment Preferences.
To pay with training units, all items within the order must accept training units. If at least one item does not accept training units, you cannot pay with training units. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the Checkout process, and it displays a summary of the shopping cart items, including a subtotal. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
To pay for training using distributed training units on the Checkout - Payment page, select Training Units (Distributed) from the Payment Method drop-down list. The system displays the following information:
· Subtotal - This displays the number of training units that is needed to purchase the items in the shopping cart.
· Individual Balance - This displays the number of training units that are available in the user's account.
· Insufficient Balance - If the user does not have enough training units in their account to purchase the training in the shopping cart, the difference is displayed in training units. The user can either remove one or more items from their shopping cart until the subtotal is less than or equal to their individual balance. Otherwise, if other payment methods are enabled, the user may be able to pay the remaining balance using another form of payment. See the Pay Remaining Balance section below for additional information.
Comments
The Comments fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Comments field is enabled for a payment type, then users are able to enter comments for the transaction, up to 500 characters.
Secondary Address
The Secondary Address fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Secondary Address fields are enabled for a payment type, then users are able to enter a secondary address for the transaction. The Secondary Address may also include a Company Name and Phone Number field, depending on the Billing Information Preferences that are set for the user's OU. These fields may be required, depending on the Billing Information Preferences and User Payment Preferences that are set for the user's OU. Note: The Secondary Address label can be customized in Billing Information Preferences.
The following character limits are applied to the Secondary Address fields:
· Company Name - 100
· Phone - 30
· First Name - 30
· Address - line 1 - 60
· Last Name - 30
· Address - line 2 - 60
· Email - 50
· City - 50
· Zip Code - 10
Pay Remaining Balance
When purchasing training with training units, the entire purchase must be made with training units and cannot be split with another payment method. If the user has an insufficient number of training units in their account, the Pay Remaining Balance section displays with the remaining balance for the transaction.
From the Pay Remaining Balance drop-down list, the user can select another payment method for purchasing more training units. All of the payment methods enabled for the organization are available in the drop-down list, with the exception of Training Units (Distributed). When another payment method is selected, the appropriate fields for that payment method are displayed.
· Credit Card
· Send Bill/Purchase Order
· Training Units (Key Code)
· Custom Payment Methods
When purchasing additional training units, bundled pricing discounts do apply if available, but the user is restricted to purchasing only the number of training units to complete the sale.
Next
After entering the necessary information, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
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Checkout - Payment - Training Units - Key Code
This payment option enables users to pay via distributed training units. This option is only available if enabled by the administrator in User Payment Preferences.
To pay with training units, all items within the order must accept training units. If at least one item does not accept training units, you cannot pay with training units. 
Training unit key codes must be enabled for the system and also as a payment method for them to appear on the Checkout page. In addition, users may not be able to purchase a session with training units that expire prior to the session start date, depending upon the administrator's configuration of the training unit redemption option in Training Unit Preferences. If the administrator has enabled this option, then when a shopping cart transaction includes a session, the system uses the training units that expire furthest from the session start date. Depending on the training unit redemption option in Training Unit Preferences, if there are no available training units that expire after the session start date, then the user cannot purchase the session or must choose a different payment method.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce


Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The Purchase Summary panel appears on the Payment step of the Checkout process, and it displays a summary of the shopping cart items, including a subtotal. See Checkout - Payment - Purchase Summary on page 185 for additional information.
Enter Payment Information
To pay for training using key code training units on the Checkout - Payment page, select Training Units (Key Code) from the Payment Method drop-down list. The following fields appear below the Payment Method drop-down list:
Key Code
Enter your training unit key code and click Verify to retrieve your available training unit balance. Note: The administrator may limit the availability of the key code to users who are in a specific organizational unit (OU). Only the users who are in the OU can check out using the training unit key code. Users who are not part of the OU cannot checkout using the training unit key code and will receive an error message when attempting to use the key code. See Training Unit Preferences by Division on page 134 for additional information.
After the key code is verified, the system displays the following information:
· Subtotal - This displays the number of training units that is needed to purchase the items in the shopping cart.
· Individual Balance - This displays the number of training units that are available for the key code. If the key code balance is hidden, then the administrator has configured Training Unit Preferences to hide the balance. See Training Unit Assignment - Create - Step 1 - General on page 95 for additional information.
· Insufficient Balance - If the user does not have enough training units with the key code to purchase the training in the shopping cart, the difference is displayed in training units. The user can either remove one or more items from their shopping cart until the subtotal is less than or equal to their individual balance. Otherwise, if other payment methods are enabled, the user may be able to pay the remaining balance using another form of payment. See the Pay Remaining Balance section below for additional information.
Comments
The Comments fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Comments field is enabled for a payment type, then users are able to enter comments for the transaction, up to 500 characters.
Secondary Address
The Secondary Address fields are only available if enabled for a payment type by the administrator in User Payment Preferences.
If the Secondary Address fields are enabled for a payment type, then users are able to enter a secondary address for the transaction. The Secondary Address may also include a Company Name and Phone Number field, depending on the Billing Information Preferences that are set for the user's OU. These fields may be required, depending on the Billing Information Preferences and User Payment Preferences that are set for the user's OU. Note: The Secondary Address label can be customized in Billing Information Preferences.
The following character limits are applied to the Secondary Address fields:
· Company Name - 100
· Phone - 30
· First Name - 30
· Address - line 1 - 60
· Last Name - 30
· Address - line 2 - 60
· Email - 50
· City - 50
· Zip Code - 10
Pay Remaining Balance
If the user has an insufficient amount of training units in their account, the Pay Remaining Balance section is displayed along with the remaining balance for the transaction.
From the Pay Remaining Balance drop-down list, the user can select another payment method. All of the payment methods that are enabled for the organization are available in the drop-down list, with the exception of Training Units (Distributed). When another payment method is selected, the appropriate fields for that payment method are displayed.
· Credit Card
· Send Bill/Purchase Order
· Training Units (Distributed)
· Custom Payment Methods
When purchasing additional training units, bundled pricing discounts do apply if available, but the user is restricted to purchasing only the number of training units to complete the sale.
Next
After entering the necessary information, click Next to proceed to the Review step. See Checkout - Step 2 - Review on page 199 for additional information.
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Considerations When Purchasing Sessions
If the administrator has enabled the training unit redemption option in Training Unit Preferences, then users cannot purchase a session with training units that expire prior to the session start date.
Validations
· If the user selects Training Unit (Key Code) as the payment method for a session in their shopping cart, then the system checks the user's key code balance first, and then checks to see if the user has personal training units available.
· If the key code has an insufficient balance and there are no personal training units available, then the user is prompted to remove the session from their cart.
· If there are other training items in the user's shopping cart (not sessions) and all training units from the key code are used, then the system checks the user's personal training units balance. If the balance is insufficient to purchase the items, then the user is prompted to remove the excess items from their shopping cart or pay the remaining balance with a credit card or via the "Purchase Order" option.
· If the user selects Training Unit (Distributed) as the payment method, then the system checks the user's personal training units balance. If their personal training units balance is insufficient to cover the cost of the items, then the user is prompted to pay the remaining balance with a credit card or via the "Send Bill" option.
Use Cases
The following use cases assume that the redemption preference is checked in Training Unit Preferences and that Training Unit Key Code is selected as the payment method.
Use Case 1
Training Unit Key Code ABC Balance: 1000
Training Unit Key Code ABC Expiration Date: 07/01/2012
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 training units (TUs).
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· The user is required to remove Session A from their cart or select a different payment method.
Reason: The session starts after the user's TUs expire, and the user has no TUs available that expire after the session start date. Note: The user can purchase Online Course B with Key Code ABC, but they cannot do so unless they remove Session A from their shopping cart.
Use Case 2
Training Unit Key Code ABC Balance: 1000
Training Unit Key Code ABC Expiration Date: 07/01/2012
Training Unit Key Code XYZ Balance: 2000
Training Unit Key Code XYZ Expiration Date: 07/01/2013
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· 22 TUs are deducted from Key Code XYZ to purchase the session.
Reason: Key Code XYZ has TUs available that do not expire until after the session start date. 
· 100 TUs are deducted from Key Code ABC.
Reason: The system always uses the TUs that expire the soonest, unless the user is purchasing a session and has training units available that expire after the session start date.
Use Case 3
Training Unit Key Code ABC Balance: 1000
Training Unit Key Code ABC Expiration Date: 07/01/2012
Personal Training Units X Balance: 1000
Personal Training Units X Expiration Date: 07/01/2012
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· The user is required to remove Session A from their cart or select a different payment method.
Reason: All of the user's TUs expire before the session start date. Note: The user can purchase Online Course B with Key Code ABC or using their personal TUs, but they cannot do so unless they remove Session A from their shopping cart.
Use Case 4
Training Unit Key Code ABC Balance: 10
Training Unit Key Code ABC Expiration Date: 07/01/2013
Personal Training Units X Balance: 1000
Personal Training Units X Expiration Date: 07/01/2012
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 122 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· The user is required to remove Session A from their cart or select a different payment method.
Reason: The key code has an insufficient balance, and the user's personal TUs expire before the session start date. Note: The user can purchase Online Course B with their personal TUs, but they cannot do so unless they remove Session A from their shopping cart.
Use Case 5
Personal Training Units X Balance: 1000
Personal Training Units X Expiration Date: 07/01/2012
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· The user is required to remove Session A from their cart or select a different payment method.
Reason: The TUs expire before the session start date. Note: The user can purchase Online Course B with their personal TUs, but they cannot do so unless they remove Session A from their shopping cart.
Use Case 6
Personal Training Units X Balance: 1000
Personal Training Units X Expiration Date: 07/01/2012
Personal Training Units Y Balance: 2000
Personal Training Units Y Expiration Date: 07/01/2013
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· 22 TUs are deducted from Personal Training Units Y to purchase the session.
Reason: Personal Training Units Y has TUs available that do not expire until after the session start date.
· 100 TUs are deducted from Personal Training Units X.
Reason: The system always uses the TUs that expire the soonest, unless the user is purchasing a session and has training units available that expire after the session start date.
Use Case 7
Personal Training Units X Balance: 10
Personal Training Units X Expiration Date: 07/01/2012
Personal Training Units Y Balance: 22
Personal Training Units Y Expiration Date: 07/01/2013
User Payment Preferences are configured to allow users to pay the remaining balance with a credit card or via the "Send Bill" option.
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· 22 TUs are deducted from Personal Training Units Y to purchase the session.
· 10 TUs are deducted from Personal Training Units X to purchase the online course. The user is required to use a credit card or the "Send Bill" option to pay the remaining balance of 90 TUs.
Reason: The balance on Personal Training Units X is insufficient to pay the remaining balance for the online course.
Use Case 8
Personal Training Units X Balance: 10
Personal Training Units X Expiration Date: 07/01/2012
Personal Training Units Y Balance: 20
Personal Training Units Y Expiration Date: 07/01/2013
User Payment Preferences are configured to allow users to pay the remaining balance with a credit card or via the "Send Bill" option.
Action
1. User adds Session A to cart. The session start date is 07/02/2012 and has a price of 22 TUs.
2. User adds Online Course B to cart with a price of 100 TUs.
Result
· The user is required to remove Session A from their cart or select a different payment method.
Reason: The payment method selected is "Training Unit (Key Code)." The user does not have any training units on a key code with which to purchase the items. Therefore, the user must select a different payment method.
[bookmark: _Ref525473571][bookmark: _Toc161997447]Checkout - Step 2 - Review
The Review step is the second step of the checkout process and it allows the user to view an overview of the items being purchased, the overall cost, and the payment information. The user is able to review all of the details of the order prior to finalizing the purchase. At this stage of the checkout process, the payment has not yet been processed. Note: When testing shopping cart transactions in the Production portal, only real credit cards can be used. 
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce
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Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Shopping Cart Table
The Shopping Cart Table displays details of the training items the user is purchasing. Users have the option of editing the shopping cart before finalizing the purchase. See the Edit the Shopping Cart section below for additional information.
The following information is displayed for each item in the Shopping Cart Table:
· Title - This column displays the LO title. If the LO title exceeds two lines, an ellipsis appears at the end of the second line. The icon to the left of the LO title represents the type of LO (e.g., online class, curriculum, session). Users can click the LO title to view the LO Details Page for the LO. 
· Recipient - This column displays the recipient of the LO. If the user has purchased inventory, then this column displays "Inventory." If the LO provider exceeds two lines, an ellipsis appears at the end of the second line.
· Quantity & Price - This column displays the quantity of the LO that is added to the shopping cart and the price for a single instance of the LO. For example, if five instances of the LO are added to the shopping cart and the LO price is $500.00, then "5 x $500.00" appears in this column.
· Quantity - The quantity value represents the quantity that was entered by the user when the LO was added to the shopping cart.
· Price - The price value represents the single unit price for the LO.
· Tax Rate - A different sales tax rate may be applied to each item in a shopping cart. If multiple tax rates are applied for a user, then this column displays the corresponding tax rate for each item. tax is calculated and displayed for each item. Note: If a flat tax is applied rather than a tax rate, then the tax percentage is not displayed. The override tax amount is applied to each taxable item in the transaction.
For portals with an active CCH integration for which CCH is used as the tax calculator, the tax that displays on the Review step is calculated based on the tax rate and amount for the user's primary or secondary address. The address used is dependent upon the settings defined by the administrator in User Payment preferences. Once the user clicks the Place Order button on the Review step, the final version of the invoice is sent to CCH to maintain a record of the transaction for liability purposes.
· Subtotal - This column displays the subtotal for the quantity and price of the LO. For example, if the quantity is five and the price is $500.00, then the subtotal for the LO is $2,500.00. 
· Coupon Savings - If a coupon code is applied to the LO, the coupon savings amount appears below the discounted price. The coupon is displayed in currency or training units, depending on the coupon configuration.
· Tax - A different sales tax rate may be applied to each item in a shopping cart. If multiple tax rates are applied for a user, then this column displays the corresponding tax for each item.
Edit the Shopping Cart
Users have the option of editing the shopping cart before finalizing the purchase. To edit the shopping cart, click the Edit shopping cart link in the lower-left corner of the page. This navigates the user to the Shopping Cart page. All coupon and payment information is maintained. See Shopping Cart - Overview on page 173 for additional information.
Cost Center Percentage
If the cost center is configured to pay for a portion of certain LOs, then the amount and percentage that the cost center pays is displayed above the Subtotal row. When the cost center percentage is greater than zero and coupons are applied to at least one item in the shopping cart, then the coupon code amount may be adjusted according to the cost center percentage that is applied to the purchase.
Subtotal
The Subtotal row displays the total cost from the Shopping Cart Table, including coupons and cost center discounts.
Sales Tax
If sales tax is being collected, the sales tax percentage is displayed as well as the total amount that is being charged in sales tax.
Processing Fees
If processing fees are being collected, the total amount that is being charged is displayed.
Delivery Fees
If delivery fees are being collected, the total amount that is being charged is displayed.
Total
The Total row displays the sum total of all of the line item subtotals, plus any taxes and fees. This may be displayed in either currency value or training units.
Payment Information Panel
The Payment Information panel in the upper-right corner of the page displays a summarized view of the payment information that was entered by the user throughout the checkout process.
To edit the payment information or billing information, click the Change link at the bottom of the section. This navigates the user to the Payment page. All coupon information is maintained. See Checkout - Step 1 - Payment on page 178 for additional information.
Place Order
After reviewing the information on the Review step, click Place Order to process the order and proceed to the Confirmation step. See Checkout - Step 3 - Confirmation on page 202 for additional information.
[bookmark: _Ref394419407][bookmark: _Toc161997448]Checkout - Step 3 - Confirmation
The Confirmation step is the third and final step of the checkout process and provides a confirmation that the order has been placed. A transaction ID is also displayed, if available. At this stage of the checkout process, the payment has been processed and the purchase is finalized.
Administrator Note: In order for the transaction ID to display on the confirmation page, the TAG.TRANSACTION.ID tag must be included in the Thank You Page Message box in Shopping Cart Preferences.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	Inventory - Manage
	Grants ability to purchase multiple learning object licenses with the intent to assign that training to other users at a later time. This permission can be constrained by OU and User's OU.
	eCommerce
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Options
The following options are available from the Options drop-down list in the upper-right corner of the page:
· Print - Select this option to print the current page without the page header and footer.
· View Inventory - Select this option to open the Manage Inventory page. This option is only available to users with permission to manage inventory.
Purchase Summary
The following information is displayed for each item in the shopping cart:
· Title - This displays the LO title. If the LO title exceeds two lines, an ellipsis appears at the end of the second line. The icon to the left of the LO title represents the type of LO (e.g., Online Class, Curriculum, Session). Users can click the LO title to view the LO Details Page for the LO. 
· Price - This displays the subtotal price for each LO. When a coupon code is applied, the coupon discount appears below the price.
· Cost Center Pays - If the cost center is configured to pay a percentage of the price, the cost center percentage is displayed as well as the total amount that the cost center is paying.
· Sales Tax - If sales tax is being collected, the sales tax percentage is displayed as well as the total amount that is being charged in sales tax.
· Processing Fees - If processing fees are being collected, the total amount that is being charged is displayed.
· Delivery Fees - If delivery fees are being collected, the total amount that is being charged is displayed.
· Subtotal - This displays the subtotal that is being charged to the user. This accounts for any amount the cost center is paying, any coupon discounts, and any sales tax that is charged.
· Total - This displays the final amount that the user has paid.
Training Request Forms
If one or more of the learning objects that are purchased have a training request form attached via Course Catalog, then the training request forms for the appropriate training items are available in a Training Request Forms section on the Confirmation page. Click the training request form link to complete the training request form.
Custom Fields
The Confirmation/Thank You page of the shopping cart checkout process displays the field and values for any custom Transaction field tags that were added by the administrator to the message box in Shopping Cart Preferences and completed by the user on the Payment step.
Note: If the field was not required on the Payment page when checking out, and the user did not enter a value, the field does not display on the Confirmation/Thank You page.
[bookmark: _Toc161997449]Unsubscribe from Shopping Cart Notifications
The Unsubscribe page is accessed by users when clicking the Unsubscribe link in the Unpurchased Items section of the Shopping Cart email. This page provides options to unsubscribe from shopping cart email notifications.
Permissions
	PERMISSION NAME
	PERMISSION DESCRIPTION
	CATEGORY



	User - Edit My Account Preferences
	Allow users to view and modify their preferences on the My Account screen. This permission cannot be constrained. This is an end user permission.
	Core


Note: This permission is needed in order to be redirected to the Settings tab of the Preferences page in My Account when unsubscribing to the email notifications or when clicking Cancel to choose not to unsubscribe.
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The Unsubscribe page asks the user whether or not they would like to unsubscribe from the Shopping Cart email notifications. The user must select either Confirm or Cancel.
Confirm
To unsubscribe from email notifications, the user can click Confirm. For users with permission to edit the options on the My Account Preferences tab, this opens the Settings tab on the Preferences page in My Account. A message displays at the top of the page, indicating that the user has been unsubscribed from the notifications. In addition, the Opt out of Shopping Cart Notifications option is automatically selected.
For portals without My Account enabled and for users who do not have permission to edit the options on the My Account Preferences tab, clicking Confirm refreshes the Unsubscribe page and displays a notification that the user has been successfully unsubscribed from shopping cart notifications. The user can click Done to be redirected to their portal's homepage. They can also click the here link in the notification message to resubscribe to the notifications. The Unsubscribe page refreshes to display a notification that the user has been successfully resubscribed.
Cancel
If the user would like to continue receiving the notifications, they can click Cancel. For users with permission to edit the options on the My Account Preferences tab, clicking Cancel this opens the Settings tab on the Preferences page in My Account. A message displays at the top of the page in My Account, indicating that the user can subscribe and unsubscribe from shopping cart notifications from the Settings tab.
For portals without My Account enabled and for users who do not have permission to edit the options on the My Account Preferences tab, clicking Cancel opens the portal's homepage.
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Additional: Select Currency ~ Selecta currency to display in addition to the transacion currency.
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